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What Is IBIS MATCHPOINT+?

IBIS® MATCHPOINT+™ is a software system, installed on a desktop 
computer, that includes powerful image analysis tools that enable firearm 
examiners to analyze images that have been acquired by 
IBIS® BRASSTRAX-3D™, IBIS® BULLETTRAX-3D™, and IBIS® Heritage™ 
(BulletProof™ and BrassCatcher™), and correlation results on-site or from a 
remote location. These tools are designed to help firearm examiners select 
potential matches that are suggested by the correlation scores and perform 
comparisons of likely candidates.

Features
MATCHPOINT+ allows firearm examiners to:

• Create manual correlation requests
• View correlation scores
• Compare and analyze bullet evidence in both 2D and 3D

  

Note: Only images that have been acquired by BULLETTRAX-3D 
are available in 3D.

 

• Compare and analyze cartridge case evidence in both 2D and 3D
  

Note: Full headstamp and 3D primer images are only available 
from BRASSTRAX-3D.

 

• Compare multiple bullet or cartridge case exhibits simultaneously using 
the MultiViewer

• Compare two exhibits in the Side-by-Side Viewer
• Use dynamic bullet visualization tools to view details of high-resolution 

images at high magnification levels, overlap images and adjust image 
transparency to create composite images, adjust image brightness and 
contrast, and stretch or shrink images vertically.
When analyzing 3D images, you can manipulate the texture of 3D images 
to bring out surface details by adjusting the 2D/3D rendering, 3D 
elevation, and lighting.
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• Use dynamic cartridge case visualization tools to move, rotate, and 
overlap images, view details of high-resolution images at high 
magnification levels, and adjust image brightness and contrast.
When analyzing 3D primer images that have been acquired using the 
Depth from focus method (DFF), you can make additional adjustments to 
the lighting and 2D/3D rendering. 

• Compare cross-sectional topographical profiles of a bullet’s surface
• Calculate and view consecutive matching striae (CMS)
• Capture and export screen images
• Record hits
• Create reports
• Export site data
• Print details about cases, exhibits, correlation requests and results, and 

hits
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User Roles

To maintain security and control in MATCHPOINT+, users are assigned a role 
which allows them access to certain features. Users can have one of the 
following core roles:

• Acquisition Technician
• Expert Acquisition Technician
• Firearm Examiner

  

Note: User accounts are managed by IBIS Administrators. For 
more information, see the IBIS Products Administration Guide.

 

Acquisition Technician
Acquisition Technicians have permission to analyze exhibits in the MultiViewer 
and Side-by-Side Viewer. The reference and test exhibits must be selected from 
the Navigation tree. Acquisition Technicians cannot view correlation results 
and hits or create reports.

Expert Acquisition Technician
In addition to being able to perform the above tasks, Expert Acquisition 
Technicians can also:

• Create manual correlation requests
• View correlation requests and results
• Change the status of correlation requests
• Delete correlation requests
• Create and modify hits
• Delete unconfirmed hits

Firearm Examiner
In MATCHPOINT+, Firearm Examiners can perform the same tasks as Expert 
Acquisition Technicians.
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Specialty User Roles
In addition to core user roles, there are specialty roles that provide access to 
restricted features. Depending on the structure of your facility, users may have 
one or more specialty role. The specialty roles are:

• Report
• Administrator

Report
The Report role provides access to create, view and print reports.

Administrator
The Administrator role provides access to preferred settings to force defaults 
for the system. When a default is forced, the setting overrides user preferences. 
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System Connectivity

MATCHPOINT+ can be connected to two different types of nodes:

• An IBIS® Data Concentrator
• An IBIS® Correlation Server

Node Descriptions
The following table describes the nodes. 

Component Description

Data Concentrator The server that stores in a database all the bullet information 
and images that are received from the BULLETTRAX-3D 
Acquisition Station, and all the cartridge case information and 
images that are received from the BRASSTRAX-3D Acquisition 
Station.

Correlation Server Stores compressed images, image signatures, and information 
about cases and exhibits. After an exhibit’s signature has been 
extracted, this signature is copied to the Correlation Server. 
When a correlation is performed, the database stored on the 
server is accessed, and the signatures of the acquired images 
are compared.

MATCHPOINT+

Correlation Server

Data Concentrator
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Workflow

The following diagram shows the users, their tasks, and the components that 
are used to perform the tasks.

  

Note: The physical networking configuration of MATCHPOINT+ 
can be adjusted according to specific needs.

 

Data Concentrator

BRASSTRAX-3D 
Acquisition Station

BULLETTRAX-3D 
Acquisition Station

MATCHPOINT+ 
Analysis Station

Correlation Server

Expert Acquisition 
Technician,
Firearm Examiner

ANALYSISIMAGING

User: IBIS Administrator

STORAGE DATA PROCESSING

Acquisition Technician, 
Expert Acquisition Technician,
Firearm Examiner

Users: Users: 
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Logging On to Windows

Before logging on to MATCHPOINT+, you must log on to the Microsoft® 
Windows® operating system using the user name and password assigned to 
you by your IBIS Administrator.

To log on to Windows:

1. Enter your user name and password.
  

Note: If your IBIS Administrator has reset your password, or if it 
is the first time you are logging on, the system will prompt you to 
replace the current password with a new one.

 

2. Click OK.

If your user name and password are accepted, you obtain access to your 
computer desktop.

Related Topics 
Changing the Language (page 28)
Logging on to IBIS MATCHPOINT+ (page 29)

Exiting IBIS MATCHPOINT+ (page 64)
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Changing the Language

If multiple languages are installed, you can change the language used in 
MATCHPOINT+ windows, dialog boxes, and menus. You must choose a 
language the first time you start the MATCHPOINT+ application.

To change the language:

1. From the Windows Start menu, select Programs > Forensic 
Technology > IBIS MATCHPOINT+ > Language Selector.

The Language Selection window opens.

2. Select a language.

3. Click OK.

When you start the application, all text in MATCHPOINT+ windows, dialog 
boxes, and menus is displayed in the selected language.

Related Topics 
Logging on to IBIS MATCHPOINT+ (page 29)

Exiting IBIS MATCHPOINT+ (page 64)
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Logging On to IBIS MATCHPOINT+

After you have logged on to Windows, you can start the MATCHPOINT+ 
application from the Windows Start menu. Use the user name and password 
assigned to you by your IBIS Administrator. For more information on creating 
accounts, refer to the IBIS Products Administration Guide. 

To log on to MATCHPOINT+: 

1. Start MATCHPOINT+ in one of the following ways:

• Double-click the MATCHPOINT+ icon that is on the desktop.

• From the Windows Start menu, select Programs > Forensic 
Technology > IBIS MATCHPOINT+.

A series of built-in tests are run to test if the CPU, operating system, and 
screen resolution meet the system requirements, and if the system has 
booted in safe mode. If a test fails, you are prompted to specify if you want 
to continue using the application. If the computer boots in safe mode due 
to a problem, do not use the application. Contact your IBIS Administrator.

When startup is complete, the MATCHPOINT+ Logon window opens.

2. Enter your user name and password.
  

Tip: To change the display of the characters that you type, 
right-click in the Password field and select Visual Feedback.

 

3. Click OK.
  

Note: The first time you log on, the Software License Agreement 
appears. You must click “I Agree” to be able to work with 
MATCHPOINT+.
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If your user name and password are accepted, the Home Page opens and 
you can start working with MATCHPOINT+. Your user name displays on 
the Status bar.

The right-hand side of the window provides basic information about the 
MATCHPOINT+ application. The Navigation tree provides access to the 
different sites, and the cases and exhibits that are contained within these 
sites.

  

Note: If you have not logged on for a certain number of days, as 
configured by your IBIS Administrator, you will be denied access 
to the system. If this happens, contact your IBIS Administrator.

 

Related Topics 
Changing Your Password (page 31)
Using Windows-Based Features (page 40)

Exiting IBIS MATCHPOINT+ (page 64)
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Changing Your Password 

For security reasons, you should change your password on a regular basis. 
Follow your facility’s guidelines, if any. 

Your IBIS Administrator may set a period of time after which your password 
will expire. You will then be asked to enter a new password. Your IBIS 
Administrator can tell you the minimum and maximum allowable number of 
characters in your password. 

  

Note: If domain accounts are implemented in your system, then 
there is only one user account (on the MATCHPOINT+ domain 
account computer). If local accounts are used, each user has two 
accounts, one on the MATCHPOINT+ computer and one on the 
Data Concentrator. However, these accounts are not the same 
account and the passwords can be different. 

 

To change your password:

1. Press CTRL+ALT+DELETE.

The Windows Security view opens.

2. Click Change Password.

The Change Password window opens.

3. Enter your current password in the Old password field.

4. Enter your new password in the New password field.

5. Confirm your new password by re-typing it in the Confirm password 
field.

6. Click OK to record your new password into the system.

Related Topics 
Logging On to Windows (page 27)

Exiting IBIS MATCHPOINT+ (page 64)
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Exploring Areas of the Application

The MATCHPOINT+ graphical user interface (GUI) consists of the following 
areas: 

Interface Elements
The following table describes each area in more detail:

Summary view

Status bar

Column header

Navigation 
tree

Toolbar

Menu bar

Title bar

Information view

Interface Element Description

Title bar Displays the name of the application.

Menu bar Displays the menus from which MATCHPOINT+ tasks are 
carried out. 

Toolbar Displays buttons that provide an alternative method of 
performing the most common tasks in MATCHPOINT+. 
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Navigation tree Displays sites, the cases at each site, and the bullet and 
cartridge case exhibits that are associated with each case. For 
more information, see Navigation Tree (page 34).

Status bar Displays messages, and other information like the description of 
tasks, and the user name of the user currently logged on.

Summary view When an exhibit is selected, displays a list of the images that 
have been acquired, as well as some basic information about 
each image, such as the most recent modification date and the 
status of the exhibit.

When a case is selected, displays its associated exhibits and 
some basic information about each exhibit, such as caliber, 
make, and event type.

When a correlation request is selected, displays the correlation 
results. 

Column header Area in which right-clicking activates a context menu of display 
features to Group and Show’Hide columns.

Information view Displays detailed information about the selected case or exhibit. 
This is also where correlation requests, hits, and reports are 
listed.

Interface Element Description
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Navigation Tree
The Navigation tree displays sites, the cases at each site, and the bullet, 
cartridge case, and firearm exhibits that are associated with each case. 
Clicking an object in the tree displays information about the selected object in 
the Information view and Summary view which appear to the right of the 
Navigation tree. 

Site

Case folders

Legend

Remote site

Case folder (no hits)

Case folder (at least one exhibit is involved in a hit)

Cartridge case exhibit

Bullet exhibit

Bullet exhibit

Acquired images

Local site

Cartridge case image

Bullet image

Bullet test fire exhibit

Cartridge case test fire exhibit

Firearm exhibit

Bullet exhibit (hit)

The case has been imported

The case or exhibit is new or has been modified
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The following icons appear at the top of the Navigation tree:

About Sites Managed by Jurisdiction
A jurisdiction is a functional perspective that allows users to recognize the sites 
that are configured for their analysis network. There may be one or more sites 
configured to be in your jurisdiction. The sites that display in the Navigation 
tree with a colored site icon are in your jurisdiction. Sites with a gray icon are 
not in your jurisdiction.

The availability of some features in MATCHPOINT+ depends on your 
jurisdiction configuration. For example, to create a hit, at least one of the 
exhibits must be in your jurisdiction, and to view a Correlation Request, the 
reference exhibit must be in your jurisdiction.

If you have the required privileges, there are no feature limitations or access 
restrictions to the sites in your jurisdiction. For some developed IBIS solutions, 
customized networks may be configured to enable connectivity and data 
sharing between jurisdictions.

Opens the Correlations window
Opens the Hits window

Lists the reference and test 
exhibits selected for display in the 
MultiViewer or the Side-by-Side Viewer

Opens the Reports window

Opens the Filter window

Opens the Search window

Opens the System Messages window
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Menu Bar
The following table describes the menus that are available from the menu bar:

Menu Item Action

File New Displays the following options:

• Manual Correlation Request opens the Correlation 
Request dialog box (page 277) for a selected exhibit, 
in which you specify filter criteria. 

• Report opens the New Report dialog box (page 390) 
in which you select the template you want to use to 
generate the report.

Print Opens the Print dialog box.

Refresh Refreshes the displayed information by reloading data 
from the database.

Exit Closes the application.

Edit Modify If a hit is selected in the Hit list, opens the Modify Hit 
dialog box (page 381). 

For data that has been migrated from IBIS Heritage, 
the case or exhibit information can be modified.

Modify All Images This item is disabled in MATCHPOINT+.

Delete Deletes the selected correlation request, hit, or report.

For data that has been migrated from IBIS Heritage, 
the case or exhibit can be deleted.

Restore This item is disabled in MATCHPOINT+.

Search Replaces the contents of the Information window 
with a group of fields that allows you to specify 
criteria for finding a particular case or exhibit.

View Toolbar Shows or hides the toolbar, depending on the current 
state.

Status Bar Shows or hides the status bar, depending on the 
current state.

New Filter Opens the appropriate Filter dialog box in which you 
can specify filter options to limit the scope of the 
display.
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Tools Synchronize This option is disabled in MATCHPOINT+.

Preferences Opens the Preferences dialog box (page 263) in which 
users can define their default preferences.

Quick Search Opens the Quick Search dialog box (page 271) to find 
items in a list.

Preferred Lists Opens the Preferred Lists dialog box (page 273) in 
which data lists can be defined.

Side-by-Side Viewer Opens the Cartridge Case Side-by-Side Viewer 
(page 347) or the Bullet Side-by-Side Viewer 
(page 355).

This item is enabled when a reference exhibit and a 
test exhibit have been selected.

MultiViewer Opens the Cartridge Case MultiViewer (page 331) or 
the Bullet MultiViewer (page 339).

This item is enabled when a reference exhibit and a 
test exhibit have been selected.

Data Export Opens the Data Export dialog box (page 326).

Help Help Opens IBIS MATCHPOINT+ help.

About IBIS 
MATCHPOINT+

Opens a window that displays basic information 
about the MATCHPOINT+ application.

Menu Item Action
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Toolbar
You can use the buttons on the toolbar to access common commands. The 
following buttons are available on the toolbar of the main window:

Click To

Delete correlation requests in the Correlations window (page 285). 
Delete hits in the Hits window (page 383). Delete reports in the 
Reports window (page 387).

Open the Print dialog box.

Refresh the displayed information by reloading data from the 
database.

Set the selected exhibit as the reference exhibit. This button is 
enabled when an exhibit is selected from the Navigation tree.

Set the selected exhibit as the test exhibit. The previous test exhibit 
list is cleared.

Set the selected exhibit as an additional test exhibit; adding to the 
test exhibit list.

Open the Cartridge Case Side-by-Side Viewer (page 347) or the 
Bullet Side-by-Side Viewer (page 355).

This button is enabled when a reference exhibit and a test exhibit, or 
a correlation request have been selected.

Open the Cartridge Case MultiViewer (page 331) or the Bullet 
MultiViewer (page 339). 

This button is enabled when a reference exhibit or a correlation 
request has been selected.

Change the status of a correlation request from Correlation Done to 
Previously Viewed after a Firearm Examiner has analyzed the 
correlation results. This can be done in the Correlations window 
(page 285) only.

Change the status of a correlation request from Previously Viewed 
to Correlation Done in the Correlations window (page 285).
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Open the New Report dialog box (page 390) so that you can create 
a new report from a template or create a new custom report 
template. 

Open Help.

Click To
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Using Windows-Based Features

MATCHPOINT+ runs on the Microsoft Windows operating system and follows 
many of the Windows standard conventions. The functionality that is specific 
to MATCHPOINT+, as well as some standard Windows functionality are 
described in the following sections:

• Cursor Modes (page 40)
• Using List Boxes (page 41)
• Using the Calendar (page 41)

Cursor Modes
The following cursor modes are available in the MATCHPOINT+ Viewers: 

Cursor Mode Action

Translate Click and drag an image in the Side-by-Side 
Viewer to move the image.

Note: This cursor is blue when it is positioned over 
the end point of a ruler in the Bullet Side-by-Side 
Viewer and is used to move the ruler.

Rotate Click and drag to rotate a cartridge case image 
clockwise or counterclockwise in the Side-by-Side 
Viewer and MultiViewer.

Horizontal move Click and drag to reposition the hairline in the Side-
by-Side Viewer.

Vertical move Click and drag to move a mosaic vertically in the 
Bullet Side-by-Side Viewer and Bullet 
MultiViewer.
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Using List Boxes
List boxes contain a list of pre-defined options. 

To select information in a list box: 

1. Click the arrow to the right of a field to display the list. 

2. Click an item in the list to select it.
  

Tip: Enter the first letter(s) or number(s) to go to the item in the 
list that starts with this (these) letter(s) or number(s).

 

Using the Calendar
You can open a calendar to simplify the task of entering dates into date fields.

To open the calendar:

• Click the arrow to the right of a date field to display the calendar.
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The Calendar dialog box opens.

To specify a date using the calendar:

1. Use the arrows to select the month:

2. Click a date on the calendar.
  

Tip: You can also specify the date without opening the calendar 
by clicking that part of the date that you want to change and 
typing over it.

 

The calendar closes and the date field displays the selected date.

In some fields, there is a check box that must be selected to certify that the 
date is chosen, as shown below.

Click To

Go back one month.

Go forward one month.

Today’s date

Date 
selection

Click to change the year

Reverse and forward
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Speeding Up the Way You Work

You can speed up the way you work in MATCHPOINT+ by: 

• Using keyboard shortcuts and function keys (page 43)
• Using context menus (page 44)
• Using search (page 46)

Using Keyboard Shortcuts and Function Keys
You can use the following keyboard shortcuts and function keys to carry out a 
command directly from the keyboard without having to use your mouse:

Press  To

F1 Open the IBIS MATCHPOINT+ Help.

F3 Display the search fields in the Information view. For more 
information, see Using Search (page 46).

F5 Reload case, correlation request, hit information, or reports 
from the database.

CTRL+C Copy a selection from an input field.

CTRL+M Create a manual correlation request.

CTRL+P Print. 

CTRL+Q Filter the cases that are displayed in the Navigation tree.

CTRL+T Create a new report.

CTRL+V Paste your cut or copied selection into an input field.

CTRL+X Cut a selection from an input field.
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Using Context Menus
When you right-click on specific items in the Navigation tree or Information 
view, a context menu opens with commands. The commands that appear 
depend on where you click in the interface. Many of these commands are also 
found in the menu bar. The context menu provides a faster way of achieving 
the same result. 

Select To

These items appear when a site is selected:

Filter Filter the cases that are displayed in the Navigation tree by 
specifying a set of filter criteria.

Search Search for cases or exhibits belonging to the selected site.

Unapply Filter Unapply a case filter, if one is applied.

These items appear when a case is selected:

Submit This item is disabled in MATCHPOINT+.

Modify This item is disabled in MATCHPOINT+.

Delete This item is disabled in MATCHPOINT+.

Restore This item is disabled in MATCHPOINT+.

Print Open the Print dialog box.

These items appear when an exhibit is selected:

Set as Reference Exhibit Make the selected exhibit the reference exhibit.

Set as Test Exhibit Make the selected exhibit the test exhibit so that it can be 
viewed in the MultiViewer (page 329) or the Side-by-Side 
Viewer (page 345) along with the current reference exhibit.

Add to Test Exhibits Add the selected exhibit to the existing selection of test 
exhibits.

Manual Correlation 
Request

Create a manual correlation request.

Reimport Exhibit Reimport an exhibit to ensure the information is up-to-date.

Export Exhibit Export an exhibit to another site.
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Modify All Images This item is disabled in MATCHPOINT+.

Restore Archived Images This item is disabled in MATCHPOINT+.

Modify This item is disabled in MATCHPOINT+.

Delete This item is disabled in MATCHPOINT+.

Print Open the Print dialog box. 

These items appear when a correlation request is selected:

Side-by-Side Viewer View the correlation results of the selected correlation 
request in the Side-by-Side Viewer (page 345). The sort order 
in the correlation results list determines the display order of 
the exhibits in the viewer.

MultiViewer View the correlation results of the selected correlation 
request in the MultiViewer (page 329).

Correlation Results 
Filtering

Open Correlation Results Filtering (page 119).

Status Change the status of the selected correlation request to 
Viewed or Not Viewed.

Delete Delete the selected correlation request.

Correlation Request 
Information

Open the Correlation Request Information dialog box 
(page 291), which displays detailed information about the 
selected correlation request.

Reference Exhibit 
Information

Open the Reference Exhibit Information dialog box.

Print Correlation Results Open the Print Correlation Results dialog box (page 297).

These items appear when a correlation result is selected:

Compare Exhibits Open the Side-by-Side Viewer (page 345). The reference 
exhibit that is selected in the Correlation Requests view 
(page 287) and the test exhibit that is selected in the 
Correlation Results view (page 287) are displayed.

Import Exhibit Import an exhibit that is stored on a remote server.

Select To
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Using Search 
You can search for cases and exhibits using different criteria. The available 
criteria change according to the type of search. Types of searches include case, 
cartridge case exhibit, bullet exhibit and firearm exhibit. A maximum of 2000 
search results can be returned.

The search feature is intended for simple queries, for example, finding a certain 
case using the case number or the date that it was created. 

A search cannot be saved or edited. For more on information management, 
see Working with Filters (page 49).

To perform a search:

1. From the Edit menu, select Search. 

The Search window is displayed in the Information view.

2. Select a search type from the Type list.

The criteria for the search type are displayed in the Fields panel.

3. From the Fields panel, select a criterion and click the right arrow.

The dialog box for that criterion opens.

4. Define the parameter(s) and click OK. If you selected a data criterion, see 
Date dialog box (page 267) for more information.

The criterion is added to the Criteria panel on the right.

5. Define the details of the search as required:

• To add another criterion to the search, repeat step 3. An “And” 
statement will be added to the search.

• To add the same criterion with a different definition, repeat step 3. An 
“Or” statement will be added to the definition. For example, Law 
Agency: Anytown or Anycity.

• To modify a criterion in the Criteria panel, double-click it and revise the 
definition in the dialog box.

Reimport Exhibit Reimport an exhibit that is stored on a remote server.

Test Exhibit Information Display the test exhibit details.

Select To
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• To remove a criterion from the Criteria panel, select it and click the left 
arrow.

  

Tip: To activate a pop-up window of the search definition, hold 
your mouse over any of the fields in the Criteria panel. To close 
the pop-up window, click anywhere.

 

6. Click Search to activate the search.

Results are displayed in the Summary window.

The Search button becomes the Stop button for the duration of the 
search. You can click the Stop button at any time to stop the search.

Related Topics 
Working with Filters (page 49)
Using Quick Search (page 57)
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Reading System Messages

System messages are sent to individual MATCHPOINT+ workstations to 
provide more information about system events and errors. If an error occurs, 
for example, when exporting an exhibit, a descriptive message is sent to the 
System Messages folder. A system message can help users understand, or 
perhaps resolve, an issue.

Messages can be opened by any user who has access to the workstation. If a 
message is not read during the expiration period, it is automatically removed.

  

Note: The expiration period for system messages is configurable. 
The default is 180 days.

 

To open a system message:

1. From the Navigation tree, click System Messages to open the folder.

The current messages are displayed.

2. Double-click the message you want to read.

The message opens.

To delete a system message:

1. From the Navigation tree, click System Messages to open the folder.

The current messages are displayed.

2. Right-click the message you want to delete.

3. Select Delete from the context menu.

The message is deleted.
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Working with Filters

Use filters to customize the information you want to display. You can create 
filters for cases that display in the Navigation tree, and for correlation requests 
that display in the Information view. 

The criteria that you can include in a filter depend on the type of filter you 
create. When a filter is applied, only the information that meets your criteria is 
displayed.

  

Note: You do not have to reapply a filter each time you log on. 
The filters that you apply remain until you remove or modify them. 

 

A filter can have many criteria defined, but only one filter type can be applied 
at a time. The filters that you create are for your use only; they cannot be 
shared with other users. 

To create a filter:

1. From the View menu, select New Filter.

2. Select the type of filter you want to create:

• Cases

• Correlation Requests

The Filter dialog box (page 265) opens. The available fields depend on the 
type of filter.

  

Tip: Use the shortcut from the Navigation tree by right-clicking 
the item you want to filter and selecting Filter.

 

3. From the Fields panel, select a criterion and click the right arrow. 

The dialog box for that criterion opens.

4. Define the parameter(s) and click OK. If you selected a date criterion, see 
Date dialog box (page 267) for more information.

The criterion is added to the Filter panel on the right.

5. Define the details of the filter as required:
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• To add another criterion to the filter, repeat step 3. An “And” statement 
will be added to the filter.

• To add the same criterion with a different definition, repeat step 3. An 
“Or” statement will be added to the definition. For example, Law 
Agency: Anytown or Anycity.

• To modify a criterion in the Filter panel, double-click it and revise the 
definition in the dialog box.

• To remove a criterion from the Filter panel, select it and click the left 
arrow.

  

Tip: To activate a pop-up window of the filter definition, hold 
your mouse over any of the fields in the Filter panel. To close the 
pop-up window, click anywhere.

 

6. When you are finished, type a name for the filter in the Name field.

7. Type a brief description in the Description field.

The name and description appear in the Filters list to help you manage the 
filters you create.

8. Click Save or Save & Apply.

The new filter is added to the Filters list.

To apply a filter:

1. From the Navigation tree, click Filters.

The Filters list is displayed.

2. Double-click the filter that you want to apply.

The filter is applied and indicators are set as follows:

• In the Filters list, a green check mark appears beside a filter that is 
applied.

• For an applied case filter, a message is displayed at the top of the 
Navigation tree: Case filter: [filter name].

• For an applied list filter, a message is displayed at the top of the 
Information view: Filter Type {Filter: [filter name]}.



CHAPTER 2  Getting Started
Working with Filters

51

To modify a filter:

1. From the Navigation tree, click Filters.

The Filters list is displayed.

2. Right-click the filter that you want to modify and select Modify.

The Filter dialog box (page 265) opens. The available fields depend on the 
type of filter.

3. From the Fields panel, select the criteria that you want to modify.

Modify the criteria and parameters as required.

4. Click Save.

To unapply a filter:

1. From the Navigation tree, click Filters.

The Filters list is displayed.

2. Right-click the filter that you want to undo and select Unapply.

The filter and the green check mark are removed.
  

Tip: Use the shortcut from the Navigation tree by right-clicking 
the item and selecting Unapply Filter.

 

To delete a filter:

1. From the Navigation tree, click Filters.

The Filters list is displayed.

2. Right-click the filter that you want to delete and select Delete.

3. Click Yes.

The filter is deleted from the list.
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Defined Filters
The defined filters that are provided with MATCHPOINT+ are displayed in the 
Filters list. These filters are available for all users and cannot be modified. 
Defined filters are described in the following table.

Related Topics 
Using Search (page 46)
Grouping List Information (page 53)

Name Type Description

Load Case On Demand Case When you apply this filter, all the cases in the 
Navigation tree are hidden. You can then use 
Search (F3) and select criteria to identify the 
cases you want to load. 

Select the case(s) from the search results, and 
then right-click to load the ones you want to 
display in the Navigation tree.

Confirmed Hits Hit When you apply this filter, only the confirmed hits 
display in the Hits list. 

Unconfirmed Hits Hit When you apply this filter, only the unconfirmed 
hits display in the Hits list. 
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Grouping List Information

Use groups to customize the information that you want to display in a list. You 
can select up to four items to group and control which columns you want to 
show in the Information view. For example, a list may be more meaningful if 
the event type is grouped and the site name column is hidden. A group cannot 
be saved.

  

Tip: To manage large amounts of information, you can group a 
list that has been filtered, see Work with filters (page 49). The 
resulting list can be further enhanced by sorting the columns.

 

To group a list:

1. Display the list information that you want to group. For example, select 
Correlation Requests from the Navigation tree.

2. Right-click the column header bar in the Information view and select 
Group.

The Group By dialog box (page 269) opens.

3. From the drop-down list, select the first item that you want to group.

4. Click Ascending or Descending for the sort order.

5. By default, the column of a grouped item is hidden. If you want to display 
the column, select the Show Column check box.

  

Note: You can right-click the column header and select Show/
Hide Columns to control which columns show. The display order 
of columns cannot be modified.

 

6. If you want to group another item, repeat step 3. 

A maximum of four items can be defined for one group.

7. Click OK.

The list displays according to the defined groups. Click the plus sign (+) or 
minus sign (-) to expand or collapse grouped information. 
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If you sort a column when a list is grouped, the column header will display 
the next sort number. For example, if there are two grouped items, the 
sorted column displays the number three.

To modify or ungroup information:

1. Display the grouped information. For example, select Correlation Requests 
from the Navigation tree.

2. Right-click the column header bar in the Information view and select 
Group.

The Group By dialog box (page 269) opens.

3. Modify the group as required, or click Clear All to remove all the groups.

4. Click OK.

Third item sorted

Second grouped 
item

First grouped
item
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Using Tools

The Tools menu provides you with the following commands:

• Setting Your Preferences
• Using Quick Search
• Defining Preferred Lists
• Side-by-Side Viewer (enabled when a reference exhibit has been selected)
• MultiViewer (enabled when a reference exhibit has been selected)

Setting Your Preferences
You can eliminate redundant tasks and set your preferences based on how you 
want to work. Your preferences are associated with your user account, so 
when you log on, your settings are applied.

There are more than 100 preferred default settings you can save for the 
MultiViewer, the Side-by-Side Viewer, display options, manual correlations, 
printing and CMS calculation.

  

Note: This feature is not available if a workstation is configured 
to force the same preferences for all users.

 

The Preferences dialog box (page 263) displays the Current Values for the 
preferences that you can edit. The system Default Values are also provided 
for your reference if you want to reset.

You can also save your preferences when you use a feature, for example, 
display options in the MultiViewer or chart type in Correlations Results 
Filtering. 

To set your preferences:

1. From the menu bar, select Tools > Preferences.

The Preferences dialog box (page 263) opens with all the groups of 
preferences.

2. Click the plus sign ( + ) next to the group you want to open.

3. In the Current Value column, select or enter the value you want for a 
specific preference.
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The values you change display in red text.
  

Note: Click Undo Changes to cancel the changes but keep the 
dialog box open. Click Cancel to close without saving.

 

4. Click Save.

Your changes are now displayed in black text.

5. Click Close.

Resetting Preference Values
Use the context menu to reset preference values. You can reset a single 
preference value, or all the values. There are two kinds of defaults, one that is 
set for your system, and one that is standard for all MATCHPOINT+ 
applications.

  

Note: You cannot reset a default if the Administrator has forced 
a preference value for your workstation.

 

To reset a preference:

1. Click the plus sign ( + ) next to a group and select the preference you 
want to reset.

2. Right-click and select Reset to Default Value, or Reset to Factory 
Value. 

The value is displayed in red text to indicate the change.

3. Click Save.

The value is displayed in black text.

4. Click Close to the window.

To reset all preferences:

1. Right-click any preference group and select Reset All to Default Values, 
or Reset All to Factory Values.

All the preferences for all the groups are reset. Any values that change are 
displayed in red text. 
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2. Click Save.

The value is displayed in black text.

3. Click Close to the window.

Using Quick Search
Quick Search helps you locate items in lists displayed from the Navigation tree. 
Simply type a few characters or a whole word and Quick Search opens and 
focuses on the first matching item (if there is one) in the column used to sort 
the list.

Advanced mode gives you the flexibility to match the case or the whole 
word—and find the characters anywhere in the column. For example, you can 
find, pin and alpine. By default, Quick Search looks in the column used to sort 
the list, but you can select a different column to search. As well, you can select 
which direction you want to search.

  

Note: A gray triangle in the column header indicates which 
column is used to sort a list. Click the column header to select a 
different column to sort. 

 

Quick Search stays on top of the window until you close it, change the view, or 
press ESC. Quick Search is activated automatically from the keyboard, but you 
can also open it from the Tools menu.

To find an item in a list:

1. Display any list available from the Navigation tree.

2. Enter the text you want to find.

The Quick Search dialog box (page 271) opens and searches in the column 
used to sort the list. The first matching item is selected, if there is one. 

3. Select Advanced mode to extend the search options:

• To match the case or whole word.

• To search in another column.
• To find the next or previous occurrence.
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Defining Preferred Lists
Some data lists can be very long, such as those for calibers and law 
enforcement agencies. To make these lists easier to use, frequently referenced 
items can be defined as preferred data. When a list is first displayed, only the 
preferred list items are shown. 

  

Note: Only users with the Administrator role can define or edit 
preferred lists. 

 

To synchronize the data lists throughout your IBIS® TRAX-3D™ network, 
preferred lists should be defined on a MATCHPOINT+ Analysis Station that is 
connected to a centralized Data Concentrator. Acquisition Stations that are 
part of the network receive updated preferred lists from the Data Concentrator 
after a synchronization is performed. 

Unique lists can also be maintained and not overwritten; for example, if there 
is one Acquisition Station in your network for which a different list of calibers 
is appropriate. Contact technical support for more information.

To define a preferred list:

1. Click Tools > Preferred Lists.

The Preferred Lists dialog box (page 273) opens.

2. From the List Names drop-down list, select the list that you want to define.

3. From the complete list on the left, select the item(s) you want to include in 
the preferred list and then click the right arrow. 

To remove item(s) from a preferred list, select the item(s) and then click 
the left arrow.

4. Click Save.

The changes you made are applied to the selected list. 

5. Select another list to define, if required.

6. Click Close when you are finished.

The dialog box closes.
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Getting Help

There are several ways in which you can get information about 
MATCHPOINT+:

• Using Help (page 59)
• Consulting the documentation (page 62)
• Contacting technical support (page 63)

Using Help
MATCHPOINT+ Help contains procedures and reference information. 
Procedures provide step-by-step instructions about how to complete a task. 
Reference topics describe MATCHPOINT+ windows and dialog boxes. 
MATCHPOINT+ Help is divided into three major sections:

• Introducing IBIS MATCHPOINT+ provides an overview of the product, 
and describes the MATCHPOINT+ interface and its features.

• Working with IBIS MATCHPOINT+ contains procedures that provide 
step-by-step instructions on how to request manual correlations and 
analyze images using the MultiViewer and the Side-by-Side Viewer.

• IBIS MATCHPOINT+ Reference describes the windows and dialog 
boxes in MATCHPOINT+.

MATCHPOINT+ Help is a compiled Microsoft HTML Help system and follows 
the standard Microsoft HTML Help conventions. The following sections 
describe some of the Help functionality which you may find useful.
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Help Overview
The MATCHPOINT+ Help interface displays the Help Viewer in the left pane 
and a Help topic in the right pane. The Help Viewer provides an integrated 
Table of Contents, Index, and full-text Search capability to help you find 
information easily. You can view the Contents, Index, or Search results while 
you are viewing a Help topic. You can also bookmark topics for easy retrieval 
from the Favorites page.

Opening MATCHPOINT+ Help
To open Help within MATCHPOINT+, do one of the following:

• From the menu bar, click Help > Help.
• Press F1.
• Click the Help button in a dialog box to open the relevant help topic.

To open Help from outside the MATCHPOINT+ application:

• From the Windows Start menu, select Programs > Forensic Technology 
> IBIS MATCHPOINT+ > Help. 

Navigating Through Topics
On the Contents page, you can click the plus (+) and minus (-) signs to open 
and close each book and view the topics and subtopics. When you click a book 
icon or topic title, the corresponding topic is displayed. 

The Help topics also provide numerous ways for you to either browse 
sequentially through topics or select the type of information that you want to 
view. The following table lists some of the conventions that are used to help 
you navigate through the topics:

Item Location Description

Top and bottom corners of 
the topic view

Click to move to the previous or 
next topic page.

Top and bottom corners of 
the topic view

Click to return to the last page 
viewed.
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Printing a Topic
With MATCHPOINT+ Help, you can print either the selected topic or all topics 
in the selected heading. 

To print a topic alone or with subtopics:

1. From the Contents tab, select the topic.

2. On the toolbar, click Print.

The Print Topics dialog box opens.

3. Select whether you want to print just the selected topic or all topics in the 
selected heading, and then click OK.

The Windows Print dialog box opens.

4. Define your printing options, and then click Print.

The topic is sent to the selected printer. 
  

Note: If you select the topic from the Index, Search, or 
Favorites tab (rather than from the Contents tab), 
MATCHPOINT+ goes directly to the Windows Print dialog box.

 

Help toolbar Click to return to the topic that 
you were viewing previously.

Blue, underlined words 
within any topic

Click to jump to a related topic.

End of procedural topic Click to display a list of related 
procedural topics.

At the beginning of reference 
topic

Click to jump to the “How Do 
I…?” links for the window or 
dialog box that you can select 
to view related procedural 
topics.

Item Location Description
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Bookmarking a Topic
When you find a topic that you are likely to refer to again, you can bookmark it 
for quick retrieval. 

To bookmark the current Help topic:

1. Click the Favorites tab.

2. Click the Add button.

The topic is added to the list of favorites.
  

Tip: To remove a bookmark from the Favorites list, select the 
bookmark, and then click Remove.

 

To view a bookmarked topic:

1. Click the Favorites tab.

2. Double-click the topic that you want to view.

Consulting the Documentation
MATCHPOINT+ includes a comprehensive set of learning materials. Consult 
the following documentation to familiarize yourself with the application.

• IBIS MATCHPOINT+ Help contains comprehensive online information that 
describes how to perform the basic and advanced tasks that are related to 
working with the MATCHPOINT+ application.

• IBIS MATCHPOINT+ User Guide is a PDF file that contains the same 
information as the online help in a printable format.

• IBIS Products Administration Guide describes how to configure and 
troubleshoot the IBIS TRAX-3D system.
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Contacting Technical Support
For information about the minimum system requirements necessary to run 
MATCHPOINT+, or for technical support, contact MATCHPOINT+ Support. You 
can contact us by phone, fax, or email.

Providing Feedback
We are dedicated to continually improving our documentation products. Please 
include the title of the document, its part number, version, and the specific 
section that you are commenting on in all correspondence. We appreciate your 
comments, and will use your advice to improve our services.

Send your comments to: documentation@contactft.com

Europe, Africa, and 
Western Asia

Americas, Oceania, and Asia 
(other than western)

Toll-free number 800 4247 4247 866 984 4247

Direct number +353 1 690 9199 +1 727 826 7236

Fax +353 1 457 1822 +1 727 826 7242

Email fti.support@contactft.com fti.support@contactft.com
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Exiting IBIS MATCHPOINT+ 

After completing your work, you must exit the application properly. 

To exit MATCHPOINT+:

1. From the File menu, select Exit.

A confirmation window is displayed.

2. Click Yes.

The MATCHPOINT+ application closes.

Related Topics 
Logging On to Windows (page 27)
Changing Your Password (page 31)
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Working with IBIS MATCHPOINT+

This section covers the following topics: 

About Correlations..................................................................................... 67
Working with Cases and Exhibits................................................................ 87
Working with Correlation Requests and Results ........................................ 107
Analyzing Images with the MultiViewer .................................................... 127
Analyzing Images in the Side-by-Side Viewer ............................................ 155
Working with Hits .................................................................................... 219
Creating Reports...................................................................................... 229
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About Correlations

This section covers the following topics: 

Overview ................................................................................................... 69
How Automatic Correlations Are Processed ................................................ 71
Event Types................................................................................................ 72
Caliber Families.......................................................................................... 74
Correlation Status ...................................................................................... 75
Correlation Scores...................................................................................... 76
Understanding Cartridge Case Correlation Scores ....................................... 77
Understanding Bullet Correlation Scores..................................................... 80
Correlation Analysis Process....................................................................... 85
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Overview

Images that are acquired by BULLETTRAX-3D, BRASSTRAX-3D, BrassCatcher 
or BulletProof are stored in databases and are correlated (digitally compared) 
against one another. A correlation identifies similarities between images, and 
ranks likely candidates for initial analysis. There are two types of correlation 
requests: automatic and manual.

Automatic Correlation Requests
After a cartridge case or bullet exhibit is submitted and synchronized, the IBIS 
TRAX-3D system automatically generates a correlation request, using default 
settings, for the acquired exhibit. Correlation requests are processed by a 
Correlation Server, a large-capacity processor and storage unit that serves a 
geographical region. 

Manual Correlation Requests
Using MATCHPOINT+, you can also submit correlation requests manually if the 
default settings are not applicable. For example, you may need to correlate a 
particular exhibit against exhibits in other geographical regions or using 
correlation criteria that are different from the defaults. 

Reference Exhibits and Test Exhibits
During a correlation, a digital representation of the exhibit image, called a 
signature, is copied to the Correlation Server and is compared against all other 
exhibit signatures on the server. The exhibit that is compared with the exhibits 
in the database is the reference exhibit. The exhibits in the database with 
which the reference exhibit is compared are test exhibits.

A reference exhibit can be correlated against test exhibits in either a local or 
an external jurisdiction. The amount of time it takes to perform the correlation, 
as well as the volume of correlation results, depends on the scope of the 
request and the size of the database consulted.
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Correlation Scores
A correlation score is calculated for each pair of exhibits (reference and test1, 
reference and test2, etc.) and reflects how similar the region of interest (ROI) 
of a test exhibit is to that of the reference exhibit. Correlation scores provide 
an indication of which exhibit pairs are potential matches. The actual scores 
are used to rank samples based on the degree of similarity between the 
signatures, and have minimal intrinsic value outside of their specific correlation 
request. 

Image Analysis
High-ranking exhibit pairs are compared in MATCHPOINT+ to identify 
potential matches. When one is found, a hit is recorded to link the two exhibits 
to the same firearm. A firearm examiner can then analyze the physical 
evidence using a comparison microscope to confirm the hit in MATCHPOINT+.

International Data Sharing
For network configurations that allow international data sharing, the process 
for a manual correlation differs in the following ways:

• The correlation site selection includes sites that are from other countries. 
The international sites available in you configuration appear in the site 
selection list.

• The results from an international correlation request include:

• Only 2D compressed images or images from IBIS Heritage acquisitions.
• If configured, case and exhibit information that is considered sensitive is 

sanitized to protect it. Sanitized information is masked from view in the 
database and the user interface. MATCHPOINT+ users will see asterisks 
in the fields that have been sanitized.

• If a hit is identified, Forensic Technology recommends that a protocol 
established between the countries be used to confirm the hit.

• International correlation requests usually take longer to process.
  

Note: Cases that have restricted status are never replicated 
outside the country where they were created.
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How Automatic Correlations Are Processed

When an automatic correlation request is processed, the Correlation Server 
compares the reference exhibit to test exhibits that are already in the 
database, using pre-determined settings. To perform a correlation that 
overrides these settings, see Create a Manual Correlation Request (page 110).

The following table describes the settings used for automatic correlations.

Setting Description

Server The server used to perform the correlation is the workstation’s 
default or parent server.

Class 
characteristics

Only test exhibits with the same class characteristics as the 
reference exhibit are included in a correlation. This ensures that a 
reference exhibit is correlated against possible matches only. For 
example, a bullet with five land engraved areas (LEAs) and a right 
twist will be correlated against test exhibits with similar features.

Class characteristics for a cartridge case exhibit include caliber and 
firing pin shape. Class characteristics for a bullet exhibit include 
caliber, direction of twist, and number of LEAs.

Note: Some types of ammunition match others in diameter and 
length, but have different names. To correlate similar ammunition 
correctly, calibers are grouped into families. For more information, 
see Caliber Families (page 74).

Event type Exhibits are excluded from correlation depending on event type. 
For example, exhibits with the Demonstration, Test and QA event 
type are not included in automatic correlations. For more 
information, see Event Types (page 72).

Date of 
occurrence

The date of occurrence is the date specified in the exhibit’s parent 
case. For more information, see Event Types (page 72).
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Event Types

Exhibits are correlated against each other depending on their event type. The 
following table describes which event types are included in automatic 
correlations. The Assault with a Deadly Weapon (ADW), Homicide (HOM), 
Other (OTH), and Unknown (UNK) event types are considered “crime” exhibits 
and are grouped together. The occurrence date specified in the exhibit’s parent 
case is the one used in the correlation.

Exhibits are excluded from a correlation depending on event type. Exhibits with 
the following event types are not included in automatic correlations:

• Demonstration, Test and QA
• Police and Military Firearm (PMF)
• Private Security Firearm (PSF)
• Virtual Serial Number (VSN)

A manual correlation can be used to correlate a reference exhibit against test 
exhibits with event types that are not included in requests that are generated 
automatically. For more information, see Create a Manual Correlation Request 
(page 110).

Reference Exhibit
Event Type

Test Exhibit 
Event Type

ADW, HOM, OTH, UNK • ADW, HOM, OTH, UNK
• TF (occurrence date after reference)
• TFR

TF (Test Fire) • ADW, HOM, OTH, UNK (occurrence date before reference)

TFR (Test Fire Returned) • ADW, HOM, OTH, UNK



CHAPTER 3  About Correlations
Event Types

73

Test Fires
Correlations of test fires are restricted by date as it is assumed that the 
weapon is in police custody and can no longer be used in a crime. However, to 
account for possible clerical delays, the date used in the correlation is later 
than the actual occurrence date. For example, if the actual occurrence date is 
May 1, the date used in the correlation would be May 30, if the date overlap is 
set to 30 days.

  

Note: The date overlap is configured when the system is 
installed. Contact your IBIS Administrator for more information.
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Caliber Families

Some types of ammunition match others in diameter and length, but have 
different names. These name discrepancies may be caused by differences in 
their manufacturers, purposes, compositions, or regions of manufacture. To 
avoid confusion caused by multiple names, as well as to correlate similar 
ammunition correctly, calibers are grouped into families. 

Each caliber family contains the calibers that could be fired from one firearm. 
For example, .38 Special ammunition can be fired from a .357 Magnum 
revolver, so .38 Special and .357 Magnum ammunition are in the same family.
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Correlation Status

The status of a correlation request changes as it moves through various stages, 
as described in the following table: 

Request Status Description

New request A correlation request has just been created.

Ready to correlate The set of test exhibits (the correlation sample), has been 
created and is standing by, ready to be correlated. 

Call support The correlation request cannot be processed. Call 
Forensic Technology Technical Support for assistance.

Halted The correlation request has been put on hold by Forensic 
Technology Technical Support.

Processing The reference exhibit is being correlated against the 
correlation sample. The percentage value shows the 
current rate of completion.

Processing 2nd/3rd A second or third attempt is being made to process the 
request. If the third attempt fails, the status changes to 
Call Technical Support. 

Completed The correlation request has been completed, but the 
results have not yet been transferred to the database.

Correlation done The correlation request has been completed and the 
results are available from the database.

Previously viewed An operator has viewed the correlation results.

Waiting for results The correlation request is waiting for results to arrive 
from external sites.

To be authorized The correlation request will not be submitted until 
authorization is received.

Request authorized The correlation request has been authorized and can 
proceed.

Request rejected The correlation request has been rejected and will not 
proceed.
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Correlation Scores

Correlation scores quantify the degree of similarity between the region of 
interest (ROI) of a reference exhibit and the ROI of test exhibits. 

A pair of exhibits with high-ranking correlation scores are more likely to match 
than exhibits with low-ranking correlation scores. The scores are only used to 
establish a ranking between pairs of reference and test exhibits and have no 
intrinsic value. 

Rankings are reliable because they are relative, not absolute. Even if the 
firearm or type of ammunition used for a reference exhibit yields bad marks 
and therefore has consistently low scores, the rankings will show the test 
exhibits that are most similar to it.

Use the comprehensive tools in Correlation Results Filtering (page 119) to 
interpret correlation scores. From there, you can also view exhibits in the 
MultiViewer or the Side-by-Side Viewer to examine all the likely candidates.

  

Note: The policy of your laboratory will dictate how many 
exhibits in each list should be compared. 

 

If you immediately re-correlate a reference exhibit, there may be additional 
exhibits in the Correlation Results view (page 287) because new cases and 
exhibits are continuously being added to the database. 

Cartridge case scores differ from bullet scores. For more information, see:

• Understanding Cartridge Case Correlation Scores (page 77)
• Understanding Bullet Correlation Scores (page 80)
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Understanding Cartridge Case Correlation Scores

Different cartridge case scores are calculated depending on the type of exhibit:

• Centerfire Exhibits (page 77)
• Rimfire Exhibits (page 79)

Centerfire Exhibits
Centerfire cartridge cases have three independent correlation scores that are 
based on comparisons between breech face, firing pin, and ejector mark 
images. 

Comparing Centerfire Cartridge Case Scores
When comparing centerfire cartridge cases, each independent score is 
important. However, different types of firearms can produce marks of varying 
reliability for each type of ROI. For example, ejector marks are sometimes 
missing from cartridge cases that are fired from pistols, but can be the most 
important marks available for cartridge cases that were fired from semi-
automatic rifles. For this reason, the top-ranking exhibits for each type of score 
should be checked for possible matches.

The following tables represent two examples of centerfire cartridge case 
correlation scores. The first table contains scores that are sorted by breech face 
while the second contains scores that are sorted by firing pin.

Scores Sorted by Breech Face

Exhibit Breech Face Firing Pin Ejector Mark

A 97 106 122

B 80 111 85
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Scores Sorted by Firing Pin

When sorted by breech face, Exhibit A is in the top position. When sorted by 
firing pin, Exhibit E is in the top position. 

In general, the top 20 scores in any category are potential matches and should 
be compared, although the exact number is determined by your laboratory’s 
policy.

C 79 90 144

D 74 108 100

E 70 182 195

F 65 101 111

G 60 96 72

H 52 110 35

Exhibit Breech Face Firing Pin Ejector Mark

E 70 182 195

B 80 111 85

H 52 110 35

D 74 108 100

A 97 106 122

F 65 101 111

G 60 96 72

C 79 90 144

Exhibit Breech Face Firing Pin Ejector Mark
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Rimfire Exhibits
Rimfire exhibits can have one of two firing pin shapes: circular or rectangular. 
For circular rimfire exhibits there is one image. For rectangular rimfire exhibits 
there are two images. The correlation scores for rimfire exhibits are displayed 
in the Firing Pin column. 
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Understanding Bullet Correlation Scores

For bullet exhibits, correlation scores are based on comparisons between 
reference and test LEAs. Each individual LEA of a reference exhibit is correlated 
against all LEAs of a test exhibit. For example, a reference exhibit with four 
LEAs generates 16 scores per test exhibit. Each group of scores is called a 
phase.

In phase 1, LEA 1 of the reference exhibit is compared to LEA 1 of the test 
exhibit. In phase 2, LEA 1 of the reference exhibit is compared to LEA 2 of the 
test exhibit, and so on.

1 1

2

3

4

2

3

4

1 2

2

3

4

3

4

1

1 3

2

3

4

4

1

2

1 4

2

3

4

1

2

3

Phase 4

Reference
LEAs

Test 
LEAs

Reference
LEAs

Test 
LEAs

Reference
LEAs

Test 
LEAs

Phase 3

Reference
LEAs

Test 
LEAs

Phase 1 Phase 2



CHAPTER 3  About Correlations
Understanding Bullet Correlation Scores

81

Bullet scores are displayed in the Correlation Results view of the Correlations 
window (page 285). 

  

Note: If a bullet is damaged, one or more of its LEAs might not 
have been acquired. However, these missing LEAs are still 
counted when the test exhibits are chosen. For example, a bullet 
which only had two of its four LEAs acquired is still correlated 
against bullets with four LEAs.

 

Analyzing Bullet Scores
When interpreting bullet scores, first sort the results by the Max Phase score 
and make sure to scroll to the top of the result list. Test exhibits with high 
scores have more similarities with the reference exhibit than those with lower 
scores. Always analyze at least the 20 highest scoring exhibits in each ROI 
category, and pay attention to Max LEA scores. If the reference and/or test 
exhibit is a fragment, the scores will be reduced, but a good matching LEA will 
generate a high Max LEA score. Therefore, it is important to analyze bullet 
results based on both the Max Phase score and the Max LEA score.



82

IBIS MATCHPOINT+ 2.3 
User Guide

Terminology
The following table describes the specific terms that are used to describe bullet 
scores.

Term Definition

LEA score A score that is generated according to the degree of similarity 
between two correlated LEAs.

Max LEA score The highest LEA score within all of the individual LEA scores for 
a bullet correlation. 

This score is available only for 3D images that have been 
acquired with BULLETTRAX-3D.

Phase One way that a pair of bullets, the reference and a test, can 
align with each other. For example, two bullets with four LEAs 
each can be aligned in four different ways. Therefore, the 
correlation has four phases.

Phase score The sum of all LEA scores within a phase.

Max Phase score The highest phase score within a bullet correlation. 

This score is available only for 3D images that have been 
acquired with BULLETTRAX-3D.

Peak Phase score The highest LEA score within the phase that produced the Max 
Phase score.
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Examining 2D Bullet Scores
The following table shows how scores can be examined for a correlation 
between two bullets with four LEAs each: 

In this example, the Max LEA score is 82, the Max Phase score is 279, and the 
Peak Phase score is 78.

Each score represents the degree of similarity between two LEAs within a 
sample. Therefore, the higher the LEA scores within a sample, the more likely it 
is that a test bullet was fired from the same firearm as the reference bullet. 

Max Phase Score
Consistently high scores throughout a phase are the best indicator of a match. 
The best reflection of these consistently high scores is the Max Phase score. 

Max LEA Score
In the case of damaged bullets or bullet fragments, missing LEAs may lead to 
incorrectly low Phase scores. In these cases, the Max LEA score can be more 
valuable than the Max Phase or Peak Phase scores.

For example, with a Correlation Results list of over 100 exhibits, a single-LEA 
bullet fragment has a high score. When sorted by the Max Phase score, the 
bullet fragment will appear in a low-ranked position. If sorted by Max LEA, the 
fragment could rise to the top of the list. 

Phase 1 Phase 2 Phase 3 Phase 4

Ref: 
Test

LEA 
score

Ref: 
Test

LEA 
score

Ref: 
Test

LEA 
score

Ref: 
Test

LEA 
score

1:1 47 1:2 34 1:3 61 1:4 78

2:2 0 2:3 55 2:4 25 2:1 67

3:3 60 3:4 82 3:1 14 3:2 59

4:4 23 4:1 0 4:2 37 4:3 75

Phase 
score

130 Phase 
score

171 Phase 
score

137 Phase 
score

279
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Peak Phase Score
In most instances, the Max LEA score will be the same as the Peak Phase score, 
but occasionally, due to the randomness of matching striae, the Max LEA score 
may be in a different phase. In this case, you should first analyze the phase 
containing the Max LEA score. This is referred to as Breaking the Phase. 

  

Note: If there is more than a 10-percent variation in LEA width, a 
score of 0 is displayed to indicate that it is unlikely that the test 
exhibit matches the reference. 

 

Examining 3D Bullet Scores
Bullets that were acquired by BULLETTRAX-3D include 2D and 3D data. 
Therefore, 2D scores are available. However, you will focus primarily on the 
Max LEA 3D score. 

The Max LEA 3D score is the highest LEA score within all of the individual LEA 
scores for a bullet correlation. The Max Phase 3D score tells you the phase in 
which the Max LEA 3D score occurred. 
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Correlation Analysis Process

After a correlation request has been automatically or manually generated and 
processed by the Correlation Server, the results are available in 
MATCHPOINT+. Inspection and analysis of correlation results normally 
includes the following steps:

1. Analyze the correlation scores that are returned in the Correlation 
Results view in the Correlations window (page 285). 

For more information, see:

• Correlation Scores (page 76)

• View Correlation Requests and Results (page 113)

• Analyze Cartridge Case Scores (page 115)
• Analyze Bullet Scores (page 117)

• Correlation Results Filtering (page 119)

2. Perform an initial analysis on the high-ranking exhibits. 

For more information, see Analyzing Images with the MultiViewer 
(page 127).

3. Select certain test exhibits for closer analysis. 

For more information, see Analyzing Images in the Side-by-Side Viewer 
(page 155).

4. Notify a firearm examiner of potential hits.

A firearm examiner analyzes the physical evidence using a comparison 
microscope. 

5. Record the hits in MATCHPOINT+. 

For more information, see Add a Hit (page 222). 
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Working with Cases and Exhibits

This section covers the following topics: 

Overview ................................................................................................... 89
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Print Cases and Exhibits ............................................................................. 94
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View an Image........................................................................................... 96
View Detailed Image Information ............................................................. 102
Modify or Delete Migrated Data ............................................................... 103
Export an Exhibit........................................................................................ 95
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Overview

A case in MATCHPOINT+ corresponds to a law enforcement case. Each case is 
represented by a folder in the Navigation tree. A case folder stores the bullet, 
cartridge case, and firearm information and images that are related to a 
specific case. 

An exhibit is an object that was retrieved from a crime scene that can be 
shown and identified in court as evidence in a case. An exhibit becomes 
evidence if it can establish that a crime was committed, if it can provide a link 
between a crime and its victim, or if it can provide a link between a crime and 
its perpetrator. 

In MATCHPOINT+, there are three types of exhibits: bullet exhibits, cartridge 
case exhibits, and firearm exhibits. Each exhibit belongs to a case, and the 
different types of exhibits can belong to the same case. Cartridge case exhibits 
contain images of different regions of interest, such as the firing pin and 
breech face. Bullet exhibits contain images of individual land engraved areas 
(LEAs) and groove engraved areas (GEAs). 

Firearm exhibits are a complement to cartridge case and bullet exhibits. 
Firearms that are entered as firearm exhibits are often the firearms that are 
used to produce test fire cartridge cases and bullets. 

You can only view cases and exhibits in MATCHPOINT+. You cannot add, 
modify, or delete them.
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Submission Status and Synchronization
During synchronization, case information, exhibit information, and image data 
are copied from the Acquisition Station to the Data Concentrator. Although 
configurable, data is typically scheduled to synchronize once a day for every 
Acquisition Station.

In addition to creating a backup copy of the data on the Data Concentrator, 
synchronization allows MATCHPOINT+ users to preview cases, exhibits, and 
any acquired images before they are submitted for the first time. 

A case must be submitted before its data can be used for correlation. New 
exhibits will be correlated automatically depending on the event type (see 
Event Types (page 72). Modified exhibits will be correlated depending on the 
type of data that was modified, for example, changes to event type, caliber, 
firing pin shape, or images for cartridge case exhibits, and changes to event 
type, caliber, twist, LEA count, or images for bullet exhibits.

Use Summary view to track the synchronization of cases and exhibits.

The statuses for cases and exhibits are described in the following tables. For 
some statuses, an indicator also appears beside the item in the Navigation 
tree. 

Case Status Indicator Description

Underway

(Asterisk)

The case is new and not submitted. 

Submitted None The case has been submitted. 

Imported

(Arrow on case 
folder)

The case has been imported from another 
Data Concentrator or a Correlation Server. The 
status of an imported case will not change.

Exhibit Status Indicator Description

Underway

(Asterisk)

The exhibit is new, or a change has been made 
to the data.
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Submitted None The exhibit has been submitted.

Completed None The exhibit has been submitted and a 
signature has been extracted.

Exhibit Status Indicator Description
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Filter Test Exhibits

You can specify the types of test exhibits you want to display before you open 
the MultiViewer or the Side-by-Side Viewer. You can select filter criteria for 
cartridge case exhibits or for bullet exhibits.

To filter test exhibits:

1. From the Navigation tree (page 34), click the plus sign (+) next to Viewer 
Exhibits to expand it.

2. Click Test Exhibits to select it.

3. Right-click and select Remove All Exhibits.

Previously selected test exhibits are cleared. 

4. From the Navigation tree, click the plus sign (+) next to the case folder 
that contains the exhibit that you want to use as the reference.

The case expands and displays the associated exhibits.

5. Click the reference exhibit to select it.

6. Right-click and select Set as Reference Exhibit.

7. Click MultiViewer or Side-by-Side Viewer on the toolbar.

Depending on the type of reference exhibit you selected, the Test Exhibits 
Filtering dialog box (page 301) opens. 

  

Note: If the MultiViewer or Side-by-Side Viewer opens 
instead of the dialog box, previously selected test exhibits have 
not been removed. Follow steps 1 to 3 to remove them.

 

8. Specify any or all of the following filter criteria:

• Event Type
• Occurrence Date Range
• Caliber Range
• Firing Pin Shape (cartridge case exhibits only)

• Twist and LEA Count (bullet exhibits only)
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9. Click MultiViewer or Side-by-Side Viewer.

The Viewer you selected opens to display the reference exhibit on the left 
side and the test exhibits on the right side.
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Print Cases and Exhibits

You can print case information, exhibit information, and images. For record 
keeping, printouts also include the page count, the current date, and the name 
of the user who made the print request.

  

Tip: To control the display of the page numbers at the bottom of 
the page, see Setting Your Preferences (page 55).

 

To print a case or an exhibit:

1. From the Navigation tree, click to select a case or exhibit.

2. Select File > Print from the menu bar.

The Print dialog box appears for you to specify a printer and the 
properties.

  

Tip: To confirm the content before you print, click Print Preview.
 

3. Click Print. 

The case or exhibit information is sent to the printer you selected. 

Related Topics 
Using search (page 46)

Set preferences (page 55)
Work with filters (page 49)
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Export an Exhibit

Use the export feature to provide specific exhibits to colleagues at other 
locations. For example, you may want to get a second opinion about a 
potential match. 

If an exhibit has been imported from another site, it cannot be exported.

To export an exhibit:

1. From the Navigation tree, select the exhibit that you want to export.

2. Right-click and select Export Exhibit.

3. From the list of destination sites, select a target destination.
  

Note: Depending on your IBIS network, the destination could be 
another Data Concentrator, Correlation Server, or an IBIS Heritage 
component. Exhibits that are normally replicated to the 
destination site will not be exported.

 

4. Click Export.

The case folder and exhibit will be copied to the destination site. The 
MATCHPOINT+ workstations that are connected to the site can then 
access the exhibit from the Navigation tree.

Related Topics 
Export Site Data (page 104)

Import Exhibits from Remote Sites (page 136)
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View an Image

You can view a specific LEA, GEA, or cartridge case region of interest without 
opening the MultiViewer or Side-by-Side Viewer. 

After the image is displayed in the Image Information window, you can do the 
following:

Any action that you perform affects the displayed image only, not the saved 
image.

To view an image:

1. In the Navigation tree (page 34), click the plus sign (+) next to the case 
folder that contains the image you want to view.

The case is expanded and its associated exhibits are displayed.

2. Click the plus sign (+) next to the exhibit. 

The images that are associated with the exhibit are displayed.

Action Image Types

Change the magnification level (page 97) All

Adjust the brightness (page 97) All

Adjust the contrast (page 98) All

Adjust the sharpness (page 99) All

Adjust the 2D/3D rendering (page 98) 3D bullet composite images, primer 3D 
composite images

Adjust the 3D elevation (page 98) 3D bullet composite images, primer 3D 
composite images

Adjust the lighting (page 99) 3D bullet composite images, primer 3D 
composite images

Move an image (page 100) All

Rotate an image (page 100) Cartridge cases

View text annotations in the Image 
Information view (page 101)

Breech face ring light images, full 
headstamp images
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3. Click the image that you want to view.

The Image Information view (page 304) replaces the Summary window.
  

Note: If you make any changes in this window, you can click 
Reset to reset all settings to the defaults.

 

Change the Magnification Level
You can zoom in on or zoom out from the displayed image. 

To change the magnification level:

• On the toolbar, do one of the following: 

Adjust the Brightness
The default brightness setting is 50. You can set the image brightness to a 
value between 0 and 100.

To adjust the brightness:

1. To increase the brightness of the image, set the Brightness Control to a 
value that is greater than 50.

For more information about using these controls, see Using the Image 
Manipulation Controls (page 171). 

2. To decrease the brightness of an image, set the Brightness Control to a 
value that is less than 50. 

Click To

Increase the magnification level (zoom in).

Decrease the magnification level (zoom out). 
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Adjust the Contrast
The default contrast setting is 50. You can set the image contrast to a value 
between 0 and 100.

To adjust the contrast:

1. To increase the contrast, set the Contrast Control to a value that is 
greater than 50.

For more information about using these controls, see Using the Image 
Manipulation Controls (page 171). 

2. To decrease the contrast, set the Contrast Control to a value that is less 
than 50.

Adjust the 2D/3D Rendering
You can adjust the rendering for 3D bullet and primer 3D composite images 
only.

For more information about the 2D/3D rendering feature, see Adjust the 
Rendering of 3D Images (page 195).

To adjust the rendering:

1. To display an image with the maximum level of 3D, set the value to 100.

For more information about using these controls, see Using the Image 
Manipulation Controls (page 171).

2. To display an image as 2D only, set the value to 0.

3. To display an image as a mixture of 2D and 3D, set the value between 1 
and 99.

Adjust the 3D Elevation
You can adjust the 3D elevation for composite 3D bullet and primer 3D 
composite images only.

For more information about the 3D elevation feature, see Adjust the 3D 
Elevation of 3D Images (page 197).
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To adjust the 3D elevation:

1. To increase the elevation of image peaks, set the 3D elevation field to a 
value that is greater than 25.

For more information about using these controls, see Using the Image 
Manipulation Controls (page 171).

2. To decrease the elevation of image peaks, set the 3D elevation field to a 
value that is less than 25.

Adjust the Sharpness
The default sharpness setting is 0. You can set the image sharpness to a value 
between 0 and 10.

To adjust the sharpness:

1. To increase the sharpness of the image, set the Sharpness Control to a 
value that is greater than 10.

For more information about using these controls, see Using the Image 
Manipulation Controls (page 171). 

2. To decrease the sharpness of an image, set the Sharpness Control to a 
value that is less than 10. 

Adjust the Lighting
You can adjust the lighting for composite 3D bullet and primer 3D composite 
images only.

For more information, see Adjust the Lighting for 3D Images (page 193).

To adjust the lighting:

1. To turn on the center light, click the center of the inner circle of the Light 
Control. 

2. To turn on the side light, click the outer circle of the Light Control.

A blue “light beam” appears where you clicked, indicating the direction of 
the light. 

3. To change the direction of the side light, drag the light beam around the 
outer circle. 
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The current light inclination is displayed in the I field and the direction is 
displayed in the D field. You can also enter values directly into these fields. 
The valid range is 0° to 359° for direction and 45° to 90° for inclination. 

Move and Rotate Images
You can move bullet and cartridge case images. 

You can rotate cartridge case images only. If the displayed cartridge case is a 
primer 3D DFF image, you can rotate it three-dimensionally around the x-,  y-, 
and z-axes. Different colors are used to distinguish the topside from the 
underside of the DFF image. The top of the image is gray, whereas the 
underside is blue. 

To move an image:

1. Place the cursor over the image.

The Move cursor is displayed.

2. Click and drag the image to the desired location.

To rotate a cartridge case image:

1. Place the cursor over the image.

The Move cursor is displayed.

2. Right-click to switch to Rotate mode.

The Rotate cursor is displayed.

3. To rotate a 2D image, click the image and drag it to the left (or up) to 
rotate it in a counterclockwise direction, or to the right (or down) to rotate 
it in a clockwise direction. 

  

Note: The acquisition marker, a red line on one side, indicates the 
original position of the image.
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4. To rotate a primer 3D DFF image, click the image and drag it to rotate it 
freely. 

If you press the left and right mouse buttons simultaneously, the image 
rotates around an axis that is perpendicular to the screen.

View Text Annotations
Text annotations may have been added to certain breech face ring light images 
or full headstamp images in BRASSTRAX-3D. In MATCHPOINT+, you can only 
view text annotations. You cannot add, modify, or delete them.

If there are any text annotations associated with the displayed image, you will 
see one or more icons on the image. A triangle indicates an ejector mark, a 
square indicates an extractor mark, and a circle indicates a generic mark.

To view text annotations:

• Place the cursor over a text annotation icon.

A message box opens, displaying the associated annotation.

Ejector:
This is a potential ejector mark...
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View Detailed Image Information

You can view more detailed information about a particular image, such as its 
dimensions.

To view advanced image information:

1. In the Navigation tree (page 34), click the plus sign (+) next to the case 
folder that contains the image.

The case is expanded and its associated exhibits are displayed.

2. Click the plus sign (+) next to the exhibit. 

The images that are associated with the exhibit are displayed.

3. Click an image to select it. 

The image is displayed to the right of the Navigation tree.

4. Click Info.

The Detailed Image Information dialog box (page 308) opens.

5. Click OK to close the dialog box after you have finished viewing the 
information.
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Modify or Delete Migrated Data

When an IBIS Heritage Acquisition Station is decommissioned, such as when it 
is replaced by IBIS TRAX-3D systems, the existing data is migrated to a Data 
Concentrator to maintain its availability. 

You can modify or delete migrated data to correct mistakes that affect 
correlation. This capability includes the modification of case and exhibit 
information, and the deletion of cases and exhibits. You can only modify or 
delete migrated data belonging to a child site of the Data Concentrator.

If an image itself needs to be changed, it must be reacquired on the new IBIS 
TRAX-3D system. After data has been modified, it will be replicated to the 
Correlation Server and correlated again.

To modify migrated data:

1. Select the case or exhibit to modify from the Navigation tree.

2. From the Edit menu, select Modify.

The Modify Bullet Exhibit Dialog Box (page 317), Modify Cartridge Case 
Exhibit Dialog Box (page 313), Modify Firearm Exhibit Dialog Box 
(page 320) or Modify Case Dialog Box (page 324) opens.

3. Modify the fields as required.

4. Click OK.

The case or exhibit is updated and the dialog box closes.

To delete migrated data:

1. Select the case or exhibit to delete from the Navigation tree.

2. From the Edit menu, select Delete and confirm.

The data is deleted.



104

IBIS MATCHPOINT+ 2.3 
User Guide

Export Site Data

The data stored on the local sites in your configuration can be exported and 
saved in a format that can be integrated into external applications to generate 
a wide range of reports and statistics.

You can define the data export using the options for site selection, date range, 
image content, and the name you give the exported file.

For example, your data export could target sites ABC and DEF; include all the 
cases created between January 1, 2000 and January 1, 2010; include the 
images as JPEG file types; and save the file as First Decade. 

It can take a long time to generate an export file if you select many sites, 
include a large date range, and include all the images. The export process runs 
in the background, so you can continue to work with MATCHPOINT+ or close 
your session without interrupting the process. 

To export site data:

1. From the menu bar, select Tools > Data Export.

The Data Export dialog box (page 326) opens.

2. In the Sites section, select the site(s) to export, or click Select All to export 
all the sites.

3. In the Date Range section, select the type of date that is associated with 
the case: 

• Select a start date, and then an end date from the calendar. 

4. From the Image Export drop-down list, select an image export option.
  

Note: When you include the images, the export file can take a 
long time to generate.

 

5. From the File Type drop-down list, select a graphic file type.

6. In the Name field, enter a name for the file. 

7. Click Create.
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Tip: To view the status of a pending export that you created, click 
the Pending Data Export tab.

 

A confirmation message is displayed when the export file is complete.

To cancel a data export:

1. From the menu, select Tools > Data Export.

The Data Export dialog box (page 326) opens.

2. Click the Pending Data Export tab. 

3. Click Cancel.

The data export is canceled and no files are saved, regardless of how close 
it was to completion. 

Related Topics 
Export an Exhibit (page 95)

Export Cartridge Case Images (page 213)
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Working with Correlation Requests
and Results

This section covers the following topics: 

Overview ................................................................................................. 109
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Overview

After a cartridge case or bullet exhibit is submitted and synchronized, the IBIS 
TRAX-3D system automatically generates a correlation request for that exhibit. 
Automatic correlations use default settings for class characteristics (caliber 
family, firing pin shape for cartridge cases, number of LEAs and LEA twist for 
bullets, event type, and date of occurrence) and a default region that is based 
on crime patterns, highways, freeways, or regional borders. MATCHPOINT+ 
allows you to create manual correlation requests to override the default 
settings. 

You must use a manual correlation request to: 

• Correlate a reference exhibit against exhibits at sites that are not included 
in the default region. You choose the particular sites that you want to 
include in the correlation. 

• Correlate against test exhibits with class characteristics that are different 
from those of the reference exhibit. For example, you can correlate an 
exhibit with members that are outside its caliber family.

• Bypass the restriction that does not include exhibits with the 
Demonstration, Test and QA event type in automatic correlations. 
For more information, see Event Types (page 72).

The length of time that it takes to perform the correlation, as well as the 
volume of the correlation results, depends upon the scope of the request and 
the size of the database that is consulted.

After a request has been processed, the correlation results can be viewed in 
the Correlations window (page 285).

  

Note: To view or create a Correlation Request, the reference 
exhibit must be from an acquisition site in your jurisdiction.
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Create a Manual Correlation Request

When you submit a correlation request manually, you specify how test exhibits 
are correlated against the reference exhibit, overriding the default settings that 
are used for an automatic correlation. Use a manual correlation request to 
correlate a reference exhibit against test exhibits that have different class 
characteristics, have the Demonstration, Test and QA event type, or are at sites 
that are not included in the automatic correlation configuration. 

You can specify the following criteria when performing a manual correlation 
request:

• Event type
• Occurrence date
• Caliber
• Firing pin shape (for cartridge cases)
• Twist (for bullets)
• LEA Count (for bullets)
• Site selection
• Number of results returned

To create a manual correlation request:

1. In the Navigation tree (page 34), click the plus sign (+) next to the case 
containing the exhibit you want to use as the reference. 

The exhibits belonging to the case are displayed.

2. Click to select the exhibit that will serve as the reference.

3. Right-click and select Manual Correlation Request.

The Correlation Request dialog box (page 277) opens.

4. Specify any or all of the following filter criteria: 

• Event type
• Occurrence date range
• Caliber range
• Firing pin shape (cartridge case exhibits only)
• Twist and LEA Count (bullet exhibits only)
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5. If you want to include exhibits that belong to the reference case, select the 
Include Exhibits from the Same Case check box.

6. If you want to select the sites to correlate against, select the Correlation 
Sites Selection check box.

  

Note: If you generate multiple manual correlation requests to 
external sites, the local response time for standard requests at 
those sites may slow down.

 

7. Specify the following criteria to manage the results that are returned:

• Percent of best score results

• Minimum number of results

8. Click Generate.

• If you selected the Correlation Sites Selection check box, the 
Correlation Sites dialog box (page 281) opens. Go to step 9.

• If you did not select the Correlation Sites Selection check box, the 
new request appears in the Correlation Requests view (page 287) with 
a status of New Request. After the request has been processed, the 
correlation status changes to Correlation Done. Go to step 12.

9. Click the plus sign (+) to expand the Correlation Sites. 

The hierarchy of sites configured for your system is displayed. 
  

Tip: To change the display of correlation sites, click Options.
 

10. Select the check boxes for the sites you want to include in the correlation.
  

Note: You can only select sites that are from the same branch of 
the hierarchy. To correlate against sites from another branch, you 
must generate another correlation request.

If your configuration includes a National or State level, you 
cannot select sites individually when these levels are selected.

 

11. Click OK.
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The new request appears in the Correlation Requests view (page 287) 
with a status of New Request. After the request has been processed, the 
correlation status changes to Correlation Done. 

12. Analyze the correlation results using Correlation Results filter (page 119).

Related Topics 
View Correlation Requests and Results (page 113)
Delete Correlation Requests (page 125)

Correlation Request Dialog Box (page 277)

Correlation Sites Options Dialog Box (page 283)
Correlations Window (page 285)
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View Correlation Requests and Results

You can view a list of correlation requests and their associated results. The 
Status column in the Correlation Requests view indicates if a correlation has 
been completed. A status of Correlation Done indicates that the results are 
ready to be viewed. 

To view correlation requests and results:

1. From the Navigation tree (page 34), click Correlation Results.

The Correlations window (page 285) opens.

2. From the Correlation Requests view, select a reference exhibit.

A list appears in the Correlation Results view showing the correlation 
results of all test exhibits that were compared against the selected 
reference exhibit. Correlation results are represented by numeric scores.

  

Note: You can view additional correlation request details, such 
as information about the request filter, reference case, and 
reference exhibit. For more information, see View Correlation 
Request Details (page 126).

 

3. Examine the scores:

• If you are examining cartridge case scores, see Analyze Cartridge Case 
Scores (page 115).

• If you are examining bullet scores, see Analyze Bullet Scores 
(page 117).

  

Tip: To create a filter to customize the list display, see Working 
with Filters (page 49).

You can also right-click the column header and select Show/Hide 
Columns to control which columns show. The display order of 
columns cannot be modified.

 

Related Topics 
Analyze Cartridge Case Scores (page 115)
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Analyze Bullet Scores (page 117)

Correlation Results Filtering (page 119)
Correlations Window (page 285)
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Analyze Cartridge Case Scores

For centerfire exhibits, there are three different correlation scores. The highest 
scores in each category should be identified and further analyzed in the 
MultiViewer. Analyze the scores in the following order:

• Breech face
• Firing pin 
• Ejector mark

For rimfire exhibits, the firing pin score is the only correlation score.
  

Note:  As a general guideline, you should examine the top 20 
scores. However, the specific scores you examine and the exact 
number of exhibits that you compare depends on the policy at 
your facility. 

 

For more information about scores, see Understanding Cartridge Case 
Correlation Scores (page 77).

To analyze cartridge case scores:

1. Open the Correlations window (page 285) to see a list of correlation 
requests and results. For more information, see View Correlation Requests 
and Results (page 113).

By default, centerfire results are sorted by breech face scores, with the 
highest scores displayed at the top of the Correlation Results list. To 
change the default sort order, see Setting Your Preferences (page 55).

The column that is used to sort the scores is indicated by an arrow in the 
column header. Scores are always displayed in a descending sort order.

  

Tip: For centerfire exhibits, click the column header to select the 
score you want to sort. 

 

Arrow indicates sort column



116

IBIS MATCHPOINT+ 2.3 
User Guide

2. Use any of the following options to examine the results:

• Use graphic tools to analyze the results. Right-click the Correlation 
Request and select Correlation Results Filtering (page 119).

• Open the MultiViewer or the Side-by-Side Viewer to view the list of 
exhibits. Click the icon on the toolbar.

• Print the correlation score results. Right-click the Correlation Request 
and select Print correlation results (page 122).

  

Note: When you specify a score to sort by in the Correlations 
window (page 285), the order is respected when you open a 
Viewer or the Correlation Results Filtering.

 

Related Topics 
Correlation Scores (page 76)
Correlation Results Filtering (page 119)

Analyzing Images with the MultiViewer (page 127)

Analyzing Images in the Side-by-Side Viewer (page 155)
Correlations Window (page 285)
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Analyze Bullet Scores

There can be up to four scores displayed for a correlation result. The 2D scores 
are Max LEA, Peak Phase, and Max Phase. The only 3D score is Peak 3D.

  

Note: As a general guideline, you should examine the top 20 
scores. However, the specific scores you examine and the exact 
number of exhibits that you compare depends on the policy at 
your facility. 

 

For a more information about scores, see Understanding Bullet Correlation 
Scores (page 80).

Analyzing Scores
First examine the Max Phase scores, looking for the highest scores. 
Consistently high scores throughout a phase are the best indicator of a match.

After you have examined the Max Phase scores, examine the Max LEA scores. 
If the reference or test exhibit is damaged or is a bullet fragment, missing LEAs 
may lead to incorrectly low Max Phase scores. In these cases, the Max LEA 
scores will be a better indicator of a potential match.

Next you can examine the Peak 3D score to identify exhibits that warrant 
further analysis. 

  

Note: If there is more than a 10-percent variation in LEA width, a 
score of 0 is displayed to indicate that it is unlikely that the test 
exhibit matches the reference.

 

To analyze bullet scores:

1. Open the Correlations window (page 285) to see a list of correlation 
requests and results. For more information, see View Correlation Requests 
and Results (page 113).

By default, scores are sorted by the Max LEA column, with the highest 
scores displayed at the top of the Correlation Results list. To change the 
default sort order, see Setting Your Preferences (page 55).
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The column that is used to sort the scores is indicated by an arrow in the 
column header. Scores are always displayed in a descending sort order.

  

Tip: To select the score you want to sort, click the column header.
 

2. Note scores that are indicative of badly damaged bullets and bullet 
fragments. Look for Max LEA scores that are:

• Significantly higher than the other Max LEA scores. 
• High but in a different phase than that of the Max Phase score. 

If the Max LEA score is not in the same phase as the Max Phase score, 
analyze the phase containing the Max LEA score.

3. Use any of the following options to examine the results:

• Print the correlation score results. Right-click the Correlation Request 
and select Print correlation results (page 122).

• Open the MultiViewer or the Side-by-Side Viewer to view the list of 
exhibits. Click the icon on the toolbar.

• Use graphic tools to analyze the results. Right-click the Correlation 
Request and select Correlation Results Filtering (page 119).

  

Note: When you specify a score to sort by in the Correlations 
window (page 285), the order is respected when you open a 
Viewer or the Correlation Results Filtering.

 

Related Topics 
Correlation Scores (page 76)
Correlation Results Filtering (page 119)

Analyzing Images with the MultiViewer (page 127)

Analyzing Images in the Side-by-Side Viewer (page 155)
Correlations Window (page 285)

Arrow indicates sort column
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Correlation Results Filtering

The Correlation Results filter is a flexible graphic tool designed to help you 
analyze the scores of the correlation results.

The scores are normalized to a scale of 100 and charted at the top of the 
window. The list of exhibits and scores is displayed in a data table at the 
bottom of the window. 

You can view the images by selecting exhibits to open in the MultiViewer or 
the Side-by-Side Viewer. You can also set the chart and list options you want 
and then print your analysis of the scores of the correlation results.

The display is updated immediately if you change the sort order for bullet 
scores from Max Phase to Max LEA, or change the number of exhibits and 
show the ranking. 

  

Tip: If you click the graphic element (bar or line) in the chart, the 
corresponding exhibit row is highlighted in the data table.

 

Sort criterion

Normalized scores
Scale of 100

Rank column

Test exhibit IDs

Reference exhibit
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Filtering Options
Use the column headers to control the sort priority of the score you want to 
focus on. The score used for the sort is also displayed in the title of the chart. 
For more information on sorting column headers, see Analyze Cartridge Case 
Scores (page 115).

Use the Chart Options (page 294) and List Options (page 295) to control how 
the scores are displayed and listed. Click Reset on the toolbar to return to the 
original setting. 

• Chart Options control how the scores are graphically displayed. You can 
choose a bar or line chart style, the number of exhibits, and the lines you 
want to show.

• List Options control how the scores are listed. You can show the original 
scores, or the scores based on a scale of 100. You can also include the 
rank to see the relative position of the score. 
The Select All and Clear All buttons control the exhibit ID check boxes. To 
open an exhibit in a Viewer, you must first select the ID. For more 
information, see View Selected Images (page 121).

  

Tip: To save your filtering options as a preference, click Save 
Settings. For more information, see Setting Your Preferences 
(page 55).

 

To filter the correlation results:

1. Open the Correlations window (page 285) to see a list of correlation 
requests and results.

2. Right-click the correlation request you want, and select Correlation 
Results Filtering from the menu.

The scores are displayed in a table and chart.

3. Use the display and filtering options:

• Set the score sort order by clicking column headings.
• Set the Chart Options to control the graphic display.

• Set the List Options to control the list display.
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View Selected Images
For further image analysis, you can open the MultiViewer or the Side-by-
Side Viewer from Correlation Results Filtering.

To open a Viewer:

1. Select the exhibit ID check boxes for the test exhibits you want to view. If 
you want all the exhibits, click Select All in List Options.

When an ID is selected, it also displays in brackets on the X axis of the 
chart.

2. Click MultiViewer or Side-by-Side Viewer on the toolbar.

The Viewer opens with the exhibits you selected.

3. Close the Viewer to return to Correlation Results Filtering.

Related Topics 
Setting Your Preferences (page 55)

Print the Correlation Results (page 122)
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Print the Correlation Results 

After you review, sort and chart correlation scores, you may want to print the 
results. You can choose the format and the filtering display options you want. 
You can print:

• Correlation results
• Correlation results that have been evaluated using Correlation Results 

Filtering

To print correlation results:

1. From the Correlation Requests view in the Correlations window 
(page 285), select a correlation request.

For more information about how to open the Correlations window, see 
View Correlation Requests and Results (page 113).

2. In the Correlation Results view, set the sort order you want to print.

3. Right-click the correlation request and select Print Correlation Results.

The Print Correlation Results dialog box (page 297) opens.

4. Select the range you want if other than the default.
  

Tip: To activate Up to Selection, select a result in the 
Correlation Results view.

 

5. Select Include Firearms to include the make and model of the firearm 
exhibits that are linked to bullet or cartridge case exhibits.

The printed results will include a separate page for firearms and the 
number of times it occurs.

6. Click Print.

The Print dialog box opens, where you can select a printer and specify the 
number of copies.

7. Click Print.
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To print correlation results filtering:

1. From the Correlation Requests view in the Correlations window 
(page 285), select a correlation request.

For more information about how to open the Correlations window, see 
View Correlation Requests and Results (page 113).

2. Right-click the correlation request and select Correlation Results 
Filtering.

3. Set the sort order and display options you want to print.
  

Tip: You can print chart and list options that are different from 
those that are displayed on your screen. Click the down arrow 
beside Print and select Configure. You can also save the print 
setting as your preferences.

 

4. Click Print.

The Print dialog box opens, where you can select a printer and specify the 
number of copies.

5. Click OK.

Related Topics 
View Correlation Requests and Results (page 113)

Correlation Results Filtering (page 119)

Correlations Window (page 285)
Correlation Results Filtering window (page 294)
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Change the Status of Correlation Requests

If you have the appropriate permissions, you can change the status of a 
correlation request to Previously Viewed. This serves as a flag for deleting 
correlation requests. Your system may be configured to automatically delete 
correlation requests that have a status of Previously Viewed after a certain 
number of days. You can also manually delete correlation requests (page 125).

To be able to change the status of a correlation request, its status must be 
Correlation Done.

To change the status of a correlation request:

1. From the Correlation Requests view in the Correlations window 
(page 285), select a correlation request. Use the CTRL or SHIFT keys if you 
want to select multiple items.

For more information about how to display the Correlations window, see 
View Correlation Requests and Results (page 113).

2. On the toolbar, click Viewed.

The status of the selected correlation request(s) is set to Previously 
Viewed.

  

Tip: You can change the status of a correlation request from 
Previously Viewed to Correlation Done by clicking Viewed/Not 
Viewed on the toolbar.

 

Related Topics 
View Correlation Requests and Results (page 113)

Delete Correlation Requests (page 125)
Correlations Window (page 285)
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Delete Correlation Requests

Correlation requests that are kept on a server take up a substantial amount of 
storage space, and may eventually slow the system down. Therefore, it is 
recommended that you delete correlation requests that have already been 
viewed. You must have the appropriate permissions to delete correlation 
requests.

  

Note: Your system may be configured to automatically delete 
correlation requests that have a status of Previously Viewed. For 
more information, see Change the Status of Correlation Requests 
(page 124).

 

To delete a correlation request:

1. From the Correlation Requests view in the Correlations window 
(page 285), select the request that you want to delete. Use the CTRL or 
SHIFT keys if you want to select multiple items.

For more information about how to open the Correlations window, see 
View Correlation Requests and Results (page 113).

2. Right-click and select Delete, or click Delete on the toolbar. 

A message appears asking you to confirm the deletion.

3. Click Yes to delete the correlation request(s).

The correlation request is deleted from the database and the dialog box 
closes.

Related Topics 
View Correlation Requests and Results (page 113)
Change the Status of Correlation Requests (page 124)

Correlations Window (page 285)
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View Correlation Request Details

You can view detailed information about the selected correlation request and 
the associated reference case and exhibit.

To view correlation request details:

1. From the Correlation Requests view in the Correlations window 
(page 285), select a correlation request.

For more information about how to open the Correlations window, see 
View Correlation Requests and Results (page 113).

2. Right-click and select Correlation Request Information.

The Correlation Request Information dialog box (page 291) opens.
  

Tip: To view details about the reference exhibit, select Reference 
Exhibit Information from the right-click menu.

 

3. Click OK when you have finished viewing the information.

The dialog box closes.

Related Topics 
View Correlation Requests and Results (page 113)
Print the Correlation Results (page 122)

Correlations Window (page 285)

Correlation Request Information Dialog Box (page 291)



127

C H A P T E R 6  

Analyzing Images with the
MultiViewer

This section covers the following topics: 

Overview ................................................................................................. 129
What Is a Mosaic? ................................................................................... 130
Select Exhibits to View ............................................................................. 132
Display Guides in the MultiViewer ............................................................ 134
Import Exhibits from Remote Sites ............................................................ 136
Sort Exhibits............................................................................................. 139
Image Layout........................................................................................... 141
Display One or All Cartridge Case Image Types ......................................... 143
Filter Breech Face Images ......................................................................... 145
Set Images at Best Match Position............................................................ 147
Hide Exhibits............................................................................................ 149
Move and Rotate Images ......................................................................... 150
Adjust the Lighting and Rendering of 3D Images ...................................... 151
Open the Side-by-Side Viewer from the MultiViewer ................................. 152
Save MultiViewer Settings ........................................................................ 153
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Overview

The MultiViewer (page 329) allows you to analyze multiple exhibits 
simultaneously. The reference exhibit is always displayed on the left side of the 
viewer. The test exhibits are displayed to the right of the reference exhibit.

If you find a potential match, you can open the Side-by-Side Viewer directly 
from the MultiViewer to perform a closer analysis of the reference exhibit and 
a particular test exhibit.

When viewing exhibits in the MultiViewer, you can do the following:

• Display guides in the MultiViewer (page 134)
• Sort exhibits (page 139)
• Display one or all cartridge case image types (page 143)
• Setting image positions (page 147)
• Hide exhibits (page 149)
• Move and rotate images (page 150)
• Rotate cartridge case images (page 150)
• Adjust the lighting and rendering of 3D images (page 151)
• Open the Side-by-Side Viewer (page 152)
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What Is a Mosaic?

Bullet exhibits are displayed as mosaics in the MultiViewer and Side-by-Side 
Viewer. A mosaic is a fully acquired bullet image. Exhibits that were acquired 
with BULLETTRAX-3D include images of each LEA and GEA. These separate 
images are stitched together, creating a 3D mosaic in which the LEAs and 
GEAs are displayed vertically in one continuous image. If a LEA or GEA was too 
damaged and, therefore, not acquired, a black band is displayed in its place.

Exhibits that were acquired with BulletProof include LEA images only. This is 
also true of images of bullets that have been fired through a polygonal rifled 
barrel. The image on the left shows a mosaic that includes LEAs and GEAs. The 
image on the right shows a mosaic that has only LEAs. The LEAs are separated 
by narrow black bands.

GEA 6

LEA 6

GEA 5

LEA 5

GEA 4

LEA 4

GEA 3

LEA 3 

GEA 2

LEA 2

GEA 1

LEA 1

LEA 6

LEA 5

LEA 4

LEA 3

LEA 2

LEA 1
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If the selected reference exhibit is a 2D image, all of the test exhibits are 
displayed in 2D and only LEAs are displayed. If the selected reference exhibit is 
a BULLETTRAX-3D image, exhibits that have been acquired by BulletProof are 
displayed in 2D and exhibits that have been acquired by BULLETTRAX-3D are 
displayed in 3D.

  

Note: 3D bullet images are only available if the feature is 
activated for your system.
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Select Exhibits to View

There are a number of different ways to select the exhibits you want to view. 
Regardless which method you use, the reference exhibit and test exhibits are 
automatically recorded in Viewer Exhibits in the Navigation tree. You can 
view the selected exhibits in either the MultiViewer or the Side-by-Side 
Viewer. 

Open the MultiViewer
To select the exhibits you want to view in the MultiViewer, you can do one of 
the following: 

• Select exhibits based on their correlation scores, see View Correlation 
Requests and Results (page 113).

• Select exhibits based on analysis in correlation results filtering, see 
Correlation Results Filtering (page 119).

  

Note: When you select correlated exhibits, you can display 
images in their best match position and view the correlation 
scores.

 

• Define filter criteria to select the test exhibits based on their class 
characteristics, see Filter Test Exhibits (page 92).

• Manually select exhibits you want to view from the Navigation tree.
  

Note: To view exhibits that are stored at other sites, you must 
create a manual correlation request (page 110) that includes the 
correlation sites.

 

To manually select test exhibits:

1. From the Navigation tree (page 34), click the plus sign (+) next to the case 
folder that contains the exhibit that you want to use as the reference.

The case expands and displays the associated exhibits.

2. Select the exhibit that you want to use as the reference.

3. Right-click and select Set as Reference Exhibit.
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Tip: You can also use the toolbar buttons to select exhibits. 
 

4. Select the exhibits that you want to use as test exhibits.

After clicking one exhibit to select it, you can select additional exhibits by 
using CTRL+Click.

5. Right-click and select Set as Test Exhibit.

6. Select additional exhibits as required, and select Add to Test Exhibits 
from the right-click menu.

7. Click MultiViewer on the toolbar.

Depending on the type of reference exhibit that was selected, the 
Cartridge Case MultiViewer (page 331) or the Bullet MultiViewer 
(page 339) opens. The reference exhibit appears on the left side of the 
viewer and the test exhibits appear on the right side.

  

Note: The Exhibit Details are displayed at the bottom of the 
screen. If the text is too long to display, an ellipsis (…) is 
displayed to indicated that the information has been truncated. 
To display the complete text, hold your mouse over the ellipsis.

 

Related Topics 
Create a Manual Correlation Request (page 110)

Display Guides in the MultiViewer (page 134)
Import Exhibits from Remote Sites (page 136)

Test Exhibits Filtering Dialog Box (page 301)

Cartridge Case MultiViewer (page 331)
Bullet MultiViewer (page 339)
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Display Guides in the MultiViewer

When viewing exhibits in the MultiViewer, you can control the types of 
guides you want to display. You can select one or more guides to display, and 
then click Display Guides on the toolbar to turn them on or off. 

For example, if you work with bullet exhibits you may want to set the anchor 
lines, LEA labels and exhibit details so that you can show and hide them easily. 

You can change the display settings for individual guides as required when you 
work. To set your preferences, see Setting Your Preferences (page 55).

The display guides for bullet and cartridge case exhibits are listed below. 

Bullet Display Guides
• Anchor Lines
• LEA/GEA Labels
• LEA/GEA Widths
• Sorting Criterion
• Exhibit Details 

Cartridge Case Display Guides
• Outlines
• Outline Diameters
• Acquisition Markers
• Annotations
• Outer Regions
• Breech Face Class Characteristics
• Sorting Criterion
• Exhibit Details

  

Tip: To display text Annotations, hold your cursor over the icon 
to activate a pop-up window.

 

To set display guides:

1. On the toolbar, click the down arrow beside Display Guides.

The information controlled by Display Guides is displayed.
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2. Select the information you want to display.

A check mark appears beside your selection to indicate the guides that will 
be displayed when you click Display Guides.

  

Tip: To turn the display on or off, click Display Guides.
 

Exhibit Information
When you select Exhibit Details on the Display Guides it creates an 
activation area that you can use to trigger the Exhibit Information window to 
open. 

The Exhibit Information window includes the correlation result scores and an 
option to print the exhibit. 

The activation area is at the top of an exhibit (reference or test) on the label 
where the name of the site, case and exhibit are displayed.

  

Note: If you select a single cartridge case image type to view, the 
activation area is at the top of each image.

 

To display exhibit information:

1. Hold your cursor over the exhibit label.

The exhibit information for the exhibit is displayed.

2. To close the window, move your cursor away or click the X.

Related Topics 
Open the MultiViewer (page 132)

Filter Breech Face Images (page 145)
Display Guides in the Side-by-Side Viewer (page 168)

Cartridge Case MultiViewer (page 331)

Bullet MultiViewer (page 339)
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Import Exhibits from Remote Sites

If you selected test exhibits based on their correlation scores, some of those 
exhibits may be stored on remote servers. According to your connection, the 
Data Concentrator or the Correlation Server will automatically import a set 
number of the best exhibits (those that are the most likely matches).

For example, if your system is set to import ten exhibits, it means that up to ten 
of the best exhibits in each score category will be imported automatically. After 
the top ten have been imported for each score category, you must import the 
exhibits manually if you want to view them.

  

Note: Imported exhibits may have hidden field information; 
whereby the original content is replaced with five asterisks 
(*****). This indicates that the data has been sanitized as part of 
the secure process for international data sharing.

 

You can import exhibits individually when you want them, or import all the 
exhibits that are stored on remote sites at once. If you decide to import all the 
remotely stored exhibits, the process may take a long time. 

Reimport an Exhibit
After an exhibit is imported to your local Data Concentrator or the Correlation 
Server, it can still be changed at its origin; for example, images can be 
reacquired, new information can be added, or the exhibit can be deleted. To 
ensure that the exhibit on the Data Concentrator or the Correlation Server is 
up-to-date, you can reimport the exhibit. To do so, right-click the exhibit and 
then select Reimport Exhibit.

  

Tip: To reimport an exhibit in the MultiViewer, open the Exhibit 
Information pop-up window and click Reimport Exhibit.

 

To import individual remote exhibits:

1. Open the MultiViewer (page 132) with exhibits that have correlation 
scores.
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If any of the exhibits are not stored locally, an Import button is displayed 
in place of the exhibit image.

2. Click the Import button in the Bullet MultiViewer (page 339) or Cartridge 
Case MultiViewer (page 331).

While the exhibit is being imported, you can continue working. 

To import all remote exhibits:

1. Open the MultiViewer (page 132) with exhibits that have correlation 
scores.

2. Click Import on the toolbar.
  

Note: If all the exhibits are stored locally, Import is not available.
 

The Import Exhibits dialog box (page 311) opens.

3. Select All, or select Highest Scores and enter a number.

4. Click Import.

The importing process is started and may take some time. The exhibits 
display when the import is complete.

Related Topics 
Open the MultiViewer (page 132)
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Cartridge Case MultiViewer (page 331)

Bullet MultiViewer (page 339)
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Sort Exhibits

If you open the MultiViewer from the Correlations window (page 285), test 
exhibits are sorted according to correlation scores. The highest ranking exhibit 
appears as the first test exhibit. Bullets exhibits are sorted by the Max LEA 
score. Cartridge case exhibits are sorted according to the Breech Face score. 
Otherwise, they are sorted in the order in which you selected them.

After you have opened the MultiViewer, you can change the sort order and 
sort exhibits using any of the following criteria: 

* These options are displayed only if the MultiViewer was opened from the 
Correlations window. 

** User Selection is available if the exhibits were selected from the 
Navigation tree.

Cartridge Case Exhibits Bullet Exhibits

Firing Pin Score* Max LEA 2D Score* 

Breech Face Score* Peak Phase 2D Score* 

Ejector Mark Score* Max Phase 2D Score* 

User Selection** Max LEA 3D Score* 

Event Type Max Phase 3D Score* 

Caliber User Selection**

Law Agency Event Type 

Caliber

Law Agency

Average LEA Width

Maximum LEA Width

Minimum LEA Width
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To sort exhibits:

• Click the arrow on the Sort by list and select the criterion that you want to 
use to sort the images. 

The MultiViewer (page 329) is refreshed to display the test exhibits in the 
new sort order.

Related Topics 
Open the MultiViewer (page 132)

Cartridge Case MultiViewer (page 331)

Bullet MultiViewer (page 339)
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Image Layout

You can control the image size of the exhibits in the MultiViewer by choosing 
the number of test exhibit images to display. 

The smaller layout format provides a way to eliminate mismatches quickly 
during an initial review. The larger layout format can be used to see more 
image detail. The image quality and proportion is maintained regardless of the 
layout.

The default image layout is 8 images for bullets, and 8 x 5 images for cartridge 
cases. To change the default, see Setting Your Preferences (page 55).

Bullet Images
You can choose the number of test exhibit images you want to display, from 
eight to two. The two-image layout displays the largest images.

Only the 8-image layout displays the complete bullet mosaic. All the other 
layouts increase the bullet image size so that a portion of the mosaic does not 
display. An orange bar at the bottom of the image indicates the relative 
portion of the mosaic in view. Scroll vertically to see more of the mosaic.

  

Tip: Show the LEA and GEA labels to help with orientation in the 
mosaic.

 

Portion of the mosaic 
that is in view 
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Cartridge Case Images
You can choose the number of test exhibit images you want to display, from 
8 x 5 to 2 x 2. The 2 x 2 image layout displays the largest images.

To change the layout:

• Click the image down arrow on the toolbar and select the number of 
images you want to display.

The MultiViewer (page 329) is refreshed to display the test exhibits in the 
selected layout.

You can use the navigation buttons on the toolbar to navigate the list of 
test exhibits.

Related Topics 
Setting Your Preferences (page 55)

Navigate Exhibits and Regions of Interest (page 170)

Set Bullet Images at Best Match Position (page 173)
Adjust Bullet Images (page 174)
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Display One or All Cartridge Case Image Types

When viewing cartridge cases in the MultiViewer, up to seven of the 
following image types can be displayed for each exhibit. 

• Breech face - ring light
• Breech face - 6 o’clock side light
• Firing pin - ring light
• Ejector mark - 6 o’clock side light
• Ejector mark - 3 o’clock side light
• Full headstamp - ring light
• Primer 3D DFF 

  

Note: The primer all-in-focus image does not display in the 
MultiViewer or Side-by-Side Viewer. It is used for rendering 
the primer 3D composite.

 

You can view all of the associated image types together or you can filter the 
display so that only one type of image is displayed at a time. If, for example, 
you want to compare only breech face marks, you can filter out the other 
image types. 

  

Note: Large caliber full headstamp images acquired with 
BRASSTRAX-3D version 2.2 SP3 and later may be smaller than 
full headstamp images that were acquired with earlier versions.

 

To display one cartridge case image type:

• In the reference exhibit image group in the Cartridge Case MultiViewer 
(page 331), double-click the image type that you want to display. 

For example, to display only firing pin images, double-click the firing pin 
image in the reference exhibit image group.

For the test exhibits, only the images of the selected type are displayed.

To display all cartridge case image types:

• On the toolbar, click All Test Exhibits Images.
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Related Topics 
Open the MultiViewer (page 132)

Cartridge Case MultiViewer (page 331)
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Filter Breech Face Images

The class characteristics that best describe breech face marks can be identified 
when an exhibit is acquired in BRASSTRAX-3D, for example, parallel or arch. 
When no breech face marks are identified or eliminated, the default class 
characteristic is Unknown.

In MATCHPOINT+, you can use this information to filter images and focus on 
the class characteristics that suit your analysis. Breech face class characteristics 
are part of the exhibit information.

This feature helps optimize the analysis by eliminating inappropriate exhibits 
based on the breech face class characteristics.

  

Tip: You can specify breech face class characteristics in search 
criteria. For more information, see Using Search (page 46).

 

To filter breech face class characteristics:

1. Click the down arrow beside Display Guides and select Breech Face 
Class Characteristics.

The Breech face class characteristics fillter dialog box (page 337) opens.

2. Select the Filter check box to activate the option.

3. Select the check boxes for the class characteristics you want to include.

An example displays if you hold your cursor over a class characteristic.

4. Select Exclude Unknown to limit the filter to only the exhibits with 
known class characteristics.

5. Click OK.
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Only the filtered image types display.

Related Topics 
Using Search (page 46)
Open the MultiViewer (page 132)

Sort Exhibits (page 139)

Display One or All Cartridge Case Image Types (page 143)



CHAPTER 6  Analyzing Images with the MultiViewer
Set Images at Best Match Position

147

Set Images at Best Match Position

If you selected the exhibits from the Correlations window, they are 
automatically aligned in their best match position when you open 
MultiViewer. If you move or rotate the images, you can return them to their 
best match position using this feature. 

The best match position is not available if you selected the exhibits from the 
Navigation tree; they can only be displayed in their acquisition position. 

Best Match Position
When cartridge case exhibits are displayed in the best match position, 
MATCHPOINT+ determines the optimal rotation for aligning markings on the 
displayed exhibits.

When bullet images are displayed in the best match position, LEAs are aligned 
according to the phase that produced the best score. 

For more information about phases, see Understanding Bullet Correlation 
Scores (page 80).

To display cartridge case images in the best match position:

1. In the Navigator view of the Cartridge Case MultiViewer (page 331), 
rotate a reference image to the position on which the alignment will be 
based.

  

Note: This feature is not available for ejector mark, full 
headstamp and rimfire firing pin images.

 

2. On the toolbar, click the down arrow beside Set Position and select Set at 
Best Match Position. 

The images are aligned according to the rotation of the reference image. 

3. To align the best match for another reference position, repeat steps 1 
and 2.
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To display bullet images in the best match position:

1. In the Navigator view of the Bullet MultiViewer (page 339), position the 
reference LEA you want to align in the center of the Navigator view.

2. On the toolbar, click the down arrow beside Set Position and select Set at 
Best Match Position.

The images are aligned according to the centered reference LEA. 

3. To align the best match for another LEA, repeat steps 1 and 2.

Related Topics 
Open the MultiViewer (page 132)

Adjust Bullet Images (page 174)
Cartridge Case MultiViewer (page 331)

Bullet MultiViewer (page 339)
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Hide Exhibits

If you determine that certain test exhibits are definitely not matches, you can 
hide them to reduce the number of displayed images.

To hide test exhibits:

1. In the MultiViewer (page 329), right-click the exhibit that you want to 
hide.

An X appears over the image.
  

Note: To unmark an image, right-click the image again. 
 

2. On the toolbar, click Marked Exhibits.

The marked images are hidden.
  

Note: To display hidden images, click Marked Exhibits again.
 

Related Topics 
Open the MultiViewer (page 132)
Cartridge Case MultiViewer (page 331)

Bullet MultiViewer (page 339)
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Move and Rotate Images

You can move bullet exhibits vertically. When you do so, the image wraps 
around. This means that if, for example, you move the image up, the top LEA 
or GEA will appear at the bottom of the exhibit and the bottom LEA or GEA 
will appear at the top. This simulates the action of turning a bullet in the 
holder of a comparison microscope. 

You can rotate all cartridge case exhibit types. Primer 3D DFF images can be 
rotated in three-dimensions.

To move a bullet mosaic:

• In the Bullet MultiViewer (page 339), click a bullet exhibit and drag it up 
or down. 

The image wraps around as you move it.

To rotate a cartridge case image:

1. In the Cartridge Case MultiViewer (page 331), place the cursor over the 
image that you want to rotate.

The Rotation cursor appears.

2. To rotate a 2D image, click the image and drag to the left (or up) to rotate 
it in a counterclockwise direction, or to the right (or down) to rotate it in a 
clockwise direction. 

3. To rotate a primer 3D DFF image, click the image and drag it to rotate it 
freely. 

If you press the left and right mouse buttons simultaneously, the image 
rotates around an axis that is perpendicular to the screen.

Related Topics 
Open the MultiViewer (page 132)
Cartridge Case MultiViewer (page 331)

Bullet MultiViewer (page 339)
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Adjust the Lighting and Rendering of 3D Images

If you are comparing 3D bullet images or primer 3D DFF images, you can 
manipulate the images in the following ways:

• Adjust the lighting for 3D images (page 193)
• Adjust the rendering of 3D images (page 195)
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Open the Side-by-Side Viewer from the MultiViewer

After you have identified potential matches using the MultiViewer, open the 
Side-by-Side Viewer to perform in-depth analyses of individual exhibits. 

The same list of test exhibits available in the MultiViewer can display in the 
Side-by-Side Viewer. Only the test exhibits that were “hidden” do not 
display. The exhibit counter on the toolbar indicates the order number when 
there are multiple exhibits.

To open the Side-by-Side Viewer from the MultiViewer:
  

Tip: To select the test exhibit you want to view in the first 
position in the Side-by-Side Viewer, double-click it. A blue outline 
appears around the exhibit you clicked.

If you want to view two test exhibits, double-click to select the 
first one and CTRL+double-click to select the second test exhibit.

 

• On the toolbar, click Side-by-Side Viewer.

The Side-by-Side Viewer (page 345) opens. The reference exhibit appears 
on the left side of the Comparison view and the test exhibits appear on 
the right side.

For more information, see:

• Comparing Bullet Images in the Side-by-Side Viewer (page 158).
• Comparing Cartridge Case Images in the Side-by-Side Viewer 

(page 160).

Related Topics 
Open the MultiViewer (page 132)
Comparing Bullet Images in the Side-by-Side Viewer (page 158)

Comparing Cartridge Case Images in the Side-by-Side Viewer (page 160)

Cartridge Case MultiViewer (page 331)
Bullet MultiViewer (page 339)
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Save MultiViewer Settings

You can save the settings that you have changed, such as lighting, layout, and 
display. When you save your settings they become your default preference. The 
next time you open the MultiViewer, your preferences will be applied.

  

Tip: To set your preferences, see Setting Your Preferences 
(page 55).

 

To reset values:

• On the MultiViewer (page 329) toolbar, click Save Settings.

All the settings that you have changed are saved as your preference.

Related Topics 
Setting Your Preferences (page 55)

Open the MultiViewer (page 132)

Cartridge Case MultiViewer (page 331)
Bullet MultiViewer (page 339)
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C H A P T E R 7  

Analyzing Images in the Side-by-Side
Viewer

This section covers the following topics: 

Comparing Bullet Images in the Side-by-Side Viewer................................. 158
Comparing Cartridge Case Images in the Side-by-Side Viewer................... 160
Select Exhibits to View ............................................................................. 163
Import Exhibits from Remote Sites ............................................................ 166
Display Guides in the Side-by-Side Viewer ................................................ 168
Navigate Exhibits and Regions of Interest ................................................. 170
Using the Image Manipulation Controls.................................................... 171
Set Bullet Images at Best Match Position .................................................. 173
Adjust Bullet Images ................................................................................ 174
Set Cartridge Case Images at Best Match Position .................................... 176
Move Bullet Mosaics ................................................................................ 177
Move and Rotate Cartridge Case Images .................................................. 179
Overlap Images........................................................................................ 181
Place Rulers on a Bullet Image ................................................................. 183
View Correlation Scores ........................................................................... 185
Change the Magnification Level ............................................................... 186
Adjust Image Brightness .......................................................................... 187
Adjust Image Contrast ............................................................................. 188
Adjust Image Midtones ............................................................................ 190
Adjust Image Sharpness ........................................................................... 192
Adjust the Lighting for 3D Images ............................................................ 193
Adjust the Rendering of 3D Images .......................................................... 195
Adjust the 3D Elevation of 3D Images....................................................... 197
Stretch or Shrink Bullet Images................................................................. 199
Visualize Bullet Profiles ............................................................................ 201
Calculate the Number of Consecutive Matching Striae .............................. 205
Configure CMS Options............................................................................ 209
Save a Screenshot of the Comparison View .............................................. 211
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Export Cartridge Case Images...................................................................213
Print Images.............................................................................................215
Reset Values ............................................................................................216
Save Side-by-Side Viewer Settings.............................................................217
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Comparing Bullet Images in the Side-by-Side Viewer 

If you identify a potential match between bullet exhibits in the MultiViewer, 
you can perform a more in-depth analysis of the reference exhibit and a 
particular test exhibit in the Side-by-Side Viewer.

Mosaics
Bullet exhibits are displayed in the Bullet Side-by-Side Viewer (page 355) as 
mosaics. A mosaic represents a fully acquired bullet image, with LEAs and, in 
the case of 3D mosaics, GEAs, that are displayed vertically in one continuous 
image. For more information, see What Is a Mosaic? (page 130).

  

Note: Bullets that have been fired through a polygonal rifled 
barrel do not have GEAs. 

 

The following table describes the types of mosaics that are displayed in the 
Side-by-Side Viewer depending on the types of exhibits selected: 

Available Features
In the Side-by-Side Viewer’s Navigator view, you can compare the full mosaics 
to look for marks that may be potential matches. In the Comparison view, you 
can closely examine the LEAs that appear to have similar marks. 

When analyzing bullet images in the Side-by-Side Viewer, you can do the 
following: 

• Reposition the two images:

• Set images at the best match position (page 173)
• Adjust bullet images (page 174)

If Then

Both of the selected exhibits are 2D 
(acquired by BulletProof)

Both mosaics are 2D. Only LEAs are 
displayed. 

One of the selected exhibits is 2D 
(acquired by BulletProof) and one is 3D 
(acquired by BULLETTRAX-3D)

One mosaic is 2D and the other is 3D. 
However, only LEAs are displayed. GEAs are 
suppressed.

Both of the selected exhibits are 3D Both mosaics are 3D. LEAs and GEAs are 
displayed. 
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• Move bullet mosaics (page 177)

• Overlap images (page 181)

• Display:

• Display guides (page 168)

• Correlation scores (page 185)

• Manipulate the images:

• Change the magnification level (page 186)

• Adjust image brightness (page 187)
• Adjust image contrast (page 188)

• Display negative image

• Adjust image midtones (page 190)

• Adjust image sharpness (page 192)
• Adjust the lighting for 3D images (page 193)

• Stretch bullet images (page 199)

• Manipulate the surface texture:
• Adjust the rendering of 3D images (page 195)

• Adjust the 3D elevation of 3D images (page 197)

• If the two LEAs appear to be a potential match, you can perform the 
following detailed analyses: 

• Calculate the number of consecutive matching striae (page 205) for a 
particular LEA pair.

• Generate bullet profiles (page 201) to see a graphical representation of 
the reference and test bullets’ surface features.

• You can also:
• Save a screenshot of the Comparison View (page 211)

• Reset values (page 216)

• Print images (page 215)

If a manual comparison of two exhibits reveals a match, record the hit 
(page 222) in MATCHPOINT+. 
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Comparing Cartridge Case Images in the Side-by-Side 
Viewer

If you identify a potential match between cartridge case exhibits in the 
MultiViewer, you can perform a more in-depth analysis of the reference 
exhibit and a particular test exhibit in the Side-by-Side Viewer.

Image Types
When analyzing centerfire cartridge case images, compare the different types 
of images for similarities in the following order:

• Breech face images
• Firing pin images
• Ejector mark images
• Primer images

Analyzing Cartridge Case Images
The following procedure describes a general approach that can be used to 
analyze cartridge case images. See Available Features (page 161) for a 
complete list of functions that are available in the Side-by-Side Viewer. 

To analyze cartridge case images:

1. Open the Side-by-Side Viewer (page 163).

• If you are comparing centerfire acquisitions, by default, the breech face 
ring light images are displayed in the Comparison view. Go to step 2 
to continue.

• If you are comparing rimfire acquisitions, you only need to analyze firing 
pin images. Go to step 4 to continue.

2. Set images at best match position (page 176).

MATCHPOINT+ uses the optimal rotation for image comparison.

This feature is disabled if the exhibits were not selected from the 
Correlations window.

3. Overlap the images (page 181) to determine if there is a visual match.
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4. Display the firing pin images in the Comparison view and repeat steps 2 
and 3.

See Navigating exhibits and ROIs (page 170).

5. Display the ejector mark images in the Comparison view and repeat steps 
2 and 3.

  

Note: You can reset values to their default settings. For more 
information, see Reset Values (page 216).

 

6. Continue to examine different exhibits in the Side-by-Side Viewer, by 
repeating steps 1 to 5, until you are satisfied that you have examined all 
the likely candidates.

If a manual comparison of two exhibits reveals a match, record the hit 
(page 222) in MATCHPOINT+. 

Available Features
When analyzing cartridge case images in the Side-by-Side Viewer you can do 
the following:

• Position images:

• Set images at best match position (page 176)

This feature is disabled if exhibits were not selected from the 
Correlations window, or Correlation Results Filtering.

• Move and rotate images (page 179)

• Overlap images (page 181)
• Display:

• Display guides (page 168) 

• Navigating exhibits and ROIs (page 170)
• Correlation scores (page 185)

This feature is disabled if exhibits were not selected from the 
Correlations window, or Correlation Results Filtering.

• Manipulate images:

• Change the magnification level (page 186)

• Adjust image brightness (page 187)
• Adjust image contrast (page 188)
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• Display negative images

• Adjust image midtones (page 190)
• Adjust image sharpness (page 192)

• Adjust the lighting for 3D images (page 193)

• Adjust the rendering of 3D images (page 195)
• Adjust the 3D elevation of 3D images (page 197)

• You can also:

• Save a screenshot of the Comparison View (page 211)
• Export cartridge case images (page 213)

• Print images (page 215)

• Reset values (page 216)

Related Topics 
Open the Side-by-Side Viewer (page 163)
Cartridge Case Side-by-Side Viewer (page 347)
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Select Exhibits to View

There are a number of different ways to select the exhibits you want to view. 
Regardless which method you use, the reference exhibit and test exhibits are 
automatically recorded in Viewer Exhibits in the Navigation tree. You can 
view the selected exhibits in either the MultiViewer or the Side-by-Side 
Viewer. 

Open the Side-by-Side Viewer 
To select the exhibits you want to view in the Side-by-Side Viewer, you can 
do one of the following:

• Select exhibits based on their correlation scores, see Open from the 
Correlation Window (page 163).

• Select exhibits based on analysis in correlation results filtering, see 
Correlation Results Filtering (page 119).

  

Note: When you select correlated exhibits, you can display 
images in their best match position and view the correlation 
scores.

 

• Define filter criteria to select the test exhibits based on their class 
characteristics, see Filter Test Exhibits (page 92).

• Manually select exhibits you want to compare, see Open from the 
Navigation tree (page 164).

• Open directly from the MultiViewer, see Open from the MultiViewer 
(page 165).

  

Note: Only users with Expert Acquisition Technician or Firearm 
Examiner permissions can view the Correlations window.

 

To open the Side-by-Side Viewer from the Correlations window:

1. Open the Correlation List window (page 113). 

2. In the Correlation Requests view, click to select a correlation request.

All of the results that are associated with the selected correlation request 
are displayed in the Correlation Results view. 
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Note: If you specify a score to sort by in the Correlations window 
(page 285), the order is respected when you open the Side-by-
Side Viewer.

 

3. Click Side-by-Side Viewer on the toolbar.

The Side-by-Side Viewer (page 345) opens with the sort order you set. The 
exhibit counter indicates the number of test exhibits in the list.

  

Tip: To display Exhibit Details, hold your cursor over the upper 
left or right image area in the Comparison view. 

 

To open the Side-by-Side Viewer from Correlation Results Filtering:

1. Open Correlation Results Filtering (page 119).

2. Select the individual ID check boxes for the exhibits you want to view, or 
Select All.

3. On the toolbar, click the Side-by-Side Viewer.

The Side-by-Side Viewer (page 345) opens. The reference exhibit and the 
selected test exhibits are displayed.

To open the Side-by-Side Viewer from the Navigation tree:

1. From the Navigation tree (page 34), click the plus sign (+) next to the case 
folder that contains the exhibit that you want to use as the reference.

The case expands and displays the associated exhibits.

2. Select the exhibit that you want to use as the reference.

3. Right-click and select Set as Reference Exhibit.
  

Tip: You can also use the toolbar buttons to select exhibits. 
 

4. Select the exhibit that you want to use as the test exhibit.

5. Right-click and select Set as Test Exhibit.

6. If required, select additional exhibits to create a list of test exhibits.

7. Right-click and select Add to Test Exhibits.
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The additional selection is added to the list of test exhibits.

8. Click Side-by-Side Viewer on the toolbar. 

The Side-by-Side Viewer (page 345) opens with the test exhibits sorted in 
the order they were selected. You are ready to begin analyzing the 
exhibits.

To open the Side-by-Side Viewer from the MultiViewer:

1. Open the MultiViewer (page 132).

2. Select the Sort by order to display the exhibit list.
  

Tip: To select an exhibit to view first in the list, double-click it. A 
blue outline appears around the exhibit. 

When you open the Side-by-Side Viewer the exhibit counter 
displays the order of the list, for example, 3/39 to indicate the 
third exhibit in a list of 39.

 

3. Click the Side-by-Side Viewer on the toolbar.

The Side-by-Side Viewer (page 345) opens. The reference exhibit and the 
test exhibits are displayed.

  

Note: The exhibit counter on the toolbar indicates the number of 
test exhibits in the list.

 

Related Topics 
Cartridge Case Side-by-Side Viewer (page 347)

Bullet Side-by-Side Viewer (page 355)
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Import Exhibits from Remote Sites

If you selected test exhibits based on their correlation scores, some of those 
exhibits may be stored on remote servers. According to your connection, the 
Data Concentrator or the Correlation Server, will automatically import a set 
number of the best exhibits (those that are the most likely matches).

For example, if your system is set to import ten exhibits, it means that up to ten 
of the best exhibits in each score category will be imported automatically. After 
the top ten have been imported for each score category, you must import the 
exhibits manually if you want to view them.

  

Note: Imported exhibits may have hidden field information; 
whereby the original content is replaced with five  (*****). This 
indicates that the data has been sanitized as part of the secure 
process for international data sharing.

 

You can import individual exhibits when you want them, or import all of the 
exhibits that are stored on remote sites at once. If you decide to import all the 
remotely stored exhibits, the process may take a long time. 

Reimport an Exhibit
After an exhibit is imported to your local Data Concentrator or the Correlation 
Server, it can still be changed at its origin; for example, images can be 
reacquired, new information can be added, or the exhibit can be deleted. To 
ensure that the exhibit on the Data Concentrator or the Correlation Server is 
up-to-date, you can reimport the exhibit. To do so, right-click the exhibit and 
then select Reimport Exhibit.

  

Tip: To reimport an exhibit in the Side-by-Side Viewer, open the 
Exhibit Information pop-up window and click Reimport Exhibit.

 

To import individual remote exhibits:

1. Open the Side-by-Side Viewer (page 163) with exhibits that have 
correlation scores.

If any of the exhibits are not stored locally, an Import button is displayed 
in place of the exhibit image.
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2. Click the Import button in the Bullet Side-by-Side Viewer (page 355) or 
Cartridge Case Side-by-Side Viewer (page 347).

While the exhibit is being imported, you can continue working. 

To import all remote exhibits:

1. Open the Side-by-Side Viewer (page 163) with exhibits that have 
correlation scores.

2. Click Import on the toolbar.
  

Note: If all the exhibits are stored locally, Import is not available.
 

The Import Exhibits dialog box (page 311) opens.

3. Select All, or select Highest Scores and enter a number.

4. Click Import.

The importing process is started and may take some time. The exhibits 
display when the import is complete.

Related Topics 
Open the Side-by-Side Viewer (page 163)
Cartridge Case Side-by-Side Viewer (page 347)

Bullet Side-by-Side Viewer (page 355)
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Display Guides in the Side-by-Side Viewer

When viewing exhibits in the Side-by-Side Viewer, you can control the types 
of guides you want to display. You can select one or more guides to display, 
and then click Display Guides on the toolbar to turn them on or off.

You can change the display settings for individual guides as required when you 
work. To set your preferences, see Setting Your Preferences (page 55).

The display guides for bullet and cartridge case exhibits are listed below.

Bullet Display Guides
• Anchor Lines
• LEA/GEA Labels Numbers (Navigator view only)
• LEA/GEA Widths (Navigator view only)

Cartridge Case Display Guides (Comparison view only)
• Outlines
• Outline Diameters
• Acquisition Markers
• Annotations
• Outer Regions

  

Note: To display text Annotations, hold your cursor over the 
icon to activate a pop-up window.

 

To set display guides:

1. On the toolbar, click the down arrow beside Display Guides.

The information controlled by Display Guides is displayed.

2. Select the information you want to display.

A check mark appears beside your selection. These are the guides that 
display when you click Display Guides.

  

Note: To turn the display on or off, click Display Guides.
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Exhibit Information
The Display Guides listed for the Side-by-Side Viewer do not include Exhibit 
Details. However, there are two small activation areas that you can use to 
trigger the Exhibit Information window to open. These activation areas are 
always available.

To display exhibit information:

1. In the Comparison view, hold your cursor at the top left corner of the 
reference exhibit.

The exhibit information for the reference exhibit is displayed.

2. In the Comparison view, hold your cursor at the top right corner of the 
test exhibit.

The exhibit information for the test exhibit is displayed.

3. To close the window, move your cursor away or click the X.

Related Topics 
Display Guides in the MultiViewer (page 134)
Open the Side-by-Side Viewer (page 163)

Cartridge Case Side-by-Side Viewer (page 347)

Bullet Side-by-Side Viewer (page 355)
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Navigate Exhibits and Regions of Interest

Use the navigation buttons in the Side-by-Side Viewer to cycle through a list 
of test exhibits or regions of interest. The navigation feature provides an easy 
way to rapidly view full-size images, or quickly locate key regions of interest. 

  

Note: The exhibit navigation buttons are not available if there is 
only one test exhibit.

 

If you change the position, zoom or rotation of an image, the setting is 
maintained if you navigate to another exhibit or another ROI and return.

The ROI navigation for bullets can be used forward or backward (Next or 
Previous) continuously. The ROI will loop around again if you continue to 
navigate.

The ROI navigation for cartridge cases displays an image pair in the 
Comparison view and outlines the ROI in the Navigator view. You can also 
click an image pair in the Navigator view to select the ROI you want to 
display.

To navigate exhibits:

1. Open the Side-by-Side Viewer (page 163).

2. Use the Next Exhibit and Previous Exhibit arrows to move forward or 
backward through a series of exhibits.

  

Tip: Use the keyboard shortcuts, PAGE UP and PAGE DOWN, to 
navigate exhibits.

 

To navigate ROIs:

1. Open the Side-by-Side Viewer (page 163).

2. Use the Next ROI and Previous ROI arrows to move forward or backward 
through the available ROIs of the exhibit.

  

Tip: Use the keyboard shortcuts, CTRL+RIGHT ARROW and 
CTRL+LEFT ARROW, to navigate ROIs.
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Using the Image Manipulation Controls

The Side-by-Side Viewer provides controls that enable you to manipulate the 
following image characteristics: brightness, contrast, 2D/3D rendering, 3D 
elevation, stretch, and shrink. 

Entering a Value
These controls work in the same way and accept input in a variety of ways, as 
shown in the following illustration.

If you enter a value that is outside the valid range, the value is displayed on a 
red background. If the entered value is less than the minimum valid value, 
MATCHPOINT+ will use the minimum valid value for its calculations. If the 
entered value is greater than the maximum valid value, MATCHPOINT+ will 
use the maximum valid value. 

Locking Controls
You have the option of locking most of the controls in the Side-by-Side 
Viewer. When you lock a control, the adjustments that you make are applied 
to the reference image and the test image simultaneously. When a control is 
unlocked, you can make adjustments to each image independently. 

The locking controls are indicated by the following icons:

Click the UP ARROW to 
increase the value by 1, or 
click the DOWN ARROW to 
decrease it by 1

Enter a value directly in 
the text box

Click the V to open a slider 
and drag it to the left to 
decrease the value or to 
the right to increase the 
value

Click and drag the blue 
slider to the left to 
decrease the value or to 
the right to increase the 
value
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All of the controls, except the Stretch control in the Bullet Side-by-Side Viewer, 
have a lock. 

Related Topics 
Open the Side-by-Side Viewer (page 163)

Cartridge Case Side-by-Side Viewer (page 347)

Bullet Side-by-Side Viewer (page 355)
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Set Bullet Images at Best Match Position

If you selected the exhibits from the Correlations window, they are 
automatically aligned according to their best match position; the phase that 
produced the best score. If you move the images, you can return them to their 
best match position using this feature. 

The best match position is not available if you selected the exhibits from the 
Navigation tree; they can only be displayed in their acquisition position.

To display images in best match position:

1. In the Navigator view of the Bullet Side-by-Side Viewer (page 355), move 
the exhibit so that the reference LEA you want to use to calculate the best 
phase alignment is positioned within the Navigator Box.

2. On the toolbar, click Set Position.

The reference exhibit and test exhibit are aligned according to the best 
match position in the Comparison view.

  

Tip: To set the action of the button to either Best Match Position 
or Acquisition Position, click the down arrow beside Set Position.

 

3. To recalculate the best match position using a different reference LEA, 
repeat steps 1 and 2.

Related Topics 
Open the Side-by-Side Viewer (page 163)
Adjust Bullet Images (page 174)

Bullet Side-by-Side Viewer (page 355)
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Adjust Bullet Images

You can adjust images to make the comparison of angled striae and different 
image formats easier to see. The adjustment options available in the Side-by-
Side Viewer are Redress Only and Normalize. 

• Redress Only: Adjusts the striae angle to a flat plane. The twist of a 
barrel’s rifling creates striae on a bullet that are not horizontal. This 
adjustment can help make a comparison.

• Normalize: Adjusts the comparison when the reference and the test 
images were not acquired by the same system, that is, one was acquired 
using BULLETTRAX-3D and one was acquired using IBIS Heritage. Both 
images are redressed and the height of the BULLETTRAX-3D image is 
adjusted to match the format of the IBIS Heritage image.
Normalize is not available when the images have been acquired by the 
same system.

  

Tip: After an option is set, you can click Adjust to turn it on or 
turn it off.

 

To redress the images:

1. Open the Side-by-Side Viewer (page 163).

2. Use the controls in the Bullet Side-by-Side Viewer (page 355), to set the 
images. 

3. On the toolbar, click the down arrow beside Adjust. 

4. Select Redress Only.

The reference and test images are redressed.
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To normalize the images:

1. Open the Side-by-Side Viewer (page 163).

2. Use the controls in the Bullet Side-by-Side Viewer (page 355), to set the 
images. 

3. On the toolbar, click the down arrow beside Adjust.

4. Select Normalize.

The images are redressed and normalized.

Related Topics 
Open the Side-by-Side Viewer (page 163)

Set Bullet Images at Best Match Position (page 173)
Bullet Side-by-Side Viewer (page 355)
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Set Cartridge Case Images at Best Match Position

If you selected the exhibits from the Correlations window, they are 
automatically aligned in their best match position when you open the Side-by-
Side Viewer. If you move or rotate the images, you can return them to their 
best match position using this feature. 

The best match position is not available if you selected the exhibits from the 
Navigation tree; they can only be displayed in their acquisition position. 

  

Note: This feature is not available for ejector mark, full 
headstamp and rimfire firing pin images.

 

To display images in best match position:

• On the Cartridge Case Side-by-Side Viewer (page 347) toolbar, click Set 
Position.

MATCHPOINT+ aligns the images in the Comparison view according to 
their optimal rotation.

  

Tip: To set the action of the button to either Best Match Position 
or Acquisition Position, click the down arrow beside Set Position.

 

Related Topics 
Open the Side-by-Side Viewer (page 163)

Adjust Bullet Images (page 174)
Cartridge Case Side-by-Side Viewer (page 347)
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Move Bullet Mosaics

In the Navigator view, bullet mosaics can be moved vertically. In the 
Comparison view, they can be moved vertically and horizontally.

Moving Mosaics Vertically
The Navigator view displays entire bullet mosaics, whereas the Comparison 
view displays a section of each mosaic in a magnified view. To display a 
different section of mosaic in the Comparison view, you must move the 
mosaic vertically until the section is within the Navigator Box of the Navigator 
view. Any vertical movement in the Comparison view is reflected in the 
Navigator view.

When you move a mosaic vertically, the image wraps around. This means that 
if, for example, you move the mosaic up, the top LEA or GEA will appear at the 
bottom of the mosaic and the bottom LEA or GEA will appear at the top. This 
simulates the action of turning a bullet in the holder of a comparison 
microscope.

Moving Mosaics Horizontally
In the Comparison view, you can also move mosaics horizontally to overlap 
the two images or to separate them. 

For more information, see Overlap Images (page 181). 

To move a mosaic:

1. If you want to move the reference exhibit and the test exhibit together, 
click the Lock button that is to the right of the Navigator view.

For more information about the viewer, see Bullet Side-by-Side Viewer 
(page 355).

  

Note: You can also move mosaics in the Bullet MultiViewer 
(page 339).

 

2. To move a bullet mosaic horizontally, click the image in the Comparison 
view and drag it to the left or right.
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3. To move a bullet mosaic vertically, click the mosaic and drag it up or 
down. 

The mosaic wraps around.

Related Topics 
Open the Side-by-Side Viewer (page 163)

Overlap Images (page 181)
Bullet Side-by-Side Viewer (page 355)
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Move and Rotate Cartridge Case Images 

You can move and rotate the cartridge case images that are displayed in the 
Comparison view to align them. Primer 3D DFF images can be rotated three-
dimensionally.

Two cursor modes are available in the Cartridge Case Side-by-Side Viewer.

  

Note: You can also automatically align the images using the best 
match position (page 176), as determined by MATCHPOINT+.

 

To move an image:

1. If the cursor is not in Translation mode, either click Translation Mode on 
the Cartridge Case Side-by-Side Viewer (page 347) toolbar, or right-click 
the image.

2. To move a cartridge case image horizontally, click the image and drag it to 
the left or right.

3. To move a cartridge case image vertically, click the image and drag it up or 
down.

To rotate a cartridge case image:

1. If the cursor is not in Rotation mode, either click Rotation Mode on the 
toolbar, or right-click the image.

2. To rotate a 2D image, click the image and drag it to the left (or up) to 
rotate it in a counterclockwise direction, or to the right (or down) to rotate 
it in a clockwise direction. 

 Button Mode Description

Translation Enables translation mode. You can move images 
horizontally and vertically.

Rotation Enables rotation mode. You can rotate 2D images in a 
clockwise or counterclockwise direction. You can rotate 3D 
images in any direction.
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3. To rotate a primer 3D DFF image, click the image and drag it to rotate it 
freely. 

If you press the left and right mouse buttons simultaneously, the image 
rotates around an axis that is perpendicular to the screen.

  

Tip: The acquisition marker, a red line, indicates the original 
position of the image. Use Display Guides to show or hide the 
acquisition markers.

 

Related Topics 
Open the Side-by-Side Viewer (page 163)

Set Bullet Images at Best Match Position (page 173)

Cartridge Case Side-by-Side Viewer (page 347)



CHAPTER 7  Analyzing Images in the Side-by-Side Viewer
Overlap Images

181

Overlap Images

When similarities are found between two exhibits, you can overlap them in the 
Comparison view to identify marks which coincide. 

Overlapping Bullet Images
When overlapping bullet images, you can turn transparency on or off. When it 
is off, both exhibits are fully opaque. When it is on, as shown below, both 
exhibits are transparent, which allows the reference image to show through 
the test image.

To turn on Transparency mode:

• On the Bullet Side-by-Side Viewer (page 355) toolbar, click Transparency 
Mode.

The hairline separator disappears. The exhibits become transparent.
  

Note: To turn transparency off, click Transparency Mode again. 
 

To overlap bullet images:

• Click an image in the Comparison view and drag it horizontally towards 
the other image.
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As you do so, you will be able to see the features of the reference exhibit 
showing through the test exhibit. 

For more information, see Move Bullet Mosaics (page 177).

Overlapping Cartridge Case Images
There is no Transparency mode in the Cartridge Case Side-by-Side Viewer 
(page 347). When overlapping cartridge case images, you instead attempt to 
create a single composite image out of the two separate images. 

To overlap cartridge case images:

1. Click an image in the Comparison view of the Cartridge Case Side-by-
Side Viewer (page 347) and drag it horizontally towards the other image.

For more information about moving exhibits, see Move and Rotate 
Cartridge Case Images (page 179).

2. To enlarge one of the image areas, click the hairline and drag it to the left 
to enlarge the test image area or to the right to enlarge the reference 
image area.

Related Topics 
Open the Side-by-Side Viewer (page 163)

Move Bullet Mosaics (page 177)

Cartridge Case Side-by-Side Viewer (page 347)
Bullet Side-by-Side Viewer (page 355)
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Place Rulers on a Bullet Image

To measure distances, you can place up to five rulers on each image in the 
Comparison view. A ruler appears as a red line with a red circle at each end 
point, as shown below. 

Values
For each ruler, the following values are displayed:

  

Note: X, Y, D, and Z are accurate if both end points are on the 
same LEA or GEA. X, Y, and D are accurate if both end points are 
on the same region. If, however, the two end points are on 
different regions, none of the values are accurate.

And if horizontal alignment is used, X, Y, D, and Z are only 
displayed if both points are on the same LEA or GEA.

 

Value Description

X The difference between the X coordinates of the two end points. 

Y The difference between the Y coordinates of the two end points.

This value is not displayed if the ruler spans two or more regions.

Z The difference between the Z coordinates of the two end points.

D The distance between the two end points.

This value is not displayed if the ruler spans two or more regions.

Y

X
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The X, Y, and D values are displayed in inches or millimeters, depending on the 
system settings. The Z value is always displayed in micro meters. To set your 
preferences, see Setting Your Preferences (page 55).

  

Note: Anchor lines that were placed in BULLETTRAX-3D are 
independent, so their angles can vary. To ensure that LEA width 
measurements are consistent for all images, a standardized 
method is used to calculate an average for the direction of anchor 
lines.

 

To use rulers:

1. To add a ruler, right-click an image in the Comparison view and select 
Add ruler.

2. To move a ruler, click an end point and drag it.

3. To delete a ruler, right-click an end point and select Delete ruler.
  

Tip: If you have placed multiple rulers and want to delete all of 
them, select Delete all rulers.

 

Related Topics 
Open the Side-by-Side Viewer (page 163)

Bullet Side-by-Side Viewer (page 355)
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View Correlation Scores

You can view the correlation scores of the exhibits that are displayed in the 
Comparison view.

  

Note: This feature is enabled only if the exhibits were correlated.
 

To view correlation scores:

1. On the Bullet Side-by-Side Viewer (page 355) or the Cartridge Case Side-
by-Side Viewer (page 347) toolbar, click Correlation Scores.

The Correlation Scores dialog box (bullets) (page 377) or the Correlation 
Scores dialog box (cartridge cases) (page 375) opens and displays the 
correlation scores for the reference exhibit and the test exhibit.

2. Click Close to close the dialog box. 

Related Topics 
Open the Side-by-Side Viewer (page 163)

Cartridge Case Side-by-Side Viewer (page 347)
Bullet Side-by-Side Viewer (page 355)
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Change the Magnification Level

In the Comparison view of the Side-by-Side Viewer, you can change the 
magnification level of the displayed images. 

To change the magnification level for exhibits:

• On the toolbar of the Bullet Side-by-Side Viewer (page 355) or Cartridge 
Case Side-by-Side Viewer (page 347), click the desired magnification level: 

Related Topics 
Open the Side-by-Side Viewer (page 163)

Cartridge Case Side-by-Side Viewer (page 347)

Bullet Side-by-Side Viewer (page 355)

Click To

Decrease the magnification level of the Comparison view. 

Increase the magnification level of the Comparison view. 
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Adjust Image Brightness

If you are comparing two bullet images that were acquired by 
BULLETTRAX-3D, or two cartridge case images that were acquired by 
BRASSTRAX-3D, the brightness should be similar for both images. However, if 
you are comparing an image that was acquired by BULLETTRAX-3D to an 
image that was acquired by BulletProof, or an image that was acquired by 
BRASSTRAX-3D to an image that was acquired by BrassCatcher, one of the 
images may be darker than the other. In this case, you can make the brightness 
uniform by adjusting the brightness setting of either the reference image or the 
test image. 

To adjust the brightness:

1. If you want to adjust the brightness for both images simultaneously, click 
the Lock button in the Brightness Control.

For more information about the viewer and the location of these controls, 
see Bullet Side-by-Side Viewer (page 355) or Cartridge Case Side-by-Side 
Viewer (page 347).

2. To increase the brightness of an image, set the Brightness Control to a 
value that is greater than 50.

The range is 0 to 100. The default is 50.

You can enter a value directly, or you can use the up and down arrows or 
one of the sliders to set a value. For more information about using these 
controls, see Using the Image Manipulation Controls (page 171). 

3. To decrease the brightness of an image, set the Brightness Control to a 
value that is less than 50. 

Related Topics 
Open the Side-by-Side Viewer (page 163)

Using the Image Manipulation Controls (page 171)
Cartridge Case Side-by-Side Viewer (page 347)

Bullet Side-by-Side Viewer (page 355)
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Adjust Image Contrast 

If you are comparing two bullet images that were acquired by BULLETTRAX-3D 
or two cartridge case images that were acquired by BRASSTRAX-3D, the 
contrast should be similar for both images. However, if you are comparing an 
image that was acquired by BULLETTRAX-3D to an image that was acquired by 
BulletProof, or an image that was acquired by BRASSTRAX-3D to an image 
that was acquired by BrassCatcher, the contrast will likely be different for the 
two images. In this case, you can make the contrast uniform by adjusting the 
contrast setting of either the reference image or the test image. 

The range is 0 to 100 and the default value is 50. Setting the contrast to a 
value that is greater than 50 increases the contrast and, therefore, exaggerates 
the difference between highlights and shadows. Setting the contrast to a value 
less that is than 50 decreases the contrast and, therefore, lessens the 
difference between highlights and shadows.

The following graphic shows an example of the effect of different contrast 
settings on the same bullet exhibit.

To adjust the contrast:

1. If you want to adjust the contrast for both images simultaneously, click the 
Lock button in the Contrast Control.

For more information about the viewer and the location of these controls, 
see Bullet Side-by-Side Viewer (page 355) or Cartridge Case Side-by-Side 
Viewer (page 347).

Contrast = 35
(Decreased contrast)

Contrast = 50
(Average contrast)

Contrast = 65
(Increased contrast)
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2. To increase the contrast, set the Contrast Control to a value that is 
greater than 50.

You can enter a value directly, or you can use the up and down arrows or 
one of the sliders to set a value. For more information about using these 
controls, see Using the Image Manipulation Controls (page 171). 

3. To decrease the contrast, set the Contrast Control to a value that is less 
than 50.

  

Note: After adjusting the contrast, you may want to adjust the 
brightness (page 187) to correct for changes in exposure.

 

To display the negative image:

• Select the Negative Image check box located below the Sharpness 
control.

The contrast is inverted; the light areas become dark, and the dark areas 
become light.

Related Topics 
Open the Side-by-Side Viewer (page 163)

Using the Image Manipulation Controls (page 171)

Adjust Image Brightness (page 187)
Cartridge Case Side-by-Side Viewer (page 347)

Bullet Side-by-Side Viewer (page 355)

Midtones Dialog Box (page 367)
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Adjust Image Midtones

When you use the main Contrast control, the adjustments affect the image 
globally. If you want to make more subtle adjustments, you can adjust the 
contrast and brightness of only the midtones.

When you adjust the midtone contrast it changes the middle portion of the 
light scale. Decreasing the value will reduce the differences between the mid 
gray levels, thus increasing the differences in the lighter and darker portions of 
the image. Increasing the values creates the opposite effect. 

Midtone Viewer
The midtone viewer provides a graphic representation of the adjustments on a 
standard scale of 0-255, where black is zero and white is 255. The bottom left 
corner of the scale represents black (0), the top left and bottom right are white 
(255). 

If you want to adjust the images independently, open the lock beside the 
control. The reference exhibit appears as a red line and the test exhibit as a 
green line.

Because of the way the human eye sees grayscale, compressing the midtones 
can make it easier to see subtle details, especially in the darker zones. Usually, 
when doing this, the shift will need to be increased to restore the overall 
average intensity.

Therefore, the most beneficial adjustment is to decrease the contrast value 
(compress the midtones). In the midtone viewer, the line will move above the 
default start position. If the shift value is modified, the adjustment is 
rotational.

To adjust the midtone contrast:

1. Inside the Contrast control section, click the ellipsis (...) button.

The Midtones dialog box (page 367) opens.

2. To decrease the midtone contrast, set the Midtone control to a value that 
is less than 50.

You can enter a value directly, or you can use the up and down arrows or 
one of the sliders to set a value. For more information about using these 
controls, see Using the Image Manipulation Controls (page 171). 
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3. To increase the midtone contrast, set the Midtone control to a value that is 
greater than 50.

  

Note: If you click Reset on the toolbar, all the control values on 
the Side-by-Side Viewer are reset.

 

To adjust the shift:

1. Inside the Contrast control section, click the ellipsis (...) button.

The Midtones dialog box (page 367) opens.

2. To shift the adjustment to the right, set the Shift control to a value that is 
greater than 0.

3. To shift the adjustment to the left, set the Shift control to a value that is 
less than 0.

Related Topics 
Open the Side-by-Side Viewer (page 163)

Using the Image Manipulation Controls (page 171)

Adjust Image Contrast (page 188)
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Adjust Image Sharpness

If you are comparing two images that have slightly different clarity, you can 
sharpen either the reference image or the test image by increasing the contrast 
of adjacent pixels.

  

Note: For IBIS Heritage images, adjusting the sharpness can 
improve the comparison.

 

To adjust the sharpness:

1. If you want to adjust the sharpness for both images simultaneously, click 
the Lock button in the Sharpness Control.

For more information about the viewer and the location of these controls, 
see Bullet Side-by-Side Viewer (page 355) or Cartridge Case Side-by-Side 
Viewer (page 347).

2. To increase the sharpness of an image, set the Sharpness Control to a 
value that is greater than 10.

The range is 0 to 10. The default is 0.

You can enter a value directly, or you can use the up and down arrows or 
one of the sliders to set a value. For more information about using these 
controls, see Using the Image Manipulation Controls (page 171). 

Related Topics 
Open the Side-by-Side Viewer (page 163)
Using the Image Manipulation Controls (page 171)
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Adjust the Lighting for 3D Images 
  

Note: You can adjust the lighting for 3D images only. This can be 
done in the Side-by-Side Viewer and the MultiViewer. When 
you compare 2D images, the Light Control is disabled.

 

You can adjust the lighting to better visualize the striae on 3D bullet images or 
the marks on primer 3D composite images. The default light is the top side 
light at a 45-degree inclination. You can switch between a center light and a 
side light. Changes that you make to the lighting affect the displayed image 
only, not the acquired image.

The center light spreads the light evenly over the surface, causing few shadows 
and a relatively flat image. The side light casts shadows, which emphasize 
surface texture and add to the three-dimensional effect. You can change the 
direction and inclination of the side light. When the light originates from the 
top or bottom, markings are more pronounced than when it originates from 
the left or right side.

To adjust the lighting:

1. If you want to adjust the lighting for both exhibits simultaneously, click the 
Lock button on the Light Control.

For more information about the Light Control, see Bullet Side-by-Side 
Viewer (page 355) or Cartridge Case Side-by-Side Viewer (page 347).

2. To turn on the center light, click the center of the inner circle of the Light 
Control. 

3. To turn on the side light, click the outer circle of the Light Control.

A blue “light beam” appears where you clicked, indicating the direction of 
the light. 

4. To change the direction of the side light, drag the light beam around the 
outer circle. 

The current light inclination is displayed in the I field and the direction is 
displayed in the D field. You can also enter values directly into these fields. 
The valid range is 0° to 359° for direction and 45° to 90° for inclination. 
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Related Topics 
Open the Side-by-Side Viewer (page 163)

Cartridge Case Side-by-Side Viewer (page 347)
Bullet Side-by-Side Viewer (page 355)
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Adjust the Rendering of 3D Images
  

Note: You can adjust the rendering for 3D images only. This can 
be done in the Side-by-Side Viewer and the MultiViewer.

 

The 2D/3D rendering value determines how the data representing an exhibit is 
depicted visually: as a 2D image, a 3D image, or a combination of 2D and 3D.

For bullet exhibits and primer 3D DFF images, the default 2D/3D rendering 
value is 30.

  

Note: In the Image Information View (page 304), the 2D/3D 
rendering value is 0 for all images, except for 3D LEAs or GEAs 
and primer 3D DFF images which have a default value of 100. 

 

Setting the 2D/3D rendering to 100 makes the topology of the image surfaces 
more evident due to the rendering of depth. In addition, visual noise, such as 
shadows or primer residue, is removed when images are rendered as 3D. To 
further enhance the relief, you can amplify the 3D Elevation (page 197).

In the example below, the effect of changing the rendering value is shown 
using a primer 3D DFF reference and test exhibit. 

2D/3D rendering = 0 2D/3D rendering = 100
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To adjust the rendering:

1. If you want to adjust the rendering for both images simultaneously, click 
the Lock button in the 2D/3D Rendering Control.

For more information about the viewer and the location of these controls, 
see Bullet Side-by-Side Viewer (page 355) or Cartridge Case Side-by-Side 
Viewer (page 347).

2. To display an image with the maximum level of 3D, set the value to 100.

You can enter a value directly, or you can use the up and down arrows or 
one of the sliders to set a value. For more information about using these 
controls, see Using the Image Manipulation Controls (page 171).

3. To display an image as 2D only, set the value to 0.

4. To display an image as a mixture of 2D and 3D, set the value between 1 
and 99.

Related Topics 
Open the Side-by-Side Viewer (page 163)

Using the Image Manipulation Controls (page 171)
Adjust the 3D Elevation of 3D Images (page 197)

Cartridge Case Side-by-Side Viewer (page 347)

Bullet Side-by-Side Viewer (page 355)
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Adjust the 3D Elevation of 3D Images 
  

Note: You can adjust the 3D elevation for 3D images only. 
 

3D elevation is a measure of the differences in height along the z-axis. 
Increasing the 3D elevation increases the appearance of the elevation of the 
peaks on the image surface, thus exaggerating the difference between the 
peaks and valleys. The result is a more pronounced surface topology. 

  

Tip: Set the 2D/3D Rendering (page 195) value to 100 before 
increasing the 3D elevation. The texture of the exhibit surface is 
enhanced and visual noise is removed from the image. This 
technique is especially useful in the case of lead bullets, which 
tend to melt or become deformed when fired. 

 

3D elevation = 25 3D elevation = 75

2D/3D rendering = 1002D/3D rendering = 100
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To adjust the 3D elevation:

1. If you want to adjust the 3D elevation for both images simultaneously, 
click the Lock button in the 3D Elevation Control.

For more information about the viewer and the location of these controls, 
see Bullet Side-by-Side Viewer (page 355) or Cartridge Case Side-by-Side 
Viewer (page 347).

2. To increase the elevation of image peaks in the Bullet Side-by-Side Viewer 
(page 355) or Cartridge Case Side-by-Side Viewer (page 347), set the 3D 
elevation field to a value that is greater than 25 (the default).

You can enter a value directly, or you can use the up and down arrows or 
one of the sliders to set a value. For more information about using these 
controls, see Using the Image Manipulation Controls (page 171).

3. To decrease the elevation of image peaks, set the 3D elevation field to a 
value that is less than 25.

Related Topics 
Open the Side-by-Side Viewer (page 163)
Using the Image Manipulation Controls (page 171)

Adjust the Rendering of 3D Images (page 195)

Cartridge Case Side-by-Side Viewer (page 347)
Bullet Side-by-Side Viewer (page 355)
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Stretch or Shrink Bullet Images 

You can vertically stretch or shrink one or both of the mosaics in the 
Comparison view. This feature is useful when:

• Analyzing deformed bullets.
• One of the LEAs that is being analyzed is wider than the other.

This may be the case if one of the images is of poorer quality than the 
other, resulting in a more compressed image. 

• Comparing IBIS Heritage images to IBIS TRAX-3D images.

The goal of stretching or shrinking a mosaic is to make the width of the two 
LEAs being examined equal so that you can determine if the stria patterns 
coincide. When using the stretch feature, you may need to enhance the images 
by adjusting the light and contrast.

You can stretch or shrink an image by 20 percent. The default is 0 for the 
reference image and test image, which means no change is applied. In the 
following example, the stretch factor of the test exhibit has been set to 5. 

Before After 

Ref Stretch = 0 Test Stretch = 0 Ref Stretch = 0 Test Stretch = 5
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To stretch or shrink a bullet mosaic:

• In the Bullet Side-by-Side Viewer (page 355), set the change factor to a 
value between -20 and 20. 

You can enter a value directly, or you can use the up and down arrows or 
one of the sliders to set a value. For more information about using these 
controls, see Using the Image Manipulation Controls (page 171). 

You may need to move one of the mosaics to align the striae. For more 
information, see Move Bullet Mosaics (page 177).

Related Topics 
Open the Side-by-Side Viewer (page 163)

Using the Image Manipulation Controls (page 171)

Bullet Side-by-Side Viewer (page 355)
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Visualize Bullet Profiles

Bullet profiling is a tool that you can use to analyze the surfaces of the two 
bullets that are displayed in the Side-by-Side Viewer. 

What Is a Bullet Profile?
If you were to cut a bullet in half and look at the resulting cross-section, you 
would be able to distinguish the elevated groove engraved areas (GEAs) and 
the indented land engraved areas (LEAS). For the profile analysis, the data has 
been flattened, where the larger height difference between LEAs and GEAs is 
reduced to provide better focus on the details of the surface texture.

A bullet profile is a two-dimensional graph that represents the contour of such 
a cross-section of a bullet’s surface. However, the profile shows much more 
detail than is revealed to the eye. The points on the graph represent the height 
measurements of the bullet’s surface features. Peaks correspond to elevated 
regions on a bullet’s surface and valleys correspond to deeper surface areas. 

Two profiles are displayed in the Profile view, which is located below the 
Comparison view. The orange profile represents the surface of the test exhibit 
and the green profile represents the surface of the reference exhibit. The more 
similar the two profiles are, the more likely it is that the two exhibits match.

LEAs
GEAs

Peak

Valley
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Profile Modes
There are two profile modes: Hairline Profiling and Profile Lines. When Hairline 
Profiling is selected, the hairline that separates the reference exhibit from the 
test exhibit is used to generate the bullet profiles and compute the CMS. When 
Profile Lines is selected, two separate lines appear, one on the reference 
exhibit and one on the test exhibit. The position of the hairline or profile lines 
determines which area is profiled and are also used to compute the CMS.

Relationship Between the Comparison View and the Profile View
To analyze bullet profiles, you must understand the relationship between what 
you see in the Comparison view and what you see in the Profile view. 

Both the Comparison view and the Profile view show the bullet’s surface. 
However, it is represented differently in each view. The Comparison view 
shows you a 2D or 3D representation of the bullet’s surface and its markings, 
as you would see using a comparison microscope. The two graphs in the 
Profile view plot the height measurements of the points along the hairline or 
the two profile lines that are in the Comparison view. 
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The position of the hairline or profile lines determines which data slice in the 
Comparison view is represented in the Profile view. In other words, the line 
represents the place at which you cut the bullet in half to reveal a cross-
section. If you were to cut the bullet in different places, a different cross-
section would result each time. Similarly, as you move the hairline or profile 
lines, the selected data slice changes, and the profiles change correspondingly. 

In the above example, the area circled in orange in the Profile view 
corresponds to the area circled in orange in the Comparison view. The 
horizontal guidelines in the Comparison view are used to help you visually 
locate a particular point of interest in the Profile view. When you move a 
guideline in the Comparison view, the corresponding (vertical) guideline moves 
in the Profile view. For example, if there is a particular peak in the 
Comparison view that you want to locate in the profile, position the 
horizontal guideline at that point in the Comparison view. The corresponding 
vertical guideline in the Profile view moves to indicate where that point is 
located along the graph.

Comparison view

Profile view

Test exhibit guideline

Hairline

Reference exhibit guideline
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To analyze bullet profiles:

1. On the Bullet Side-by-Side Viewer (page 355) toolbar, do one of the 
following:

• Click Hairline Profiling to base the bullet profiles on the position of 
the hairline.

  

Note: To use hairline profiling, the images must have some 
overlap. For more information, see Overlap Images (page 181).

 

• Click Profile Lines to base the bullet profiles on the vertical profile lines 
that can be positioned independently on each bullet exhibit. This is the 
default.

  

Tip: To set your profile preferences, see Setting Your Preferences 
(page 55).

 

2. In the Comparison view, do one of the following: 

• If you clicked Hairline Profiling in the previous step, click the hairline 
and drag it into position. 

• If you clicked Profile Lines in the previous step, click the blue Move 
Handle at the end of a vertical profile line and drag the line to the 
position on which you want the bullet profiles based. 

3. In the Comparison view, click the blue Move Handle at the end of a 
horizontal guideline and drag it to the area of interest so that you can 
locate that area in the Profile view.

As you move the guideline, the corresponding guideline in the Profile 
view moves.

Related Topics 
Open the Side-by-Side Viewer (page 163)

Calculate the Number of Consecutive Matching Striae (page 205)

Bullet Side-by-Side Viewer (page 355)

A move handle is located at the end of each 
profile line and guideline
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Calculate the Number of Consecutive Matching Striae
  

Note: This feature applies to bullet exhibits only.
 

Consecutive matching striae (CMS) is a pattern-matching technique that 
compares a given reference LEA and test LEA to determine if there are matches 
between clusters of consecutive striae. If your visual analysis of two LEAs 
identifies potentially matching striae patterns, you can corroborate your 
analysis by assessing that area for consecutive matching striae. 

  

Note: The CMS tool is still under development. A unique and 
complete set of the topography analysis parameters that 
reproduces the published CMS method's results is not yet 
available. Therefore, you can change certain parameters in the 
Configure CMS dialog box to yield results that you judge to be 
satisfactory.
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CMS Scores
When you calculate the CMS, matching groups of consecutive striae (CMS 
groups) and individual striae are highlighted in the Comparison view. CMS 
scores are displayed in the Consecutive Matching Striae view.

The CMS is calculated either along the hairline that separates the reference 
exhibit from the test exhibit, or along the two profile lines that can be 
positioned separately for the reference exhibit and the test exhibit. These are 
the same lines that are used to generate bullet profiles. For more information, 
see Visualize Bullet Profiles (page 201).

  

Note: The CMS scores in the grid are color-coded to match the 
striae color in the Comparison view.

 

Group consisting of three consecutive 
matching striae (3 CMS). Each stria is 
highlighted with a colored line (cyan in 
this case) and the CMS group is shaded 
in the same color.

Individual striae that are found 
to match (1 CMS) are 
highlighted in red

Blue lines are anchor lines

Reference Test

CMS scores

Individual striae that do not 
match any other striae are 
highlighted in yellow
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Twelve scores, labeled 1 CMS to 12 CMS, are generated. 1 CMS indicates that 
there is a single stria in the reference LEA that matches a stria in the test LEA. 
2 CMS indicates that two consecutive striae in the reference LEA match two 
consecutive striae in the test LEA, and so on, up to 12 consecutive striae. The 
score indicates how many CMS groups with a particular number of consecutive 
matching striae were found. For example, a score of 1 in the 3 CMS column 
indicates that MATCHPOINT+ found one CMS group consisting of three 
consecutive matching striae.

The resulting CMS scores indicate how likely it is that the striae on the two 
exhibits were created by the same firearm. 

  

Note: The CMS score is sensitive to the CMS options. For more 
information, see Configure CMS Options (page 209).

 

To calculate the CMS:

1. On the Bullet Side-by-Side Viewer (page 355) toolbar, select the vertical 
line that will be used to calculate the CMS:

• Click the Hairline Profiling button to calculate the CMS on the 
position of the hairline.

  

Note: The images must have some overlap. For more 
information, see Overlap Images (page 181).

 

• Click the Profile Lines button to calculate the CMS on the vertical 
profile lines that can be positioned independently on each bullet 
exhibit. This is the default.

2. In the Navigator view of the Bullet Side-by-Side Viewer (page 355), move 
the bullet exhibits until the reference LEA and the test LEA that you want 
to compare are visible in the Comparison view. The entire LEA does not 
have to be in view. 

You can perform a CMS calculation on a pair of LEAs only if 3D data is 
available.
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Note: The area that is used in the CMS computation depends on 
the location of the hairline or profile lines. Adjust the position as 
required. For more information, see Visualize Bullet Profiles 
(page 201). 

 

3. On the toolbar, click Calculate CMS.

In the Comparison view, matching striae are highlighted in color. The 
CMS scores are displayed in the Consecutive Matching Striae view.

4. To show or hide CMS highlighting, click the arrow next to the Show/Hide 
the CMS button on the toolbar and select one of the following:

• To highlight CMS groups only, select CMS Only.

• To highlight striae without showing the CMS groups, select 
Striae Only.

• To highlight CMS groups and individual striae, select CMS and Striae.

• To hide all CMS highlighting, click Show/Hide the CMS on the toolbar.

5. To calculate the CMS on a different pair of LEAs, repeat steps 2 and 3.

Related Topics 
Open the Side-by-Side Viewer (page 163)

Visualize Bullet Profiles (page 201)
Bullet Side-by-Side Viewer (page 355)
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Configure CMS Options
  

Note: This feature applies to bullet exhibits only.
 

The CMS configuration options define the criteria that are used to identify 
individual striae and CMS groups. You can:

• Configure MATCHPOINT+ to look for a succession of peaks or a 
succession of valleys to calculate the CMS.

• Define which markings will be considered valid striae and which will be 
ignored. There are two criteria:
• The Relative Height Difference specifies how high peaks must be in 

relation to the mean level of all surface features in the selected LEA. If 
CMS is calculated using valleys, this option determines how deep 
valleys must be relative to the mean level. 

• The Minimum Length is used to exclude markings that are not 
significant (too short). 

• Define the Match Tolerance
When consecutive striae are created on different bullets by the same 
firearm, the amount of vertical space between two adjacent striae can 
differ somewhat from exhibit to exhibit. The Matching Stria Tolerance 
specifies how much of a difference, in pixels, is acceptable and, therefore, 
considered insignificant. 

To configure the CMS criteria:

1. On the Bullet Side-by-Side Viewer (page 355) toolbar, click the arrow next 
to the Calculate CMS button.

2. Select Configure.

The Configure CMS dialog box (page 365) opens. 

3. In the Find Striae Using section, do one of the following:

• If you want MATCHPOINT+ to look for a succession of peaks, select 
Peaks.

• If you want MATCHPOINT+ to look for a succession of valleys, select 
Valleys.
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4. In the Relative Height Difference field, enter the tolerated height 
difference, in percent. 

In Peak mode, a given peak will be included if its height, relative to the 
mean level of surface features in the LEA, is greater than or equal to this 
value. In Valley mode, a given valley will be included if its depth, relative to 
the mean level, is greater than or equal to this value. 

5. In the Minimum Length field, do the following:

• Select the unit of measure (mm or inch).
• In the text box, enter the minimum stria length. Striae that are shorter 

than the specified length will be ignored.

6. In the Match Tolerance field, enter the difference in vertical spacing (in 
pixels) that will be tolerated between two sets of consecutive striae that 
are being compared. 

If the difference is less than or equal to this value, the two sets of 
consecutive striae will be considered a match. 

7. Click OK.
  

Note: If you have already performed the CMS calculation, you 
must recalculate the CMS for the new settings to take effect.
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Save a Screenshot of the Comparison View

The images that are displayed in the Comparison view can be saved as a 
bitmap file or copied to the Windows clipboard for pasting into another 
application. You can choose to save just the image, or the image and its 
related information, such as the contrast and brightness settings. 

The following is an example of an image that was saved with exhibit 
information. 

To save a screenshot of the Comparison view as a bitmap file:

1. On the Cartridge Case Side-by-Side Viewer (page 347) or the Bullet Side-
by-Side Viewer (page 355) toolbar, click Screenshot.

The Screenshot dialog box (page 369) opens.

2. Select Save to file, if not already selected.

3. Click the ellipsis (...) next to the Save to file field.

The Save as screenshot dialog box opens. 

4. Select the folder in which you want to save the file, enter a file name in the 
File name field, and click Save.

The Save as screenshot dialog box closes.
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5. If you want to save exhibit information along with the image, select the 
Add text information check box.

6. Click OK.

A screenshot of the Comparison view is saved as a bitmap file to the 
specified folder. 

To copy a screenshot of the Comparison view image to the 
clipboard:

1. On the Cartridge Case Side-by-Side Viewer (page 347) or the Bullet Side-
by-Side Viewer (page 355) toolbar, click Screenshot.

The Screenshot dialog box (page 369) opens.

2. Select Copy to clipboard.

3. If you want to save exhibit information along with the image, select the 
Add text information check box.

4. Click OK.

A screenshot of the Comparison view is copied to the clipboard. You can 
now paste the image into another application.

Related Topics 
Open the Side-by-Side Viewer (page 163)

Cartridge Case Side-by-Side Viewer (page 347)
Bullet Side-by-Side Viewer (page 355)
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Export Cartridge Case Images

You can export any of the individual images that are associated with the 
reference exhibit and the test exhibit that are currently displayed.

Unlike saving a screenshot of the Comparison view, the export feature allows 
you to specify the individual images you want to export. Each selected image is 
saved as a graphic file. You can choose from among several formats such as 
jpg and png. An example is shown below:

  

Note:  Of the two primer images, you can only export the primer 
all-in-focus image. The image is listed by name in the Export 
dialog box.

 

To export images:

1. From the Reference Exhibit list in the Export Images dialog box 
(page 373), select the check boxes for the images that you want to export.

2. From the Test Exhibit list, select the check boxes for the images that you 
want to export.

3. Change the root file names, if necessary.

Suffixes are applied to the root file name to indicate the image type. For 
example, if the root file name is EX-CC-9MM, the resulting name of a 
firing pin ring light image is:

EX-CC-9MM - Firing Pin- Ring Light
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4. Select the graphic file type. Your options are:

• PNG - Portable Network Graphic
• JP2 - JPEG 2000

• RAW

  

Note: The JP2 and RAW file formats are not recognized by 
default programs on your computer. To view these files, you need 
to use a program that supports the file format.

 

5. In the Export Path field, specify the folder where the files should be 
saved.

  

Tip: You can click the ellipsis (...) to browse to the folder.
 

6. Click Export.

Each selected reference and test image is exported as a file of the 
specified type and is saved to the specified folder.

If a file name already exists, an overwrite confirmation message is 
displayed.

Related Topics 
Open the Side-by-Side Viewer (page 163)

Save a Screenshot of the Comparison View (page 211)

Cartridge Case Side-by-Side Viewer (page 347)
Export Images Dialog Box (page 373)
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Print Images

You can print the reference and test images that are displayed in the 
Comparison view. You can also preview a print job before sending it to the 
printer.

To preview and print images:

1. On the Bullet Side-by-Side Viewer (page 355) or the Cartridge Case Side-
by-Side Viewer (page 347) toolbar, click Print. 

The Print dialog box opens.

2. Click Print Preview. 

The Print Preview window (page 371) opens.

3. If there are multiple pages, you can navigate through them using the Next 
Page and Prev Page buttons.

4. To change the magnification level, click Zoom In or Zoom Out.

5. To print the images:

• Click Print.
The Windows Print dialog box opens in which you can select a printer 
and specify print properties before printing.

• Click OK.

The images are printed and the dialog box closes.

6. To close the dialog box, click Close.

To print images without previewing them:

1. On the Bullet Side-by-Side Viewer (page 355) or the Cartridge Case Side-
by-Side Viewer (page 347) toolbar, click Print. 

The Windows Print dialog box opens in which you can select a printer and 
specify print properties before printing.

2. Click OK.

The images are printed and the dialog box closes.
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Reset Values

You can reset the settings that you have changed, such as lighting, contrast, 
and 3D elevation, to their default values.

To reset values:

• On the Bullet Side-by-Side Viewer (page 355) or the Cartridge Case Side-
by-Side Viewer (page 347) toolbar, click Reset.

All the settings that you have changed are reset to their default values.

Related Topics 
Open the Side-by-Side Viewer (page 163)
Cartridge Case Side-by-Side Viewer (page 347)

Bullet Side-by-Side Viewer (page 355)
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Save Side-by-Side Viewer Settings

You can save the settings that you have changed, such as lighting, contrast, 
and 3D elevation. When you save your settings they become your default 
preferences. The next time you open the Side-by-Side Viewer, your 
preferences will be applied.

  

Tip: To set your preferences, see Setting Your Preferences 
(page 55).

 

To reset values:

• On the Side-by-Side Viewer (page 345) toolbar, click Save Settings.

All the settings that you have changed are saved as your preference.

Related Topics 
Setting Your Preferences (page 55)

Open the Side-by-Side Viewer (page 163)
Cartridge Case Side-by-Side Viewer (page 347)

Bullet Side-by-Side Viewer (page 355)
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Overview

Hits must be recorded in MATCHPOINT+ for reference and statistical purposes. 
You can record both confirmed and unconfirmed hits. A confirmed hit is one 
that has been verified by a firearm examiner using a conventional comparison 
microscope. You can modify hits after they have been added, by adding 
comments or changing their status from unconfirmed to confirmed. Only 
unconfirmed hits can be deleted.

  

Note: You must have Firearm Examiner or Expert Acquisition 
Technician privileges to create, modify, and delete hits.

 

Closing the Loop
When an operator enters a hit in the MATCHPOINT+ database, the hit is 
copied to the Correlation Server. If a hit is made between two different sites, it 
must be recorded manually at each site. This is referred to as closing the loop. 

For example, a hit is confirmed in Tampa, Florida from a matching exhibit that 
was acquired in Orlando, Florida. The firearm examiner in Tampa must enter 
the hit in the database at the Tampa site, then contact the Orlando site and 
have them record the hit in their database as well. Only the agency initiating 
and confirming the microscopic comparison of the hit will be credited for the 
hit. 

After the hit is recorded, an orange bull’s-eye appears on the case folder to 
indicate that a hit has been made.

Folder Icon Description

None of the exhibits contained in the case have been implicated in a 
hit.

At least one of the exhibits contained in the case has been implicated 
in a hit.
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Add a Hit 

Hits should be recorded in MATCHPOINT+ for reference purposes. You can add 
confirmed and unconfirmed hits to MATCHPOINT+. 

You cannot add a hit if: 

• Both exhibits belong to the same case.
• Both exhibits have a Test Fire event type.
• Both exhibits belong to sites that are outside of your jurisdiction. 
• One exhibit has an event type of Demonstration, Test and QA and the 

other exhibit has an event type other than Demonstration, Test and QA. 
You can create a hit, however, between two Demonstration, Test and QA 
exhibits.

• The LEA count, twist direction, and/or caliber family of one bullet exhibit 
differs from that of the other bullet exhibit.

• The firing pin shape or caliber family of one cartridge case exhibit differs 
from that of the other cartridge case exhibit.

• Your system is connected to a Correlation Server at the regional level.
  

Note: For facilities that have connections to both a Data 
Concentrator and a Correlation Server, hits should always be 
created on the MATCHPOINT+ system that is connected to the 
Data Concentrator. This allows the replication process to ensure 
that the hit information is available to all systems.

 

To add a hit:

1. On the Side-by-Side Viewer (page 345) toolbar, click Hit.

The Add Hit dialog box (page 381) opens with all mandatory fields already 
filled in.

For information about how to open the Side-by-Side Viewer, see Open 
the Side-by-Side Viewer (page 163).

2. Enter additional information in the Comments field, if required.

3. If the hit has been confirmed, select the Confirmed check box.

• Click the down arrow to open the calendar and then select the date 
that the hit was confirmed. 
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Note: A date is recorded for a confirmed hit. The default date is 
the day that the hit is confirmed.

 

4. Click OK.

The hit is created. To see the hit, open the Hits window (page 224).
  

Tip: To print the details, hold your cursor over the Hit Count area 
and select Print from the Hit Information display.

 

Related Topics 
Open the Side-by-Side Viewer (page 163)

Modify a Hit (page 225)

Cartridge Case Side-by-Side Viewer (page 347)
Bullet Side-by-Side Viewer (page 355)
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View a Hit

You can view a list of all the hits that have been entered at your 
MATCHPOINT+ workstation. The details of an individual hit can also be 
displayed in the Side-by-Side Viewer.

In the Hits window (page 383), a colored site icon appears beside hits that 
have at least one exhibit in your jurisdiction.

To display a list of hits:

• From the Navigation tree (page 34), click Hits.

The Hits window (page 383) opens to the right of the Navigation tree.

Hits are sorted by the Creation Date column by default.
  

Tip: To create a filter to customize the list display, see Working 
with Filters (page 49).

 

To display hit information:

• From the Side-by-Side Viewer (page 345), move your cursor over the Hit 
Count area.

The Hit Information window displays the hit details. You can modify or 
print from this window.

  

Note: The Hit Information is displayed only if a hit is indicated in 
the count area.

 

Related Topics 
Add a Hit (page 222)

Modify a Hit (page 225)
Delete an Unconfirmed Hit (page 226)

Hits Window (page 383)



CHAPTER 8  Working with Hits
Modify a Hit

225

Modify a Hit

You can modify the comments or mark an unconfirmed hit as confirmed. You 
cannot modify a hit that is outside your jurisdiction.

  

Note: Hits can be confirmed only once. After a hit is confirmed it 
cannot be deleted.

 

To modify a hit:

1. In the Hits list, double-click the hit that you want to modify.

The Modify Hit dialog box (page 381) opens. 

For more information on how to open the Hit list, see View a Hit 
(page 224).

2. In the Comments field, modify or add additional comments.

3. If the hit had not been confirmed when the hit was recorded in 
MATCHPOINT+, but has now been confirmed, select the Confirmed 
check box.

• Click the down arrow to open the calendar and then select the date 
that the hit was confirmed. 

After a hit has been confirmed, you cannot change its status to 
unconfirmed.

4. Click OK.

The Modify Hits dialog box closes.

Related Topics 
View a Hit (page 224)

Delete an Unconfirmed Hit (page 226)
Hits Window (page 383)
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Delete an Unconfirmed Hit

An unconfirmed hit that turns out to be false should be deleted. You cannot 
delete a hit that has been confirmed or a hit that is outside your jurisdiction.

To delete an unconfirmed hit:

1. In the Hits list, select the unconfirmed hit that you want to delete.

For more information on how to open the Hits list, see View a Hit 
(page 224).

2. On the toolbar, click Delete.

A message appears, asking you to confirm the deletion. 

3. Click Yes.

The hit is deleted.

Related Topics 
View a Hit (page 224)

Hits Window (page 383)
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Print a Hit

You can print the detailed information about hits that are displayed in the hits 
list. All printouts include the page count and current date for record keeping.

To print a hit:

1. In the Hits list, select the hit you want to print.

2. From the menu bar, select File > Print, or right-click and select Print from 
the context menu.

The Print dialog box appears for you to specify a printer and the 
properties.

  

Tip: To confirm the content before you print, select Print 
Preview.

 

3. Click Print. 

The hit information is sent to the printer you selected. 

Related Topics 
View a Hit (page 224)

Hits Window (page 383)
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Overview

MATCHPOINT+ allows users who have the Report role to create, list, view, 
and print reports. Reports can be generated for the following types of 
information:

• Cases
• Exhibits
• Hits
• Correlation Requests

Typically, a report consists of one or more charts and data that is arranged in 
columns. 

Creating Reports from Templates
Reports are created from templates. You can either use a standard template or 
create a custom template.

• Standard templates
MATCHPOINT+ comes with a set of default templates. These templates 
cannot be modified. 

• Custom templates
If none of the standard templates meet your needs, you can create a 
custom template. Using the New Custom Report wizard, you select the 
type of report you want to create, the fields you want to include, the order 
in which they are displayed, how data is sorted, and the type of chart to 
include.
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Standard Report Templates

The following table describes the standard MATCHPOINT+ report templates 
that are available. When you create a report based on a template, you must 
specify a date range. 

Report Template Description

Acquisitions By Site A report showing the total number of acquisitions for a 
location (site) during a specific period. The report is 
organized by site name and includes site information 
concerning the acquisition date, type (cartridge case or 
bullet), law agency, case ID, exhibit ID, event type, and GRC 
(General Rifling Characteristics).

Cases By Law Agency The resulting report is based on cases grouped by law 
agency, case event type and the case creation date. This 
template includes a bar chart. The date range is based on the 
case creation date.

Cases By Occurrence 
Date

The resulting report is based on cases grouped by the 
occurrence year, month and the event type. This template 
includes a bar chart. The date range is based on the case 
occurrence date.

Correlation Requests By 
Site

A report showing the total number of correlation requests for 
a location (site) during a specific period. The report is 
organized by site name and includes correlation request 
information concerning the creation date, correlation type, 
status, user name, case ID, exhibit ID, exhibit type, and 
exhibit event type.

Exhibits Acquired By 
User

The resulting report is based on exhibits grouped by the 
users who acquired them, the year the exhibit was acquired 
and the month. This template includes a bar chart. The date 
range is based on the exhibit acquisition date.

Exhibits By Caliber The resulting report is based on exhibits grouped by the 
acquisition site, the exhibit type and the caliber. This 
template includes a bar chart and a cross-tabulation table. 
The date range is based on the exhibit acquisition date.
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Exhibits By Event Type The resulting report is based on exhibits grouped by the 
exhibit type, the event type, such as Homicide or Assault with 
a Deadly Weapon, and the acquisition month. This template 
includes a pie chart, a bar chart, and a cross-tabulation 
table. The date range is based on the exhibit acquisition 
date.

Exhibits By Evidence 
Type

The resulting report includes a pie chart and a bar chart that 
indicate the ratio of bullets versus cartridge cases. The date 
range is based on the exhibit acquisition date.

Exhibits By GRC The resulting report is based on exhibits grouped by the 
exhibit type, the caliber type and the general rifling 
characteristics. This template includes a bar chart. The date 
range is based on the exhibit acquisition date.

Exhibits Linked To 
Firearms

The resulting report is organized by the firearm. The report 
lists the test fire exhibits that are associated with the 
description of the firearm. Firearm exhibits that do not have 
an associated cartridge case or bullet exhibit are not 
represented.

Firearms By Make A report listing all firearms according to the firearm make. 
The report is organized by make, model, caliber, firearm type, 
site, case and exhibit ID, and creation date.

Firearms Linked To 
Exhibits

The resulting report is organized by the test fire cartridge 
case or bullet exhibit. The report lists the details of firearms 
that are associated with the description of the test fire 
exhibit. Test fire exhibits that do not have an associated 
firearm are not represented.

Hits By Cases The resulting report is based on hits according to the cases to 
which they belong. This template includes a bar chart. If the 
report is based on unconfirmed or all hits, the date range is 
based on the hit creation date. Otherwise, the date range is 
based on the hit confirmation date

Hits By Creation Date A report listing all hits during a specific period. The report 
provides hit information concerning the creation and 
confirmation date, exhibit type, caliber, site, case and exhibit 
ID.

Report Template Description
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Hits By Exhibits The resulting report is based on hits according to the exhibits 
to which they belong. This template includes a bar chart. If 
the report is based on unconfirmed or all hits, the date range 
is based on the hit creation date. Otherwise, the date range 
is based on the hit confirmation date

RBI Exhibits By Law 
Agencies

The resulting report is based on Rapid Brass Identification 
(RBI) exhibits grouped by law agency, the acquisition site 
and exhibit creation date. This template includes a bar chart. 
The date range is based on the exhibit creation date.

Report Template Description
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Create a Report

Reports are created from templates. The standard templates that are supplied 
with Report Manager must be used as is. They cannot be modified. For more 
information, see Standard Report Templates (page 232). If the standard 
templates do not meet your needs, you can create and use a custom template 
instead. 

After you select the template you want to use to create the report, you will be 
prompted to enter the report parameters. The parameters include a date range 
and a selection of available sites for the report content.

To create a report:

1. From the File menu, select New > Report or click New Report on the 
toolbar.

The New Report dialog box (page 390) opens.

2. Select the template you want to use to create the report by doing one of 
the following:

• To use a standard template, click Standard Templates and select a 
template from the list. 

• To use a custom template that has already been created, click Custom 
Templates and select a template from the list. 

  

Note: To create and use a new custom template, see Create a 
Custom Template (page 247).

 

3. Enter information in the Comments field. 

This information will appear in the Comments column in the Reports 
window (page 387). This field is mandatory.

4. Click Generate.

The Report Parameters dialog box (page 392) opens. For more 
information, see Specify the Report Parameters (page 241).
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Note: If you use a standard template, MATCHPOINT+ 
automatically assigns a name to the report based on the selected 
template. If you regenerate the same report several times, a suffix 
(2, 3, 4, etc.) is attached to the name to distinguish it from 
previously generated versions.

 

5. Click Next. 

The Report Format dialog box opens.

6. Select the report formats that you want to generate. 

7. Click Finish.

Related Topics 
View a Report (page 238)

Specify the Report Parameters (page 241)
Create a Custom Template (page 247)
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Display a List of Reports

Display the Reports window to view all of the reports that you have created. 
From this window, you can select a report to view, print, or delete it. You can 
also create a new report. 

To display a list of reports:

• From the Navigation tree (page 34), click Reports.

The Reports window (page 387) opens to the right of the Navigation tree. 
Existing reports are sorted by name.

Related Topics 
Create a Report (page 235)

View a Report (page 238)

Delete a Report (page 246)
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View a Report

Reports that you have created in the default PDF format can be opened in 
Adobe® Reader®. If you created other report types and have the appropriate 
programs installed on your system, you can also open HTML, RTF and Excel 
formats.

  

Note: To view a report, the report’s status must be Done. 
 

To view a report:

1. Display a list of reports (page 237), if not already open.

2. Right-click the report and select Open.

3. Select a report format.

Only the formats that have been created can be opened, see Select a 
Report Format (page 244).

Related Topics 
Create a Report (page 235)
Delete a Report (page 246)
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Print a Report

To print a report, you must first open it using the appropriate program, for 
example a PDF report format will open in Adobe Reader. To open other report 
formats, you must have the required program installed on your computer.

To print a report:

1. Display a list of reports (page 237), if not already open.

2. In the Reports list, right-click and select Open.

3. Select a report format.

The report opens in the appropriate program.

4. On the toolbar, click Print.

Related Topics 
Display a List of Reports (page 237)
View a Report (page 238)
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Copy a Report

After you create a report in any report format, you can copy it to a folder on 
your computer or to an external drive.

To copy a report:

1. Display a list of reports (page 237), if not already open.

2. In the Reports list, right-click and select Copy.

3. Select the report format.

Only the formats that have been created can be copied, see Select a 
Report Format (page 244).

4. Browse and select a location to copy the report, or create a new folder.

5. Click OK.

Related Topics 
View a Report (page 238)

Print a Report (page 239)
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Specify the Report Parameters

The report parameters that you can select include the date range and the sites 
for the report content. The date range limits the data that appears in the report 
to the time period indicated by the specified start and end date. The available 
sites are listed for you to filter the data content of a report.

If you are using a custom template, the date on which the range is based 
depends on what you selected in the Report Title and Options dialog box. 
For example, if the report type is Exhibits and you selected Date Occurred as 
the date element, exhibits with events that occurred within the specified date 
range will be retrieved and displayed in the report. 

To set the report parameters:

1. Use one of the following procedures to create a report:

• Create a report (page 235) using an existing template.

• Create a custom report template (page 247).

The Report Parameters dialog box (page 392) opens.

2. Specify a start date.

• To use a preset date, click the down arrow in the first start date field 
and select one of the following options:
- Today

- Six months ago

- One year ago
- 01 January (of the current year)

• To enter a specific date, do the following:

- Click the down arrow in the second start date field.
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The Calendar opens. 

- Click the day on the calendar. 

The Calendar closes and the selected date is displayed in the date 
field.

3. Specify an end date by clicking the down arrow in the Select an end date 
field and selecting one of the following options:

• Select your own date

See step 2 for more information. 

• Today
• Six months ago

• One year ago

• 01 January (of the current year)
  

Tip: To limit the report data to a specific date, enter the same 
date in this field as in the Select a start date field. 

 

4. For reports that are based on hits, you can choose to include confirmed, 
unconfirmed, or all hits. Select a Hits Option from the list.

5. For certain reports you can select Show Subtotals Only.

6. From the Available Sites list, select the sites for data content of the 
report.

Click to display 
the previous 
month

Click to display 
the next 
month

Click to display the up and down 
arrows for previous and next yearClick the month to display 

a list of the months



CHAPTER 9  Creating Reports
Specify the Report Parameters

243

7. Click Next.

The Report Format dialog box (page 395) opens.

Related Topics 
View a Report (page 238)

Delete a Report (page 246)
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Select a Report Format

The default format for reports that you create is PDF. You can also create 
reports in HTML, RTF, and Excel formats. After a report is created, you can print 
it, or copy it to another folder on your computer or to an external drive.

When the report status is Done, the report is available in all the formats you 
selected.

To select a report format:

1. In the Report Format dialog box (page 395), select the formats you want 
for the report.

2. Click Finish.

The report is generated. To view the report, see View a Report (page 238).

Related Topics 
View a Report (page 238)
Print a Report (page 239)

Copy a Report (page 240)
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Delete a Report Request

After you select a template and enter a date range, it takes some time to 
generate the report. During this time, the report status is Waiting. If you 
change your mind and do not want to continue with report creation, you can 
select the report and delete it to cancel the report request.

To delete a report request:

1. Display a list of reports (page 237).

2. Right-click the report and select Delete.

A confirmation message opens.

3. Click Yes to delete the report request.

Related Topics 
Delete a Report (page 246)
Delete a Custom Template (page 257)
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Delete a Report

You can delete any report that you have created. If there are other users of the 
same MATCHPOINT+ system, you cannot delete the reports they created.

When you delete a report, all the formats that have been generated for the 
report are deleted at the same time.

To delete a report:

1. From the Navigation tree, click Reports.

The Reports window (page 387) opens.

2. Select the report you want to delete.

3. Right-click and select Delete from the menu, or press DELETE.

A warning message opens, prompting you to confirm if you want to delete 
the report.

4. Click Yes.

The report is deleted.

Related Topics 
Delete a Report Request (page 245)
Delete a Custom Template (page 257)
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Create a Custom Template

You cannot modify any of the standard templates that come with 
MATCHPOINT+. If you are an Expert Acquisition Technician or a Firearm 
Examiner, you can create custom report templates.

A template is a document that defines the content and layout of a report so 
that you do not have to recreate it each time that you want to generate a 
report. It defines elements such as the fields that are included, how they are 
grouped and sorted, and the type of chart.

To create a custom template, you must do the following: 

• Start the New Custom User Report wizard (page 248)
• Select the report data source (page 249)
• Select the report fields (page 250)
• Select the grouping fields (page 251)
• Select the display order (page 252)
• Specify the sort order (page 253)
• Add a chart (page 254)
• Specify page layout options and save the template (page 255)
• Select the report parameters (page 241)
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Start the New Custom Report Wizard
The New Custom Report wizard guides you through the creation of a 
customized report template. After you have created the template, you can save 
it so that you can reuse it to generate additional reports.

  

Note: Some steps are mandatory and others are optional. If a 
step is mandatory, the Next button will remain disabled until you 
have made a selection in the wizard dialog box.

 

To start the wizard:

1. From the File menu, select New > Report or click Reports on the toolbar.

The New Report dialog box (page 390) opens.

2. Enter information in the Comments field. 

This information will appear in the Comments column in the Reports 
window (page 387). This field is mandatory.

3. Click New.

The New Custom Report wizard starts. The Report Data Source dialog box 
(page 397) is displayed.

What’s Next?
Select the report data source (page 249).
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Select the Report Data Source
The data source that you select determines the type of report that is created. 
For each of the report types described in the following table, you can select 
which fields to include, how to group and sort them, the type of chart you 
want to include, and the element upon which the date range is created, such 
as the creation date or the modification date. 

Data Source Description

Confirmed Hits by 
Exhibits

The resulting report is based on confirmed hits according to 
the exhibits to which they belong. The Report Fields dialog 
box contains a list of graphs supported by the report. 

Cases The resulting report is based on cases. It can include 
information such as the event type, case supervisor, date 
created, law agency, and occurrence date. 

Bullet Exhibits The resulting report is based on bullet exhibits. It can include 
information such as the creation date, caliber, composition, 
event type, law agency, and occurrence date. 

Cartridge Case Exhibits The resulting report is based on cartridge case exhibits. It can 
include information such as the creation date, caliber, 
composition, firing pin shape, event type, law agency, and 
occurrence date. 

Firearm Exhibits The resulting report is based on firearm exhibits. It can 
include information such as the barrel length, caliber, event 
type, make, country of origin, officer and possessor 
information, and recovery date. 

Hits for Bullet Exhibits The resulting report is based on hits between bullet exhibits. 
It can include information such as the caliber, twist, number 
of LEAs, and hit creation date. 

Hits for Cartridge Case 
Exhibits

The resulting report is based on hits between cartridge case 
exhibits. It can include information such as the caliber, 
composition, firing pin shape, and hit creation date.

Correlation Requests The resulting report is based on correlation requests. It can 
include information such as the correlation type, creation 
date, event type, and occurrence date. 



250

IBIS MATCHPOINT+ 2.3 
User Guide

To specify the report type:

1. From the Data Source list, select the type of report you want to create.

2. Click Next.

A data source must be selected for the Next button to be enabled.

The Report Fields dialog box (page 399) opens.

Select the Report Fields
You must specify the fields to include in the report. The list of fields that are 
available for inclusion in the report varies depending on the data type you 
selected in the Report Data Source dialog box (page 397).

If you selected Confirmed Hits by Exhibits as the data source, you are 
presented with a list of graphs instead of fields. For example, Caliber type bar 
graph, Evidence pie graph, Questionable hits pie graph, and Cross event (a 
cross-tabulation table).

To select the fields:

1. In the Report Fields dialog box (page 399), add the fields you want to 
include in the report to the Selected fields list.

Cartridge Case and Bullet 
Exhibits

The resulting report is based on cartridge case and bullet 
exhibits. It can include information such as the creation date, 
caliber, composition, firing pin shape, event type, law agency, 
LEA count, twist, and occurrence date. 

Hits for Cartridge Case 
and Bullet Exhibits

The resulting report is based on hits between cartridge case 
and bullet exhibits. It can include information such as the 
caliber, twist, number of LEAs, and hit creation date. 

Users The resulting report is based on information about user 
accounts created for IBIS Heritage or IBIS TRAX-3D users. It 
can include information such as the creation date, full name, 
last logon date, site name, and user lock date.

Data Source Description
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2. Click Next.

At least one field must be in the Selected fields list for the Next button to 
be enabled.

The Grouping dialog box (page 401) opens.

What’s Next?
Specify how you want to group fields in the report (page 251).

Select Grouping Fields
You can use groups to organize the report data into sections. You can use any 
of the selected fields as a grouping field. However, when choosing grouping 
fields, it is recommended that you select general fields such as Month and Law 
Agency. 

You can select up to three grouping fields. The first field you select is placed at 
the top of the hierarchy. If you choose a second and third field, they are treated 
as subgroups within the main group. If, for example, you want to group 
exhibits by caliber within the submitting law agency, you would first select Law 
agency and then Caliber Start. 

To Do the following

Include all available fields in the 
report

Click 

All of the available fields are moved to the 
Selected fields list.

Include specific available 
fields in the report

Select an available field and click 

The field is moved to the Selected fields list.

Remove a field from the 
Selected fields list

Select a field in the Selected fields list and click 

The selected field is moved to the Available 
fields list.

Remove all fields from the 
Selected fields list

Click 

All fields are moved from the Selected fields 
list to the Available fields list.
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You do not have to select any fields for grouping. However, if you do, you must 
leave at least one field in the Available fields list. These fields can be used to 
control the display order or the sorting.

To group report data:

1. In the Grouping dialog box (page 401), specify the first grouping field by 
selecting a field from the Available fields list and clicking .

The field is moved to the Grouping fields list.

2. Select a second and third grouping field, as required.
  

Note: To remove a field from the Grouping fields list, select the 
field and click . If there are any fields below the selected 
field, they are also removed from the list.

 

3. To include a total for each group, select the Add total to each group 
check box.

For example, you can create a report that indicates the caseload for each 
firearm examiner by selecting Case Supervisor as the grouping field and 
selecting this check box.

4. Click Next.

The Display Order dialog box (page 403) opens.

What’s Next?
Specify the order in which fields are displayed (page 252).

Specify the Display Order
The fields you selected appear as column headers in the report. In the Display 
Order dialog box, specify the order in which you want the columns to be 
displayed. 

The first field in the Order list will appear as the first column in the report and 
the last field in the list will appear as the last column in the report. 

This procedure is optional.
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To specify the display order:

1. In the Display Order dialog box (page 403), arrange the fields in the 
Order list to indicate the order in which you want the fields to appear in 
the report. 

2. Click Next.

The Sorting dialog box (page 405) opens.

What’s Next?
Specify the sort order (page 253).

Specify the Sort Order
The sort order determines which fields are used to sort the report data and 
whether the data is sorted in ascending or descending order. 

You can specify up to three sort fields. The Sort 1 field has priority over the 
Sort 2 field. The Sort 2 field has priority over the Sort 3 field. For example, to 
sort the data by law agency and, within law agencies, by case supervisor, you 
would select Law Agency in the Sort 1 field and Case Supervisor in the Sort 2 
field.

You do not have to specify the sort order. This procedure is optional.

To specify the sort order:

1. In the Sorting dialog box (page 405), click the down arrow next to the 
Sort 1 field and select a field from the list. 

2. Specify the sort order for the field.

To Do the following

Move a field up one position in the list Select a field and click 

Move a field down one position in the list Select a field and click 

Click To

Sort the report data in ascending order.

Sort the report data in descending order. 
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3. To sort the report by multiple fields, repeat steps 1 and 2 for the Sort 2 
and Sort 3 fields.

4. Click Next.

The Charts dialog box (page 407) opens.

What’s Next?
Add a chart to the report (page 254).

Add a Chart
Adding a graph to your report can help you visualize and analyze the data. If 
you include a graph in your report, you can choose to display the data in either 
a pie chart or a bar chart. 

You do not have to add a chart. This procedure is optional.

To add a chart to the report:

1. In the Charts dialog box (page 407), select the Add a chart to the report 
check box.

2. Select one of the following graph types:

• Bar Chart
• Pie Chart

3. In the Based on field, click the down arrow and select the field on which 
you want to base the chart.

4. Click Next.

The Report Title and Options dialog box (page 409) opens.

What’s Next?
Specify page layout options and save the template (page 255).
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Specify Report Options and Save the Report Template
In the final wizard dialog box, you specify the information you want displayed 
on the report pages, such as a report title, page numbers, and report date. By 
default, the template will be saved when you click Next. 

To specify report options:

1. In the Report Title field in the Report Title and Options dialog box 
(page 409), enter the title that you want to appear.

2. In the Element to be used as date range field, click the down arrow and 
select an option from the list. 

The available options depend on the type of report you are creating. 

After you finish the wizard, you will be prompted to enter the date range 
for the report. The selection you make in this field determines which date 
this range is based on. 

3. To include page numbers in the headers, select the Show page number 
in header check box.

4. To include the date on which the report is created in the headers, select 
the Show date in header check box.

5. To save the template, do the following:

• Make sure that the Save template as check box is selected.

• Enter the template name in the Save template as text box.
If the name already exists, MATCHPOINT+ prompts you to enter a 
different name.

This name is used as the report name that appears in the Custom 
Templates list in the New Report dialog box (page 390) and must be 
unique.

6. Click Finish.

The Report Parameters dialog box (page 392) opens. 

What’s Next?
Select the report parameters (page 241) for the report.
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Modify a Custom Template

You can modify any of the custom templates that you created. Custom 
templates are displayed in the New Report dialog box.

To modify a custom template:

1. In the Navigation tree, click Reports.

The New Report dialog box (page 390) opens.

2. In the Custom Templates field, select the template that you want to modify 
and then click Modify.

The Custom Report wizard starts. The Report Data Source dialog box 
(page 397) is displayed.

3. Follow the steps of the wizard and modify the field selections, grouping or 
other report parameters, as required. 

4. Specify page layout options and save the template (page 255).

Related Topics 
Create a Report (page 235)
Print a Report (page 239)
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Delete a Custom Template

You can delete only the templates that you have created. You cannot delete 
standard templates. 

To delete a custom template:

1. From the File menu, select New > Report or click Reports on the toolbar.

The New Report dialog box (page 390) opens.

2. Click Custom Templates and then select the template that you want to 
delete from the list.

3. Click Delete.

A confirmation message is displayed. 

4. Click Yes.

The template is deleted.
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Tools and Options Reference

This section covers the following topics: 

Preferences Dialog Box............................................................................. 263
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Date Dialog Box....................................................................................... 267
Group By Dialog Box................................................................................ 269
Quick Search Dialog Box .......................................................................... 271
Preferred Lists Dialog Box......................................................................... 273
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Preferences Dialog Box

This dialog box opens when you select Tools > Preferences from the menu 
bar. Use this dialog box to optimize workflow and set default controls for 
display settings. In the Preferences dialog box, individual preferences are 
grouped by feature. To display the settings for the features in a group, open 
the group. 

Preferences

Column Description

Preferences Outline The preference items grouped by feature. Click the plus 
sign (+) next to the group you want to open.

Current Values The current value for each preference.
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Context Menu and Buttons

How Do I...? 
Set preferences (page 55)

Default Values The default value for each preference for your system.

Force The check box used to force a value for all users of the 
system. This feature is available only to users who have 
the Administrator role.

Right-click and select To

Reset to Default Value Reset the selected preference to the system default 
value. A system value may be set for your facility.

Reset to Factory Value Reset the selected preference to the factory default 
value. The factory value is the generic setting for all 
MATCHPOINT+ installations. This feature is available 
only to users who have the Administrator role.

Reset All to Default Values Reset all the preferences to the system default values. A 
system value may be set for your facility.

Reset All to Factory Values Reset all the preferences to the factory default values. 
The factory value is the generic setting for all 
MATCHPOINT+ installations.

Cancels all changed values and displays the last saved 
settings.

Closes the window. If there are any unsaved changes, a 
confirmation message is displayed.

Saves the changes and displays the update.

Opens the Help topic that describes the dialog box.

Column Description
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Filter Dialog Box

This dialog box opens when you select View > New Filter from the menu bar 
and select a filter type: cases or correlation requests. The list of fields is 
different for each of the filter types.

Use this dialog box to customize the display of cases in the Navigation tree 
and the list view of correlation requests in the Information view. 

Options and Buttons

Options and Buttons Description

Fields Lists the fields that can be used to define a type of filter.

Filter Lists the fields that are defined for a filter. Definitions are 
arranged into AND and OR statements.



266

IBIS MATCHPOINT+ 2.3 
User Guide

How Do I...? 
Work with filters (page 49)

Name The name that you create for the filter. It appears in the 
Filters list to help you manage the filters you create.

Description The description that you enter for the filter. It appears in the 
Filters list to help you manage the filters you create.

Adds the selected field to the filter definition.

Removes the selected field from the filter definition.

Saves the filter definition to the Filters list.

Saves the filter definition and applies it at the same time.

Closes the dialog box without filtering the cases.

Opens the Help topic that describes the dialog box.

Options and Buttons Description
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Date Dialog Box

This dialog box opens when you select a date criterion to define a search or to 
define a filter, for example, Occurrence Date or Creation Date.

To obtain the desired results, make sure that you select the correct option. The 
time of day is a factor when you select Previous or Since, although it does not 
appear in the dialog box.

Options and Buttons

Options and Buttons Description

During the previous To select a period that is relative to the present date and 
time. For example, if it is 10:00 a.m. when you define 
“Previous 2 Months” as the period, the actual period will 
cover from 10:00 a.m. 60 days ago until 10:00 a.m. today.

Since To select a period that includes the entire calendar date to 
the present time. For example, if it is 3:00 p.m. when you 
select yesterday’s date, the period will include all of 
yesterday until 3:00 p.m. today. 

Between ... And To select a period that includes the entire calendar date 
range.

Adds the date criterion to the definition.

Closes the dialog box without defining a date.
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How Do I...? 
Use search (page 46)

Work with filters (page 49)
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Group By Dialog Box

This dialog box opens when you right-click the column header bar in the 
Information view and select Group. 

Options and Buttons

Options and Buttons Description

Group items by Selection of items that can be used for the first group.

Ascending Sorts the items in the group in ascending order.

Descending Sorts the items in the group in descending order.

Show column When selected, shows the column of the grouped items. 
After a group is defined, the column is hidden by default. 

Then by Selection of items that can be used for subsequent groups.

Groups the list according the specified criteria.
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How Do I...? 
Group list information (page 53)

Closes the dialog box without grouping.

Clears all the groups that are defined.

Opens the Help topic that describes the dialog box.

Options and Buttons Description
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Quick Search Dialog Box

This dialog box opens when you select Tools > Quick Search from the menu 
bar or type an entry on the keyboard when the Navigation tree displays a list.

Options and Buttons

Options and Buttons Description

Find what The text that you want to find; a single character or words.

Advanced mode Enables extended search options.

Match case Restricts the search to match the case that is used in the Find 
what field.

Match whole word Restricts the search to match the whole word that is entered 
in the Find what field.

Using column Lists the columns that can be searched according to the 
displayed list. By default, the search is performed on the 
contents of the sorted column. Use this option to search a 
column that is different than the one used to sort the list.
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How Do I...? 
Use quick search (page 57)

Searches for the next occurrence without looping.

Searches for the previous occurrence without looping.

Options and Buttons Description
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Preferred Lists Dialog Box

This dialog box opens when you select Tools > Preferred Lists from the menu 
bar.

Options and Buttons

Options and Buttons Description

List Name Selection of lists for which preferred items can be defined.

Items Items that are hidden (collapsed at the end of the list) when 
the list appears in the application. Hidden items can always 
be expanded and used, as required.

Preferred Items Items that are displayed when the list appears in the 
application, for example, preferred calibers for firearm 
exhibits. 

Moves the selected item(s) from the Hidden Items list to the 
Preferred Items list.

Moves the selected item(s) from the Preferred Items list to 
the Hidden Items list.



274

IBIS MATCHPOINT+ 2.3 
User Guide

How Do I...? 
Define preferred lists (page 58)

Closes the dialog box without modifying the list.

Saves the preferred list displayed in the List Name field.

Opens the Help topic for the dialog box.

Options and Buttons Description
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Correlations Reference

This section covers the following topics: 

Correlation Request Dialog Box ................................................................ 277
Correlation Sites Dialog Box ..................................................................... 281
Correlation Sites Options Dialog Box ........................................................ 283
Correlations Window ............................................................................... 285
Correlation Request Information Dialog Box ............................................. 291
Correlation Results Filtering Window........................................................ 294
Print Correlation Results Dialog Box ......................................................... 297
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Correlation Request Dialog Box

This dialog box opens when you create a manual correlation request for a 
cartridge case or bullet exhibit. In it you can define a set of filter criteria that 
will be used to select test exhibits, put constraints on the manual request, and 
filter the results.

Cartridge Cases
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Fields and Buttons

Field Description

Request Filter

Event Type When selected, the event type that is selected in the list 
is used as a filter criteria. Assault with a Deadly Weapon, 
Homicide, Other, and Unknown are all treated the same 
in the event type called Crime. 

Occurrence Range

Occurrence Range When selected, the specified occurrence date range is 
used as a filter criteria.

Start Specifies the start of the date range.

End Specifies the end of the date range.

The Start and End fields can be set to the same date.

Bullets
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Caliber Range

Caliber Range When selected, the specified caliber range is used as a 
filter criteria. 

Start Family Specifies the start of the caliber family range. This is a 
read-only field that depends on the selection made in 
the Start Caliber field.

Correlation requests are based on the caliber families, 
not the calibers themselves.

Start Caliber Specifies the start of the caliber range, which is the 
smallest caliber that will be considered in the 
correlation.

End Family Specifies the end of the caliber family range. This is a 
read-only field that depends on the selection made in 
the End Caliber field.

End Caliber Specifies the end of the caliber range, which is the 
largest caliber that will be considered in the correlation.

The Start and End fields can be set to the same caliber 
if you want to find exhibits of a specific caliber.

Firing Pin Shape When selected, the firing pin shape of the reference 
exhibit is used as a filter criteria. This field is applicable 
to cartridge case exhibits only. 

Twist When selected, the twist of the LEAs on the reference 
exhibit is used as a filter criteria. This field is applicable 
to bullet exhibits only. 

LEA Count When selected, the number of LEAs on the reference 
exhibit is used as a filter criteria. This field is applicable 
to bullet exhibits only. 

Request Constraints

Include Exhibits from the 
Reference Case

When selected, the selected reference exhibit is also 
correlated against the other exhibits that belong to the 
reference case.

When cleared, the other exhibits in the reference case 
are not included in the correlation.

Field Description
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How Do I...? 
Create a manual correlation request (page 110)

Correlation Sites Selection When selected, you can specify the sites to include in the 
correlation. A dialog box that lists the available 
Correlation Sites opens when you click Generate.

When cleared, the same correlation sites that are used 
for an automatic correlation are used. 

Returned Results Filter

Percent of Best Score 
Results

When set to less than 100 percent, MATCHPOINT+ 
returns only a portion of the found results (with the 
highest scores), as determined by the specified 
percentage.

Minimum Number of 
Returned Results

Specifies the minimum number of exhibits that will be 
returned as results.

Note: The greater number of results is always returned. 
For example, in a database of 1000 records, if you 
specify 5 percent and a minimum of 10, MATCHPOINT+ 
displays 50 results (0.05 x 1000 = 50).

Generates the correlation request using the specified 
criteria.

Cancels the request and closes the dialog box.

Opens the Help topic that describes the dialog box.

Field Description
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Correlation Sites Dialog Box

If the Correlation Sites Selection check box is selected on the Correlation 
Request dialog box (page 277), the Correlation Sites dialog box 
automatically opens after you click Generate to submit a manual correlation 
request. Use this dialog box to select the correlation sites that you want to 
include in the correlation. 

Options and Buttons

Options Description

Correlation Sites The hierarchy of correlation sites is configured for your 
system and can include National, State and Regional 
levels within which there may be multiple Correlation 
Servers, Data Concentrators and acquisition sites.

Performs the manual correlation against the selected 
sites.

Closes the dialog box.
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How Do I...? 
Create a manual correlation request (page 110)

Opens the Correlation Sites Options Dialog Box 
(page 283).

Opens the Help topic that describes the dialog box.

Options Description
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Correlation Sites Options Dialog Box

This dialog box opens when you click Options on the Correlation Sites dialog 
box (page 281). Use this dialog box to change the display of the site name and 
if Data Concentrators should be included.

Fields and Buttons

Field/Button Description

Short Name The short name for the site.

Long Name The long name for the site.

Both The short and long name together. 

Show Data Concentrators Controls if the Data Concentrators are included in the 
display.

Save these settings as my 
preferences

Saves the settings as your preferences. For more 
information, see Setting Your Preferences (page 55).

Applies the display setting and closes the dialog box.
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Create a manual correlation request (page 110)

Closes the dialog box.

Opens the Help topic that describes the dialog box.

Field/Button Description
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Correlations Window

The Correlations window has two views. The Correlation Requests view, on 
top, displays all correlation requests available from the Correlation Server. The 
Correlation Results view displays the correlation results for the selected 
correlation request. From this window, you can determine which test exhibits 
are most similar to a particular reference exhibit by examining correlation 
scores. You can also open the MultiViewer or Side-by-Side Viewer, to 
compare images for similarity.

  

Note: Only users with Expert Acquisition Technician or Firearm 
Examiner permissions can open this window. 
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Active Toolbar Buttons

Button Name Description

Delete Deletes the selected correlation request.

Print Opens the Print dialog box.

Refresh 
Information

Refreshes the displayed information by reloading 
data from the database.

Side-by-Side Opens the Cartridge Case Side-by-Side Viewer 
(page 347) or the Bullet Side-by-Side Viewer 
(page 355) and displays the selected reference and 
test exhibits.

MultiViewer Opens the Cartridge Case MultiViewer (page 331) or 
the Bullet MultiViewer (page 339) and displays the 
selected reference and test exhibits.

Viewed Sets the status to Previously Viewed to indicate that a 
Firearm Examiner has analyzed the correlation 
results. This button is enabled only if the selected 
correlation request has a status of Done.

Your system may be configured to automatically 
delete correlations with a status of Viewed after a 
certain number of days. 

Not Viewed Sets the status of a previously viewed correlation to 
Correlation Done.

New Report Opens the New Report dialog box (page 390).

Help Opens IBIS MATCHPOINT+ Help.
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Correlation Requests view

Correlation Results view

Column Description

Case Number The case number of the reference exhibit.

Exhibit Number The number that is assigned to the reference exhibit.

Caliber The caliber of the reference exhibit.

Site Name The name of the site that acquired the reference exhibit.

Type The type of correlation submitted: Automatic, Manual, 
Prior Test Fire, National or Eurobis.

Correlation Server The Correlation Server that performed the correlation.

Status The status of the correlation request. For more 
information, see Correlation Status (page 75).

Created By The user who created the correlation request.

Creation The date on which the correlation request was 
submitted.

Modified By The user who made the last modification.

Modification The date on which the correlation request was last 
modified.

Total Sample Size The number of exhibits that were used in the correlation.

Column Description

Case Number The number of the case containing the test exhibit.

Exhibit Number The number that is assigned to the test exhibit.

Caliber The caliber of the test exhibit.

Site Name The name of the site that acquired the test exhibit.

Cartridge Case Score Columns

Breech Face The breech face score.

Firing Pin The firing pin score.
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Context Menu
The following menu items appear when you right-click the mouse with a 
correlation request or result selected.

Ejector Mark The ejector mark score.

Firearm Columns

Make The make of the firearm linked to the test exhibit.

Model The model of the firearm linked to the test exhibit.

Bullet 2D Score Columns

Max LEA The highest LEA score, calculated using 2D data, within all of the 
individual LEA scores for a bullet correlation.

Peak Phase The highest LEA score within the phase that produced the Max 
Phase score.

Max Phase The highest phase score within a bullet correlation, calculated using 
acquired 2D data.

Bullet 3D Score Columns

Max LEA The highest LEA score, calculated using 3D data, within all of the 
individual LEA scores for a bullet correlation.

Max Phase The highest phase score within a bullet correlation, calculated using 
acquired 3D data.

Menu Item Description

These items appear when a correlation request is selected:

Side-by-Side Viewer Opens the Cartridge Case Side-by-Side Viewer 
(page 347) or the Bullet Side-by-Side Viewer (page 355), 
which displays the first test exhibits listed in the 
Correlation Results view.

Column Description
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How Do I...? 
Create a manual correlation request (page 110)

View correlation requests and results (page 113)

MultiViewer Opens the Cartridge Case MultiViewer (page 331) or the 
Bullet MultiViewer (page 339), which displays all the 
test exhibits that are listed in the Correlation Results 
view.

Correlation Results Filtering Opens Correlation Results Filtering (page 119).

Status Allows you to change the status of the selected 
correlation request from Not Viewed to Viewed, or vice 
versa.

See Change the Status of Correlation Requests 
(page 124).

Delete Deletes the selected correlation request.

Correlation Request 
Information

Opens the Correlation Request Information dialog box 
(page 291).

Reference Exhibit 
Information

Opens the Reference Exhibit information window. 

Print Correlation Results Opens the Print Correlation Results Dialog Box 
(page 297).

This item appears when a correlation result is selected:

Compare Exhibits Opens the Cartridge Case Side-by-Side Viewer 
(page 347) or the Bullet Side-by-Side Viewer (page 355), 
which displays the reference exhibit that is selected in 
the Correlation Requests view and the test exhibit 
that is selected in Correlation Results view.

Import Exhibit Imports the selected exhibit into the local site. Available 
only if the selected exhibit exists on a remote site.

Reimport Exhibit Reimports the selected exhibit to ensure that the 
imported information is up-to-date. Available only if the 
selected exhibit was imported.

Test Exhibit Information Opens the Test Exhibit information window. 

Menu Item Description
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Change the status of correlation requests (page 124)

Delete correlation requests (page 125)
Open the MultiViewer (page 132)

Analyze bullet exhibits (page 158)

Analyze cartridge case exhibits (page 160)
Open the Side-by-Side Viewer (page 163)
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Correlation Request Information Dialog Box

This dialog box opens when you select a cartridge case or bullet reference 
exhibit from the Correlations window (page 285) and select Correlation 
Request Information from the right-click menu.

Fields and Buttons

Field/Button Description

Request Specific Information

Site Name The unique name that is assigned to the site that 
originated the request.

Type The type of correlation request: Automatic or Manual.

Creation The date on which the correlation request was created.

Created By The user who created the correlation request.

Modification The date on which the correlation request was last 
modified.

Modified By The user who modified the correlation request.

Status The status of the correlation request.
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Minimum Number of 
Returned Results

The minimum number of results the correlation request 
was configured to return.

Percent of Best Score 
Results

The percentage of found best score results that the 
correlation request was configured to return.

Total Sample Size The number of exhibits that were used in the correlation.

Remote Site Name The site name of the remote Correlation Server against 
which exhibits were correlated, if applicable.

Include Exhibits from the 
Reference Case

Indicates if exhibits belonging to the reference case were 
used in the correlation.

Request Filter Information

Caliber Family Start The start of the caliber range that was specified in the 
request filter.

Caliber Family End The end of the caliber range that was specified in the 
request filter.

Occurrence Start The start of the occurrence date range that was specified 
in the request filter.

Occurrence End The end of the occurrence date range that was specified 
in the request filter.

Event Type The event type that was specified in the request filter.

Firing Pin Shape The firing pin shape that was specified in the request 
filter. This field is applicable to cartridge case exhibits 
only.

LEA Count The LEA count that was specified in the request filter. 
This field is applicable to bullet exhibits only.

Twist The direction of twist that was specified in the request 
filter. This field is applicable to bullet exhibits only.

Reference Exhibit Information

Case Number The number of the case to which the reference exhibit 
belongs.

Occurrence The date on which the incident occurred.

Field/Button Description
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How Do I...? 
View correlation request details (page 126)

Site Name The site name of the Correlation Server on which the 
reference exhibit is located.

Exhibit Number The reference exhibit number.

Event Type The type of event, such as HOM or AWD.

LEA Count The number of LEAs on the reference exhibit. This field is 
applicable to bullet exhibits only.

Opens the detailed exhibit information.

Closes the dialog box.

Prints the request information.

Field/Button Description
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Correlation Results Filtering Window

The Correlation Results Filtering window opens when you right-click a 
correlation result and select Correlation Results Filtering from the menu.

The correlation scores are charted at the top of the window and listed in a data 
table below. The Chart Options and List Options control how the scores are 
displayed and listed. 

Chart Options

Toolbar

List Options

Chart Options

Option Description

Chart Type The type of chart, either bar or line.

Number of Exhibits to Show The number of exhibits to show in the chart. If you enter 
a number that is larger than the number of exhibits, the 
field turns red.

Show Vertical Lines When selected, shows the vertical lines in the chart 
background.

Show Horizontal Lines When selected, shows the horizontal lines in the chart 
background.
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List Options

Toolbar Buttons

Show Second Y Axis When selected, shows the second Y axis on the right 
side.

Use Line Styles For Line Charts. When selected, shows the lines with 
dashed line styles.

Option Description

Show Normalized Scores When selected, shows the scores based on a scale of 
100. When cleared, shows the actual scores.

Show Ranks When selected, shows the relative ranking position of 
each score in a separate column. When cleared, the 
Rank column does not display.

Selects all the exhibit ID check boxes in the list.

Clears all the exhibit ID check boxes in the list.

Button Name Description

Reset Resets all values to the default settings.

Print Opens the Print dialog box. Print options can be 
configured by clicking the down arrow.

Side-by-Side Opens the Cartridge Case Side-by-Side Viewer 
(page 347) or the Bullet Side-by-Side Viewer 
(page 355) and displays the selected exhibits.

MultiViewer Opens the Cartridge Case MultiViewer (page 331) or 
the Bullet MultiViewer (page 339) and displays the 
selected exhibits.

Option Description
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How Do I...? 
View correlation request details (page 126)

Save Settings Saves the settings as your preferences. For more 
information, see Set preferences (page 55).

Help Opens IBIS MATCHPOINT+ Help.

Button Name Description
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Print Correlation Results Dialog Box

This dialog box opens when you select a correlation request from the 
Correlations window (page 285), right-click and select Print Correlation 
Requests from the menu.

Options and Buttons

Field/Button Description

All Results The print format that includes all the results.

Top 10 Results The print format that includes only the top 10 results.

Up to Selection The print format that includes the results according to 
the selected result in the Correlation Results view. A 
result must be selected to activate this option.

Include Firearms The print format that includes available firearm 
information from test exhibits in the correlation results.

Save these settings as my 
preferences

Saves the print settings.
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How Do I...? 
Print correlation results (page 122)

Prints the correlation results.

Closes the dialog box.

Field/Button Description
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Case Management Reference

This section covers the following topics: 

Test Exhibits Filtering Dialog Box .............................................................. 301
Image Information View........................................................................... 304
Detailed Image Information Dialog Box .................................................... 308
Import Exhibits Dialog Box ....................................................................... 311
Modify Cartridge Case Exhibit Dialog Box................................................. 313
Breech Face Class Characteristics Dialog Box ............................................ 315
Modify Bullet Exhibit Dialog Box............................................................... 317
Modify Firearm Exhibit Dialog Box ............................................................ 320
Firearm Exhibit Details Dialog Box ............................................................ 322
Modify Case Dialog Box ........................................................................... 324
Data Export Dialog Box ............................................................................ 326
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Test Exhibits Filtering Dialog Box

This dialog box opens when there are no test exhibits in the Viewer Exhibits 
and you set a cartridge case or bullet exhibit from the Navigation tree as the 
reference and then click MultiViewer or Side-by-Side Viewer on the toolbar. 
In this dialog box, you define the criteria that are used to select the test 
exhibits for display in the MultiViewer or the Side-by-Side Viewer.

The following example shows the filtering criteria for Cartridge Case exhibits to 
display in the MultiViewer. 
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Fields

Field Description

Event Type When selected, the event type that is selected in the list 
is used as a filter criteria. Assault with a Deadly Weapon, 
Homicide, Other, and Unknown are all treated the same 
in the event type called Crime.

Occurrence Range When selected, the specified date range is used as a 
filter criteria.

Start Specifies the start of the date range.

End Specifies the end of the date range.

The Start and End fields can be set to the same date.

Caliber Range When selected, the specified caliber range is used as a 
filter criteria. 

Start Family Indicates the caliber family to which the selected start 
caliber belongs.

Start Caliber Specifies the start of the caliber range, which is the 
smallest caliber that will be considered in the correlation.

End Family Indicates the caliber family to which the selected end 
caliber belongs.

End Caliber Specifies the end of the caliber range, which is the 
largest caliber that will be considered in the correlation.

The Start and End fields can be set to the same caliber 
if you want to find exhibits of a specific caliber.

Firing Pin Shape When selected, the firing pin shape of the reference 
exhibit is used as a filter criteria. This field is applicable 
to cartridge case exhibits only.

Twist When selected, the twist of the LEAs on the reference 
exhibit is used as a filter criteria. This field is applicable 
to bullet exhibits only.

LEA Count When selected, the number of LEAs on the reference 
exhibit is used as a filter criteria. This field is applicable 
to bullet exhibits only.
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How Do I...? 
Open the MultiViewer (page 132)
Open the Side-by-Side Viewer (page 163)

Opens the MultiViewer to display the filtered test 
exhibits. If you selected Side-by-Side Viewer from the 
toolbar, the button name will be Side-by-Side.

Cancels the filter operation and closes the dialog box.

Opens the Help topic that describes the dialog box.

Field Description
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Image Information View

This window opens when you select a LEA, GEA, or cartridge case ROI from 
the Navigation tree. Use it to view an acquired image without opening the 
MultiViewer or Side-by-Side Viewer. 

You can change the magnification level, adjust the brightness and contrast, 
and move all image types. For 3D images, you can also adjust the lighting, 3D 
elevation, and 2D/3D rendering. You can view text annotations, if any have 
been added to the image.
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Image Information Fields and Buttons

Buttons

Field Description

Image Type The type of image: LEA or GEA and 2D or 3D for bullets. 
For cartridge cases, examples are Breech Face - Ring, Full 
Headstamp - Ring, and Ejector 6 o’clock.

Light Intensity The light intensity setting. This field is available when 
viewing cartridge case images only.

Breech Face Class 
Characteristics

The class characteristics of the markings on the breech 
face, if known. This field is available when viewing 
cartridge case images only.

Creation The date on which the image was acquired.

Modification The last date on which the image was modified.

Opens the Detailed Image Information dialog box 
(page 308).

Button Name Description

Reset Resets all the control settings to their 
default values.

Print Opens the Print dialog box. 

Zoom Out Decreases the magnification of the 
displayed image.

Zoom In Increases the magnification of the 
displayed image.
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Image Controls

Control Description

Brightness control Adjusts the brightness of the displayed image. 

The range is between 0 and 100. The default is 50. As the 
value approaches 0, the images get darker. As the value 
approaches 100, the images get brighter. 

Contrast control Adjusts the contrast of the displayed image.

The range is between 0 and 100. The default is 50. As the 
value approaches 0, the contrast is reduced. As the value 
approaches 100, the contrast is increased. 

2D/3D Rendering Adjusts the 2D/3D rendering of the displayed 3D image. 

The range is from 0, which renders the image as completely 
2D, to 100, which renders the image with the maximum level 
of 3D. This control produces a proportionate mix of 2D and 
3D within that range.

3D Elevation Adjusts the height of the peaks on the displayed 3D image. 

The range is between 0 and 100. As the value approaches 0, 
the peak size is reduced. As the value approaches 100, the 
peak size is increased. 

Lighting control Changes the type of light and adjusts the direction of the 
side light. This control is enabled for 3D images only.

Clicking the center of the inner circle switches to the center 
light. Clicking the outer circle switches to the side light. 
Dragging the “light beam” on the outer circle changes the 
direction of the side light. For more information, see Lighting 
Control (page 363).
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Cursor Modes

How Do I...? 
View an image (page 96)

Mode Description

Moves the image. This is the default mode.

Rotates the image. You must right-click the mouse to switch 
to Rotate mode. Available when viewing cartridge case 
images only.
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Detailed Image Information Dialog Box

This dialog box opens when you select a cartridge case or bullet ROI image 
from the Navigation tree and click Info. Use this dialog box to view more 
detailed information about a particular image.

Detailed Image Information Fields

Field/Button Description

Description

ROI Type The region of interest captured by the image. For example, 
Breech Face, Ejector, and Full Headstamp.

Image Type The type of light that was used to acquire the image. For 
example, ring, 6 o’clock, and 3 o’clock.

Acquisition Unit

Unit ID The hardware-specific ID of the acquisition unit.

Cartridge Cases Bullets
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Dimensions

Width The width of the image in pixels.

Height The height of the image in pixels.

Lights (Cartridge Cases only)

Ring The light intensity setting of the ring light that is used to 
acquire the image. Applicable to certain ROIs only.

3 o’clock The light intensity setting of the 3 o’clock light that is used to 
acquire the image. Applicable to certain ROIs only.

6 o’clock The light intensity setting of the 6 o’clock light that is used to 
acquire the image. Applicable to certain ROIs only.

All-In-Focus The light intensity setting of the ring light that is used to 
acquire the image. Applicable to primer all-in-focus images 
only.

3D DFF The light intensity setting of the ring light that is used to 
acquire the image. Applicable to primer 3D DFF images only.

Outline (Cartridge Cases only)

Type The type of outline. This field is set to either Circle or 
Polygon.

Count The number of geometric forms in the outline. If the Type 
field is set to Circle, this field displays the number of circles. 
If the Type field is set to Polygon, this field displays the 
number of points in the outline.

List Displays the X and Y coordinates and the radius of the inner 
and outer rings.

Opens the Help topic that describes the dialog box.

Closes the dialog box.

Field/Button Description
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How Do I...? 
View detailed image information (page 102)
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Import Exhibits Dialog Box

This dialog box opens when you click Import on the Viewer toolbar. The 
import button is only available if there are exhibits in the selection that are 
stored on remote sites.

After an exhibit is imported it is displayed in the Navigation tree (page 34) in 
an imported case folder under the site name to which it belongs.

Fields and Buttons

Option Description

All The option to import all the remaining remote exhibits. The 
number that will be imported out of the total number of 
exhibits in the list is displayed.

Highest Scores The option to import exhibits based on the highest scores. 
You can enter a number to limit the exhibits that will be 
imported.

Imports the exhibits you selected.

Closes the dialog box.

Opens the Help topic that describes the dialog box.
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How Do I...? 
Import exhibits from remote sites (page 136) in the MultiViewer

Import exhibits from remote sites (page 166) in the Side-by-Side Viewer
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Modify Cartridge Case Exhibit Dialog Box

This dialog box opens when you select a cartridge case exhibit from a migrated 
site in the Navigation tree and then select Edit > Modify from the menu bar. 
Use this dialog box to edit a migrated cartrdige case exhibit.

Modify Cartridge Case Fields

Field Description

Exhibit Number A unique user-defined code that is assigned to the exhibit in 
the database.

Caliber The caliber of the firearm exhibit.

Make The ammunition manufacturer.

Firing Pin Shape The shape of the exhibit’s firing pin impression.

Note: If existing acquisitions are associated with the exhibit, 
you cannot change a centerfire firing pin shape to rimfire 
(rectangular or circular). You also cannot change rimfire 
(rectangular or circular) to any other firing pin shape.
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How Do I...? 
Modify or Delete Migrated Data (page 103)

Breech Face Class 
Characteristics

The class characteristics of the markings on the breech face, 
if known.

Event Type The event to which the cartridge case is related, if different 
from the case. For example, Assault with a Deadly Weapon, 
Homicide, Test Fire or Unknown.

Note: Demonstration, Test, and QA exhibits generally 
contain sample information. Therefore, to avoid confusion, 
the Event Type field of exhibits initially labeled as 
Demonstration, Test, and QA cannot be modified.

Firearm Exhibit Number The exhibit number of the firearm from which the cartridge 
was fired.

Note: This field is applicable only if the cartridge was test 
fired from a firearm exhibit in the same case.

Comments Additional relevant comments concerning the cartridge case.

Opens the dialog box to modify breech face class 
characteristics.

Saves the changes you have made to the exhibit information 
and closes the dialog box.

Closes the dialog box without saving the changes you have 
made.

Opens the Help topic that describes the dialog box.

Field Description
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Breech Face Class Characteristics Dialog Box

The class characteristics that best describe the markings present on the breech 
face are part of the exhibit information. You can describe the marks on the 
exhibit using a process of elimination, or identification. An exhibit can have 
more than one breech face class characteristic.

This dialog box is available when you modify a cartridge case exhibit from a 
migrated site in the Navigation tree. 

Use this dialog box to better describe the marks that are present on an exhibit. 
The default selection is Unknown. 

Breech Face Class Characteristics Fields

Check Box Description

Unknown Indicates that the class characteristics are unknown. This is 
different than selecting all the class characteristics.

Parallel Indicates that parallel marks are present. 

Arch Indicates that arched marks are present.

Crosshatch Indicates that crosshatch marks are present.

Circular Indicates that circular marks are present.

Granular Indicates that granular marks are present.

Smooth Indicates that smooth marks are present.
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Modify or Delete Migrated Data (page 103)

Saves the changes you have made to the exhibit information 
and closes the dialog box.

Closes the dialog box without saving the changes you have 
made.

Opens the Help topic that describes the dialog box.

Check Box Description
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Modify Bullet Exhibit Dialog Box

This dialog box opens when you select a bullet exhibit from a migrated site in 
the Navigation tree and then select Edit > Modify from the menu bar. Use 
this dialog box to edit a migrated bullet exhibit.

Modify Bullet Fields

Field Description

Exhibit Number A unique user-defined code that is assigned to the exhibit in 
the database.

Start Caliber The start of the bullet caliber range.

If the caliber is known, specify the same value for both the 
Start and End fields.

If the specific caliber is not known, use the Start and End 
fields to specify the caliber range within which the bullet is 
believed to belong.

End Caliber The end of the bullet caliber range.

LEA The number of land engraved areas (LEAs) on the bullet.

This value is very important because two exhibits will be 
correlated against each other only if they have the same 
number of LEAs.
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Twist The direction in which the striae twist. The options are Left, 
Right, and Unknown.

Rifling Type The rifling method used on the barrel through which the 
bullet was fired. Except for Unknown, the exhibit will 
automatically correlate only against exhibits of the same 
rifling type. The options are:

• Unknown - Exhibits with Unknown rifling types are 
included in all automatic correlations, unless they are 
excluded by other criteria.

• Cut or Button - Both cut and button rifling types are 
characterized by lands and grooves, which result in LEAs and 
GEAs with distinct transitions on bullets that are fired through 
these types of rifled barrels. 

• Enhanced Polygonal - Glock’s Enhanced Bullet 
Identification System (EBIS), which adds unique marks to their 
polygonal rifling in order to try to make bullets fired from 
Glock firearms more easily identifiable. 

• Polygonal - Instead of lands and grooves, the shape of the 
interior of a barrel resembles that of a polygon. 

• Smooth Bore - Refers to smooth barrels, such as those of 
shotguns.

Composition The materials that make up the bullet’s physical structure. 

Event Type The event to which the bullet is related, if different from the 
case. For example, Assault with a Deadly Weapon, Homicide, 
Test Fire or Unknown.

Note: Demonstration, Test, and QA exhibits generally 
contain sample information. Therefore, to avoid confusion, 
the Event Type field of exhibits initially labelled as 
Demonstration, Test, and QA cannot be modified.

Firearm Exhibit Number The exhibit number of the firearm from which the bullet was 
fired.

Note: This field is applicable only if the bullet was test fired 
from a firearm exhibit in the same case.

Comments Additional relevant comments concerning the bullet.

Field Description
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How Do I...? 
Modify or Delete Migrated Data (page 103)

Saves the changes you have made to the exhibit information 
and closes the dialog box.

Closes the dialog box without saving the changes you have 
made.

Opens the Help topic that describes the dialog box.

Field Description
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Modify Firearm Exhibit Dialog Box

This dialog box opens when a firearm exhibit from a migrated site is 
highlighted in the Navigation tree and you select Edit > Modify from the 
menu bar. Use this dialog box to edit a migrated firearm exhibit.

Modify Firearm Exhibit Fields

Field Description

Exhibit Number A unique user-defined code that is assigned to the exhibit in 
the database.

Caliber The caliber of the firearm exhibit.

Make The firearm manufacturer.

Serial Number The serial number of the firearm.

Country of Origin The country in which the firearm was manufactured.

Model The model of the firearm. If the model is not in the list, you 
can type it in the field.

Type The type of firearm. 

Comments Additional relevant comments concerning the firearm.
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How Do I...? 
Modify or Delete Migrated Data (page 103)

Importer

Name If the firearm was manufactured in a foreign country, the 
name of the company that imported it.

State The state in which the importer operates.

Saves the changes you have made to the exhibit information 
and closes the dialog box.

Closes the dialog box without saving the changes you have 
made.

Opens the Help topic that describes the dialog box.

Opens the Firearm Exhibit Details dialog box (page 322) in 
which you can enter additional information about the 
firearm.

Field Description
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Firearm Exhibit Details Dialog Box

This dialog box opens when you click Details in the Modify Firearm Exhibit 
dialog box (page 320). Use this dialog box to add more detailed information 
about a firearm exhibit from a migrated site.

Firearm Exhibit Details Fields

Field Description

Registration Date The date on which the firearm was registered, if available.

Crime The type of incident the firearm was involved in.

Physical Characteristics

Barrel Length The length (between 0 - 99 inches) of the firearm barrel.

Ammunition Capacity The ammunition capacity (between 0 - 9999) based on a 
standard magazine.

Finish The color or type of finish of the firearm.

Recovery 

Date The date on which the firearm was recovered.
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How Do I...? 
Modify or Delete Migrated Data (page 103)

City The city in which the firearm was recovered.

State The state in which the firearm was recovered.

Possessor Name

Last The last name of the person in possession of the firearm at 
the time of the incident.

First The first name of the person in possession of the firearm at 
the time of the incident.

Middle The middle name of the person in possession of the 
firearm at the time of the incident.

Officer Name

Last The last name of the officer who recovered the firearm.

First The first name of the officer who recovered the firearm.

Closes the dialog box.

Opens the Help topic that describes the dialog box.

Field Description
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Modify Case Dialog Box

This dialog box opens when you select a case from a migrated site in the 
Navigation tree and then select Edit > Modify from the menu bar. Use this 
dialog box to edit a migrated case. 

Modify Case Fields

Field Description

Case Number A unique user-defined code that is assigned to the case in 
the database.

Event Type The event to which the case is related. For example, Assault 
with a Deadly Weapon, Homicide, Test Fire or Unknown.

Note: Exhibits assigned the Event Type Demonstration, Test 
and QA generally contain sample information. Therefore, to 
avoid confusion, the Event Type field of exhibits initially 
labeled as Demonstration, Test, and QA cannot be modified.

Law Agency Name The name of the law agency that is submitting the case.

High Profile check box When selected, indicates that the case is high profile and 
enables the High Profile text box.

High Profile text box The reason for the high profile status.
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How Do I...? 
Modify or Delete Migrated Data (page 103)

Restricted Status When selected, indicates that the case and its exhibits 
cannot be replicated outside your country.

Occurrence Date The date on which the event occurred.

Case Supervisor The name of the supervisor in charge of the case.

Law Agency Case 
Reference Number

The reference number that was assigned to the case by the 
law agency.

Comments Additional relevant comments concerning the case.

Saves the changes you have made to the exhibit information 
and closes the dialog box.

Closes the dialog box without saving the changes you have 
made.

Opens the Help topic that describes the dialog box.

Field Description
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Data Export Dialog Box

This dialog box opens when you select Tools > Data Export from the menu 
bar. The feature is used to export data from one or more sites in your 
configuration.
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Fields and Buttons

Option Description

New Data Export Tab

Sites The local sites in your configuration.

Date Filter The type of date, associated with the case, that is used for 
the date range, for example, the date that the case was 
created, modified, or when it occurred.

Start Date The start date, based on the type of date in the date filter.

End Date The end date, based on the type of date in the date filter.

Image Export The option to include all the images, the image information 
only, or nothing about the images.

File Type The file type for the exported images if the images are 
included in the export.

Name The file name for the generated export file. File names are 
unique because the complete date and time of the export 
are automatically added to the end of the file name.

Data Export Path The default path for exported site data is C:\IBISDataExport.

Exported files are saved to a configured computer in a folder 
named after the file name. The data from every site that is 
exported is saved in a separate folder, and a subfolder is 
created for images, if they are included.

Selects all the sites in the list. 

Clears all the selected sites.

Starts creating the export file. The progress of the file export 
can be viewed on the Pending Data Export tab.

Opens the Help topic that describes the dialog box.

Pending Data Export Tab
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How Do I...? 
Export site data (page 104)

Export Name The file name given to the data export file when it was 
created.

Requested By The user who created the data export.

Status The status of the pending data export.

Cancels the pending data export that is selected. 

Opens the Help topic that describes the dialog box.

Option Description
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MultiViewer Reference

This section covers the following topics: 

Cartridge Case MultiViewer...................................................................... 331
Breech Face Class Characteristics Filter Dialog Box.................................... 337
Bullet MultiViewer ................................................................................... 339
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Cartridge Case MultiViewer 

The Cartridge Case MultiViewer has two panes in which exhibit images are 
displayed.

• The first pane (on the left) displays the reference exhibit and its acquired 
images. 

• The second pane displays the test exhibits and their acquired images.

Reference exhibit Sort by order Test exhibits

Image
group

A red X indicates that the 
exhibit is of low interestExhibit information
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Image Groups
A cartridge case exhibit can have up to seven different images, representing 
the different regions of interest (ROIs) that are associated with it. In the full 
view version of the MultiViewer, the images associated with an exhibit are 
arranged vertically into an image group. Images are arranged by region of 
interest as follows: 

“Not available” indicates that there is no image for that region of interest. 

Toolbar Buttons and Fields

Image Position Image Type

First Breech face - ring light

Second Breech face - 6 o’clock side light

Third Firing pin - ring light

Fourth Ejector mark - 6 o’clock side light

Fifth Ejector mark - 3 o’clock side light

Sixth Primer 3D DFF

Seventh Full headstamp - ring light

Button/Field Name Description

Display Guides Turns the display information on and off.

When selected, the options set using the 
down arrow are displayed on the image. 

Marked Exhibits Hides/shows all marked images.

All Test Exhibits 
Images

Displays all cartridge case image types.

Disabled if all cartridge case image types 
are already displayed.
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Set Position Displays images at their acquisition position 
or their best match position, based on 
rotation.

Best match position is enabled only if 
exhibits were selected from the 
Correlation Requests view. 

Sort By The selected option determines how images 
are sorted in the MultiViewer. The 
options in the list are:

• Breech Face Score *
• Firing Pin Score *
• Ejector Mark Score *
• Event Type
• Caliber
• Law Agency

*Available only if the MultiViewer was 
opened from the Correlation 
Requests view. Otherwise, User 
Selection is displayed as an option, 
which sorts exhibits in the order in which 
they were selected.

Layout The selection determines the number of 
images in the layout. The options are:

• 8 x 5
• 6 x 4
• 4 x 3
• 2 x 2

Side-by-Side Viewer Opens the Cartridge Case Side-by-Side 
Viewer (page 347). The reference exhibit 
and the selected test exhibit are displayed.

Import Exhibits Opens the Import Exhibits Dialog Box 
(page 311). You can import all the 
remaining exhibits that are not stored 
locally, or set a number of exhibits to 
import based on the highest scores.

Button/Field Name Description



334

IBIS MATCHPOINT+ 2.3 
User Guide

3D Image Controls

Visual Indicators

Save Settings Saves the Viewer settings as your 
Preferences (page 55). 

Help Opens the Help topic for the MultiViewer. 

Control Description

2D/3D Rendering Adjusts the 2D/3D rendering of the displayed primer 3D 
composite images that have been acquired with 
BRASSTRAX-3D. 

The range is from 0, which renders the image as completely 
2D, to 100, which renders the image with the maximum 
level of 3D. This control produces a proportionate mix of 2D 
and 3D within that range.

Lighting control Changes the type of light and adjusts the direction of the 
side light. This control affects only primer 3D composite 
images.

Clicking the center of the inner circle switches to the center 
light. Clicking the outer circle switches to the side light. 
Dragging the “light beam” on the outer circle changes the 
direction of the side light. For more information, see Lighting 
Control (page 363).

Indicator Description

Blue border When used on one exhibit, the border indicates the test 
exhibit that will display first if you open the Side-by-Side 
Viewer. When used on two exhibits, the borders indicate the 
two exhibits that will display in the Side-by-Side Viewer.

Button/Field Name Description
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Mouse Actions

Exhibit Details Fields

Red X Indicates that the test exhibit is of low interest and may be 
hidden. 

Not available Indicates that no image exists for the particular region of 
interest.

Action Description

Double-click On a test exhibit image, a blue border is placed around the 
exhibit. This indicates that the exhibit is selected to display in 
the Side-by-Side Viewer. To select a second test exhibit, press 
CTRL+double-click.

On a reference exhibit image, this isolates the image type to 
display all the test exhibits.

Right-click If the clicked exhibit is not currently marked, marks the 
images in the exhibit’s image group with a red X. When the 
Marked Exhibits button is clicked, the marked exhibits are 
removed from the display.

If the clicked exhibit is currently marked, unmarks the exhibit 
images.

Field Description

Site Name The site name of the case.

Case Number The unique ID that is assigned to the case.

Case Ref. Number The reference number that is assigned to the case.

High Profile Indicates if the case to which the exhibit belongs is high 
profile. 

Law Agency The law enforcement agency that submitted the case to 
which the exhibit belongs.

Case Occurrence The date on which the event occurred.

Case Creation The date on which the case was created. 

Indicator Description
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How Do I...? 
Open the MultiViewer (page 132)

Display guides in the MultiViewer (page 134)

Sort exhibits (page 139)
Display one or all cartridge case image types (page 143)

Hide exhibits (page 149)

Move and rotate images (page 150)
Adjust the lighting and rendering of 3D images (page 151)

Exhibit Number The unique number that is assigned to the exhibit.

Caliber The caliber of the exhibit.

Manufacturer The name of the ammunition manufacturer.

Firing Pin Shape The shape of the exhibit’s firing pin impression.

Event Type The event to which the case is related, such as a Homicide or 
Assault with a Deadly Weapon.

Acquisition The date on which the exhibit was acquired.

Created By The user who created the exhibit.

Field Description
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Breech Face Class Characteristics Filter Dialog Box

You can filter cartridge case exhibits by their breech face class characteristics. 
This dialog box opens when you select Breech Face Characteristics from 
Display Guides in the MultiViewer (page 134).

Class Characteristics
The breech face class characteristics help identify a cartridge case. The filter 
can include one or more class characteristics, and exclude Unknown types. 
Unknown is the default when no class characteristic is entered for an exhibit.

Check Box Description

Filter Activates the filter options.

Parallel Includes parallel marks.

Arch Includes arch marks.

Circular Includes circular marks.

Granular Includes granular marks.

Smooth Includes smooth marks.

Exclude Unknown Excludes class characteristics that are of the Unknown type.
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How Do I...? 
Use search (page 46)

Open the MultiViewer (page 132)

Display guides in the MultiViewer (page 134)
Display one or all cartridge case image types (page 143)

Hide exhibits (page 149)

Sets the filter and closes the dialog box.

Closes the dialog box.

Opens the Help topics that describes the dialog box.

Check Box Description
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Bullet MultiViewer 

The Bullet MultiViewer has two panes in which mosaics are displayed. 

• The first pane (on the left) displays the reference exhibit. 
• The second pane displays the test exhibits.

Reference exhibit

A red X indicates that the 
exhibit is of low interest

Exhibit information
Image manipulation 
controls

Test exhibitsExhibit layout
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Toolbar Buttons and Fields

Button/Field Name Description

Display Guides Turns the display information on and off.

When selected, the options set using the 
down arrow are displayed on the image. 

Marked Exhibits Hides/shows all marked exhibits.

Set Position Displays images at their acquisition position 
or their best match position, based on 
phase.

Best match position is enabled only if 
exhibits were selected from the 
Correlation Requests view.

Sort By The selected option determines how images 
are sorted in the MultiViewer. The 
options are:

• Max LEA 2D score*
• Peak Phase 2D score*
• Max Phase 2D score*
• Max LEA 3D score*
• Max Phase 3D score*
• Event type
• Caliber
• Law agency
• Average LEA width
• Maximum LEA width
• Minimum LEA width

*Available only if the MultiViewer was 
opened from the Correlation Requests 
view. Otherwise, User Selection is 
displayed as an option, which sorts exhibits 
in the order in which they were selected.

Layout The selection determines the number of 
images in the layout. The options are from 
8 to 2.
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Visual Indicators

Side-by-Side Viewer Opens the Bullet Side-by-Side Viewer 
(page 355). The reference exhibit and the 
selected test exhibit are displayed.

Import Exhibits Opens the Import Exhibits Dialog Box 
(page 311). You can import all the 
remaining exhibits that are not stored 
locally, or set a number of exhibits to 
import based on the highest scores.

Save Settings Saves the Viewer settings as your 
Preferences (page 55). 

Help Opens IBIS MATCHPOINT+ Help.

Indicator Description

Blue border When used on one exhibit, the border indicates the test 
exhibit that will display first if you open the Side-by-Side 
Viewer. When used on two exhibits, the borders indicate the 
two exhibits that will display in the Side-by-Side Viewer.

Red X Indicates that the test exhibit’s mosaic is of low interest and 
can be hidden.

Not available Indicates that no mosaic exists for the test exhibit.

Button/Field Name Description
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Mouse Actions

Image Manipulation Controls
There are several ways to enter a value using the following controls. For more 
information about how this type of control works, see Using the Image 
Manipulation Controls (page 171).

Action Description

Double-click On a test exhibit image, a blue border is placed around the 
exhibit. This indicates that the exhibit is selected to display in 
the Side-by-Side Viewer. To select a second test exhibit, press 
CTRL+double-click.

On a reference exhibit image, this isolates the image type to 
display all the test exhibits.

Right-click If the clicked exhibit is not currently marked, marks the 
images in the exhibit’s image group with a red X. When the 
Marked Exhibits button is clicked, the marked exhibits are 
removed from the display.

If the clicked exhibit is currently marked, unmarks the exhibit 
images.

Control Description

2D/3D Rendering Changes the rendering of the images from 2D to 3D.

The range is from 0, which renders the image as completely 
2D, to 100, which renders the image with the maximum 
level of 3D. This control produces a proportionate mix of 2D 
and 3D within that range.

This control is available only for 3D images that have been 
acquired with BULLETTRAX-3D.

Lighting Changes the lighting for all 3D images. For more 
information, see Lighting Control (page 363).
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Exhibit Details Fields

How Do I...? 
Open the MultiViewer (page 132)
Display guides in the MultiViewer (page 134)

Sort exhibits (page 139)

Hide exhibits (page 149)
Move and rotate images (page 150)

Adjust the lighting and rendering of 3D images (page 151)

Field Description

Site Name The site name of the case.

Case Number The unique ID that is assigned to the case.

Case Ref. Number The reference number that is assigned to the case.

High Profile Indicates if the case to which the exhibit belongs is high 
profile.

Law Agency The law enforcement agency that submitted the case to 
which the exhibit belongs.

Case Occurrence The date on which the event occurred.

Case Creation The date on which the case was created. 

Exhibit Number The unique ID that is assigned to the exhibit.

Caliber Start The start of the bullet caliber range.

Caliber End The end of the bullet caliber range.

Composition The materials that make up the bullet’s physical structure. 

Twist The direction in which the striae twist.

Firearm Exhibit The exhibit number of the firearm from which the bullet was 
fired.

Exhibit Creation The date on which the exhibit was created.
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Side-by-Side Viewer Reference

This section covers the following topics: 

Cartridge Case Side-by-Side Viewer .......................................................... 347
Bullet Side-by-Side Viewer........................................................................ 355
Configure CMS Dialog Box (Bullets Only) .................................................. 365
Midtones Dialog Box................................................................................ 367
Screenshot Dialog Box ............................................................................. 369
Print Preview Window.............................................................................. 371
Export Images Dialog Box (Cartridge Cases Only)...................................... 373
Correlation Scores Dialog Box (Cartridge Cases) ....................................... 375
Correlation Scores Dialog Box (Bullets) ..................................................... 377
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Cartridge Case Side-by-Side Viewer 

The Cartridge Case Side-by-Side Viewer displays two cartridge case images, 
the reference image and the test image simultaneously. The images can be 
rotated, overlapped, and saved to a file. You can adjust the contrast and 
brightness of all cartridge case images. When comparing primer 3D composite 
images, you can also adjust the 2D/3D rendering, 3D elevation, and lighting.

Comparison
view

Reference exhibit Test exhibit

Navigator view Movement lock Lighting lock

Exhibit counter

Activation areas (Exhibit Information)
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Views

Toolbar Buttons

View Description

Comparison view Displays the reference exhibit in the left pane and the test 
exhibit in the right pane.

Navigator view Displays image pairs, which consist of a reference image and 
a test image, for each image type that was acquired. 
Clicking on an image pair copies it to the Comparison 
view.

Button Name Description

Reset Resets all values to the default settings.

Export Images Opens the Export Images dialog box (page 373), 
which enables you to save selected images to 
graphic files.

Print Opens the Print dialog box, in which you can 
select a printer, specify print properties, a page 
range, and the number of copies.

Comparison View 
Screenshot

Opens the Screenshot dialog box (page 369), 
which allows you to save the Comparison view 
image as a bitmap or copy it to the Windows 
clipboard so that you can paste it into another 
application. 

Previous Exhibit Displays the previous exhibit in the test list. A 
counter indicates the number of exhibits.

Next Exhibit Displays the next exhibit in the test list. A counter 
indicates the number of exhibits.

Previous ROI Displays the previous ROI in the test exhibit.
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Next ROI Displays the next ROI in the test exhibit.

Translation Mode Puts the cursor into translation mode so that you 
can move an image by dragging the cursor. 

Rotation Mode Puts the cursor into rotation mode so that you 
can rotate an image by dragging the cursor.

Display Guides Turns the display information on and off.

When selected, the options set using the down 
arrow are displayed on the image.

Zoom Out Decreases the zoom level for the reference and 
test images. You cannot change the zoom level of 
the images independently.

Zoom In Increases the zoom level for the reference and 
test images. You cannot change the zoom level of 
the images independently.

Set Position Displays images at their acquisition position or 
their best match position, based on rotation.

Best match position is enabled only if exhibits 
were selected from the Correlation Requests 
view. 

Correlation Scores Opens the Cartridge Case Correlation Scores 
dialog box (page 375) in which the correlation 
scores of the exhibits in the Comparison view 
are displayed.

Enabled only if exhibits were selected from the 
Correlation Requests view.

Hit Opens the Add Hit dialog box (page 381). 

Import Opens the Import Exhibits dialog box (page 311). 
You can import all the remaining exhibits that are 
not stored locally, or set a number of exhibits to 
import based on the highest scores.

Button Name Description
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Image Manipulation Controls

Save Settings Saves the Viewer settings as your Preferences 
(page 55). 

Help Opens the Help topic that describes the window.

Control Description

Brightness

R (Reference) Adjusts the brightness of the reference exhibit. 

For the Reference and the Test exhibit, the brightness range 
is between 0 and 100. The default is 50. As the value 
approaches 0, the images get darker. As the value 
approaches 100, the images get brighter.

T (Test) Adjusts the brightness of the test exhibit.

Contrast

R (Reference) Adjusts the contrast of the reference exhibit. 

For the Reference and the Test exhibit, the contrast range is 
between 0 and 100. The default is 50. As the value 
approaches 0, the contrast is reduced. As the value 
approaches 100, the contrast is increased. 

For information about midtones, see Midtones dialog box 
(page 367).

T (Test) Adjusts the contrast of the test exhibit. 

Sharpness

R (Reference) Adjusts the sharpness of the reference image.

The default is 0 and the maximum is 10. As the value 
approaches 10, the focus is enhanced by increasing the 
contrast of adjacent pixels in the image.

T (Test) Adjusts the sharpness of the test exhibit.

Button Name Description
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Negative Image Converts the contrast to the negative image for the 
reference exhibit and test exhibit.

2D/3D Rendering

R (Reference) Adjusts the 2D/3D rendering of the reference exhibit. This 
control applies to primer 3D composite images only.

For the reference and the test exhibit, the range is from 0, 
which renders the image as completely 2D, to 100, which 
renders the image with the maximum level of 3D. This 
control produces a proportionate mix of 2D and 3D within 
that range.

This control can be used only on 3D images that were 
acquired with BRASSTRAX-3D.

T (Test) Adjusts the 2D/3D rendering of the test exhibit. 

3D Elevation

R (Reference) Adjusts the height of the peaks on the reference image. This 
control applies to primer 3D composite images only.

The default is 25, which represents a magnitude factor of 1x. 
The range is from 0 (0x) to 100 (4x). To reduce the height of 
peaks, select a value that is between 0 and 25. To increase 
the height of image peaks, select a value that is between 25 
and 100.

T (Test) Adjusts the height of the peaks on the reference image. This 
control applies to primer 3D composite images only.

Lighting This control applies to primer 3D composite images only. For 
more information, see Lighting Control (page 363).

Control Description
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Hit Count Fields

Locks

Field Description

R (Reference) The number of hits in which the reference exhibit has been 
involved.

T (Test) The number of hits in which the test exhibit has been 
involved.

If a hit has been recorded between the displayed reference 
exhibit and test exhibit, an orange bull’s-eye icon appears 
next to the Hit Count heading.

Lock Description

Movement When this lock is on, the test exhibit still moves 
independently, but when the reference exhibit is moved the 
test exhibit is locked to move with it. When off, only the 
exhibit over which the cursor is positioned moves.

Use the keyboard shortcut key, F12, to toggle between 
locked and unlocked.

Brightness When this lock is on, changes to brightness are applied to 
both the reference exhibit and the test exhibit 
simultaneously. When this lock is off, brightness 
adjustments can be made to each image independently.

Contrast When this lock is on, changes to contrast are applied to 
both the reference exhibit and the test exhibit 
simultaneously. When this lock is off, contrast adjustments 
can be made to each image independently.

2D/3D Rendering When this lock is on, changes to 2D/3D rendering are 
applied to both the reference exhibit and the test exhibit 
simultaneously. When this lock is off, 2D/3D rendering 
adjustments can be made to each image independently.
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Lighting Control
Adjusting the lighting can help to enhance image detail. The Lighting control 
allows you to switch between a center light and a side light and change the 
direction of the side light. Lighting adjustments affect all the 3D images in the 
Side-by-Side Viewer. 

You can use the control as shown in the following illustration, or you can enter 
values directly in the D (Direction) and I (Inclination) fields.

  

Note: Lighting can be adjusted for 3D images only.
 

3D Elevation When this lock is on, changes to 3D elevation are applied 
to both the reference exhibit and the test exhibit 
simultaneously. When this lock is off, 3D elevation 
adjustments can be made to each image independently.

Lighting When this lock is on, changes to the lighting are applied to 
both the reference exhibit and the test exhibit 
simultaneously. When this lock is off, lighting adjustments 
can be made to each image independently.

Lock Description

Clicking the outer circle enables the side light. 
Dragging the blue “light beam” changes the 
direction of the light. 

Clicking off-center in the inner circle enables the side 
light. Where you click determines the direction of the 
side light, as indicated by the blue “light beam”. 

Clicking in the middle of the inner circle enables the 
center light.
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How Do I...? 
Analyze cartridge case exhibits (page 160)

Open the Side-by-Side Viewer (page 163)
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Bullet Side-by-Side Viewer 

The Bullet Side-by-Side Viewer is used to closely compare a reference bullet 
exhibit to a test exhibit. Toolmark identification features, such as bullet 
profiling and consecutive matching striae (CMS), are available. 

Navigator view

Profile view

Test exhibit

Comparison view

Navigator 
box

Movement lock
Lighting lock

Profile 
lines

Profile 
guide lines

CMS view

Index 
numbers

Anchor 
line

Move handle
Activation areas (Exhibit Information)

Reference exhibit
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Views

Toolbar Buttons

View Description

Navigator view Displays the full mosaics of the reference and test exhibits. 
The part of the mosaic that appears in the Navigator Box is 
enlarged and displayed in the Comparison view. Missing 
LEAs or GEAs are indicated by gray shading.

Comparison view Displays an enlarged view of a section of the reference 
exhibit and the test exhibit for close side-by-side 
inspection.

Profile view When bullet profiling is enabled, displays two two-
dimensional graphs, or profiles. The green graph 
represents the shape of the reference bullet’s surface, and 
the orange graph represents that of the test bullet.

CMS view When the consecutive matching striae (CMS) have been 
calculated, displays the number of instances of each CMS 
group (1 CMS to 12 CMS) that have been found.

Button Name Description

Reset Resets all values to the default settings.

Print Opens the Print dialog box, in which you can 
select a printer, specify print properties, a page 
range, and the number of copies.

Comparison View 
Screenshot

Opens the Screenshot dialog box (page 369), 
which enables you to save the Comparison 
view image as a bitmap or copy it to the 
Windows clipboard so that you can paste it 
into another application.

Previous Exhibit Displays the previous exhibit in the test list. A 
counter indicates the number of exhibits.

Next Exhibit Displays the next exhibit in the test list. A 
counter indicates the number of exhibits.



CHAPTER 14  Side-by-Side Viewer Reference
Bullet Side-by-Side Viewer

357

Previous ROI Displays the previous ROI in the test exhibit.

Next ROI Displays the next ROI in the test exhibit.

Zoom Out Sets the magnification of the images in the 
Comparison view to the lowest level. 

Zoom In Sets the magnification of the images in the 
Comparison view to the highest level. 

Profiling State Turns the bullet profiles on and off. When 
selected, the options that are set using the 
down arrow are displayed on the image. 

Hairline Profiling: the position of the 
hairline is used as the basis of the bullet 
profiles.

Profile Lines: the position of each profile 
line is used as the basis of the bullet profiles.

There are two profile lines that can be 
positioned separately. The green line is for the 
reference exhibit and the orange line is for the 
test exhibit.

For more information, see Visualize Bullet 
Profiles (page 201).

Adjust Adjustment options used to redress and 
normalize the images.

Display Guides Turns the display information on and off.

When selected, the options set using the 
down arrow are displayed on the image.

Button Name Description
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Calculate CMS Calculates the number of consecutive 
matching striae (CMS) that are in the selected 
reference LEA and test LEA. 

Clicking the down arrow next to this button 
opens a menu that contains the Configure 
option, which opens the Configure CMS 
dialog box (page 365).

For more information, see Calculate the 
Number of Consecutive Matching Striae 
(page 205).

Show/Hide the CMS When set to Show, found CMS groups and/or 
individual striae are highlighted to make them 
stand out. When set to Hide, they are not 
highlighted.

Clicking the down arrow next to this button 
opens a menu from which you can select what 
you want highlighted in the Comparison 
view:

• CMS only 
Only CMS groups of consecutive matching 
striae are highlighted.

• Striae only
Only individual striae that meet the Stria 
Calculation criteria in the Configure CMS 
dialog box (page 365) are highlighted.

• CMS and Striae
CMS groups and individual striae are 
highlighted.

Transparency Mode When enabled, both exhibits are transparent. 
When the images are overlapped, the features 
of the two exhibits are combined.

When disabled, both exhibits are opaque.

For more information, see Overlap Images 
(page 181).

Button Name Description
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Set Position Displays images at their acquisition position or 
their best match position, based on phase. The 
pair of LEAs with the Max Phase score are 
displayed in the Comparison view.

Best match position is enabled only if exhibits 
were selected from the Correlation 
Requests view.

For more information, see Set Bullet Images at 
Best Match Position (page 173).

Correlation Scores Opens the Bullet Correlation Scores dialog box 
(page 377) in which the bullet correlation 
scores of the reference and the test exhibits 
are displayed. 

Hit Opens the Add Hit dialog box (page 381).

Import Opens the Import Exhibits dialog box 
(page 311). You can import all the remaining 
exhibits that are not stored locally, or set a 
number of exhibits to import based on the 
highest scores.

Save Settings Saves the Viewer settings as your Preferences 
(page 55). 

Help Opens MATCHPOINT+ Help.

Button Name Description
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Hit Count Fields

Locks

Field Description

R (Reference) The number of hits in which the reference exhibit has been 
involved.

T (Test) The number of hits in which the test exhibit has been 
involved.

If a hit has been recorded between the displayed reference 
exhibit and test exhibit, an orange bull’s-eye icon appears 
next to the Hit Count heading.

Lock Description

Movement When this lock is on, the test exhibit still moves 
independently, but when the reference exhibit is moved the 
test exhibit is locked to move with it. When off, only the 
exhibit over which the cursor is positioned moves.

Use the keyboard shortcut key, F12, to toggle between 
locked and unlocked.

Brightness When this lock is on, changes to brightness are applied to 
both the reference exhibit and the test exhibit 
simultaneously. When this lock is off, brightness 
adjustments can be made to each image independently.

Contrast When this lock is on, changes to contrast are applied to 
both the reference exhibit and the test exhibit 
simultaneously. When this lock is off, contrast adjustments 
can be made to each image independently.

2D/3D Rendering When this lock is on, changes to 2D/3D rendering are 
applied to both the reference exhibit and the test exhibit 
simultaneously. When this lock is off, 2D/3D rendering 
adjustments can be made to each image independently.
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Image Manipulation Controls
There are several ways to enter a value using the following controls. For more 
information about how this type of control works, see Using the Image 
Manipulation Controls (page 171).

3D Elevation When this lock is on, changes to 3D elevation are applied 
to both the reference exhibit and the test exhibit 
simultaneously. When this lock is off, 3D elevation 
adjustments can be made to each image independently.

Lighting When this lock is on, changes to the lighting are applied to 
both the reference exhibit and the test exhibit 
simultaneously. When this lock is off, lighting adjustments 
can be made to each image independently.

Control Description

Brightness

R (Reference) Adjusts the brightness of the reference exhibit. 

For the Reference and the Test exhibit, the brightness 
range is between 0 and 100. The default is 50. As the 
value approaches 0, the images get darker. As the value 
approaches 100, the images get brighter.

T (Test) Adjusts the brightness of the test exhibit.

Contrast

R (Reference) Adjusts the contrast of the reference exhibit. 

For the Reference and the Test exhibit, the contrast range 
is between 0 and 100. The default is 50. As the value 
approaches 0, the contrast is reduced. As the value 
approaches 100, the contrast is increased. 

For information about midtones, see Midtones dialog box 
(page 367).

T (Test) Adjusts the contrast of the test exhibit. 

Lock Description
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Sharpness

R (Reference) Adjusts the sharpness of the reference image.

The default is 0 and the maximum is 10. As the value 
approaches 10, the focus is enhanced by increasing the 
contrast of adjacent pixels in the image.

T (Test) Adjusts the sharpness of the test exhibit.

Negative Image Converts the contrast to the negative image for the 
reference exhibit and test exhibit.

2D/3D Rendering

R (Reference) Adjusts the 2D/3D rendering of the reference exhibit. 

For the Reference and the Test exhibit, the range is from 0, 
which renders the image as completely 2D, to 100, which 
renders the image with the maximum level of 3D. This 
control produces a proportionate mix of 2D and 3D within 
that range.

This control is available only for 3D images that have been 
acquired with BULLETTRAX-3D.

T (Test) Adjusts the 2D/3D rendering of the test exhibit. 

3D Elevation

R (Reference) Adjusts the height of the peaks on the reference image. 

The default is 25, which represents a magnitude factor of 
1x. The range is from 0 (0x) to 100 (4x). To reduce the 
height of peaks, select a value that is between 0 and 25. 
To increase the height of image peaks, select a value that 
is between 25 and 100.

The 3D elevation control can be used only on 3D images 
that were acquired with BULLETTRAX-3D.

T (Test) Adjusts the height of the peaks on the reference image.

Stretch

Control Description
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Lighting Control
Adjusting the lighting can help to enhance image detail. The Lighting control 
allows you to switch between a center light and a side light and change the 
direction of the side light. Lighting adjustments affect all the 3D images in the 
Side-by-Side Viewer. 

You can use the control as shown in the following illustration, or you can enter 
values directly in the D (Direction) and I (Inclination) fields.

  

Note: Lighting can be adjusted for 3D images only. 
 

R (Reference) Stretches or shrinks the reference image vertically.

If one of the images is of lesser quality than the other, its 
striae may be compressed in comparison to the other 
image. Stretching the image allows you to align its striae 
with those in the other image.

T (Test) Stretches or shrinks the test image vertically.

Lighting See Lighting Control (page 363).

Control Description

Clicking the outer circle enables the side light. 
Dragging the blue “light beam” changes the 
direction of the light. 

Clicking off-center in the inner circle enables the side 
light. Where you click determines the direction of the 
side light, as indicated by the blue “light beam”. 

Clicking in the middle of the inner circle enables the 
center light.
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How Do I...? 
Analyze bullet exhibits (page 158)

Open the Side-by-Side Viewer (page 163)
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Configure CMS Dialog Box (Bullets Only)

This dialog box opens when you click the arrow next to the Calculate CMS 
button on the Bullet Side-by-Side Viewer toolbar and select Configure. Use 
this dialog box to define the criteria that are used to determine which 
markings are considered valid striae and the tolerances that are used to decide 
if consecutive striae match. 

Fields and Buttons

Field/Button Description

Striae Calculation

Find Striae Using Peaks Striae will be defined by looking at the peaks.
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How Do I...? 
Calculate the number of consecutive matching striae (page 205)

Configure CMS Options (page 209)

Find Striae Using Valleys Striae will be defined by looking at the valleys.

Relative Height 
Difference (%)

When Find Striae Using Peaks is selected, determines how 
high a peak must be, relative to the mean level of surface 
features in the LEA, to be considered a significant feature 
and included in the computation.

When Find Striae Using Valleys is selected, this value refers 
to the depth of valleys.

Minimum Length Determines how long a stria must be to be considered 
significant. The length can be entered in inches or 
millimeters.

CMS Calculation

Match Tolerance (Pixels) Determines how much of a difference in vertical distance 
(measured in pixels) will be tolerated between two sets of 
consecutive striae that are being compared. 

If the difference is greater than this value, the two sets of 
consecutive striae will not be considered a match. 

Saves the CMS configuration and closes the dialog box. 

Closes the dialog box without saving the changes to the 
CMS configuration.

Opens the Help topic that describes the dialog box.

Field/Button Description
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Midtones Dialog Box

This dialog box opens when you click the button inside the Contrast control 
section. Instead of affecting the contrast of the image globally, you can use the 
midtone contrast and shift controls in this dialog box to adjust the midtones of 
an image. 

Views

Image Manipulations Controls

View Description

Midtone viewer The graphic representation of midtone adjustments for the 
reference and test. If the control is unlocked, the reference 
and test exhibits appear as separate lines. The reference 
exhibit is red and the test exhibit is green. 

Control Description

Contrast

R (Reference) Adjusts the contrast midtone of the reference exhibit. 

The default is 50 and the range is from 0 to 100. 

T (Test) Adjusts the contrast midtone of the test exhibit. 



368

IBIS MATCHPOINT+ 2.3 
User Guide

Locks

Buttons

How Do I...? 
Adjust image contrast (page 188)

Adjust image midtones (page 190)

Shift

R (Reference) Adjusts the shift of the reference exhibit. 

The default is 0 and the range is from -100 to 100. 

T (Test) Adjusts the shift of the test exhibit. 

Lock Description

Contrast When this lock is on, changes to the contrast midtone are 
applied to both the reference exhibit and the test exhibit 
simultaneously. When this lock is off, contrast midtone 
adjustments can be made to each image independently.

Shift When this lock is on, changes to the shift are applied to 
both the reference exhibit and the test exhibit 
simultaneously. When this lock is off, shift adjustments can 
be made to each image independently.

Button Description

Closes the dialog box.

Opens the Help topic that describes the dialog box.

Control Description
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Screenshot Dialog Box

This dialog box opens when you click Comparison View Screenshot on the 
Side-by-Side Viewer toolbar. Use this dialog box to save the images in the 
Comparison view as a bitmap file or to copy them to the Windows clipboard 
so that you can paste them into another application.

Fields and Buttons

Field/Button Description

Save to file Saves the Comparison view image as a bitmap file.

Opens a dialog box in which you specify the folder in which 
you want to save the file and the file name.

Copy to clipboard Copies the Comparison view image to the Windows 
clipboard so that you can paste it into another application.

Add text information Saves exhibit information, such as the contrast and 
brightness settings, along with the image.

Saves a screen capture of the Comparison view as a 
bitmap file or copies it to the Windows clipboard, 
depending on the selected option.
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How Do I...? 
Save a screenshot of the Comparison View (page 211)

Closes the dialog box without saving or copying the 
Comparison view image.

Opens the Help topic that describes the dialog box.

Field/Button Description
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Print Preview Window

This window opens when you click Print > Print Preview on the Cartridge 
Case Side-by-Side Viewer (page 347) or the Bullet Side-by-Side Viewer 
(page 355) toolbar. Use this window to preview a document before printing it. 
You can also print a document from this dialog box. 

Toolbar Buttons

Button Description

Opens the Print dialog box.

If there are multiple pages, displays the next page.

If there are multiple pages, displays the previous page.

If there are multiple pages, displays two pages side-by-side.
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How Do I...? 
Print images (page 215)

Increases the magnification level.

Decreases the magnification level.

Closes the dialog box.

Button Description
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Export Images Dialog Box (Cartridge Cases Only)

This dialog box opens when you click Export Images on the Cartridge Case 
Side-by-Side Viewer toolbar. Use this dialog box to export some or all of the 
images associated with the reference and test exhibits to individual graphic 
files.

  

Note: You cannot export primer 3D DFF images.
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Fields and Buttons

How Do I...? 
Export cartridge case images (page 213)

Field/Button Description

Reference Exhibit Lists the images that are associated with the reference 
exhibit. When the check box next to an image is selected, 
the image is exported as a graphic file when Export is 
clicked.

Test Exhibit Lists the images that associated with the test exhibit. When 
the check box next to an image is selected, the image is 
exported as a graphic file when Export is clicked.

File Name The root file name that is used in the individual names of 
the files that are created. Individual file names are made up 
of the root file name and a suffix. 

For example, if the root file name is 
EX-CC-9MM, the resulting name of the breech face ring 
light graphic file is: 

EX-CC-9MM - Breech Face - Ring Light

File Type The graphic file format in which the selected images are 
saved. The options are PNG, JP2, and RAW.

Export Path The folder in which the files will be saved. 

Opens a dialog box that allows you to browse for the 
folder.

Exports the selected images as individual graphic files and 
saves them in the folder selected in Export Path field. 

Closes the dialog box without exporting the images.

Opens the Help topic that describes the dialog box.
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Correlation Scores Dialog Box (Cartridge Cases)

This dialog box opens when you click Correlation Scores on the Cartridge 
Case Side-by-Side Viewer (page 347) toolbar. This dialog box displays the 
correlation scores of the image pair that is displayed in the Comparison view. 
For more information about scores, see Understanding Cartridge Case 
Correlation Scores (page 77).

Fields and Buttons

Field/Button Description

Breech Face This score reflects the degree of similarity between the 
breech face region of interest (ROI) of the reference exhibit 
and the test exhibit that are displayed in the Comparison 
view.

Firing Pin This score reflects the degree of similarity between the firing 
pin region of interest (ROI) of the reference exhibit and the 
test exhibit that are displayed in the Comparison view. 
This is the only score for rimfire.

Ejector Mark This score reflects the degree of similarity between the 
ejector mark region of interest (ROI) of the reference exhibit 
and the test exhibit that are displayed in the Comparison 
view.
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How Do I...? 
View correlation scores (page 185)

Closes the dialog box.

Opens the Help topic that describes the dialog box.

Field/Button Description
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Correlation Scores Dialog Box (Bullets)

This dialog box opens when you click Correlation Scores on the Bullet Side-
by-Side Viewer (page 355) toolbar. This dialog box displays the correlation 
scores of reference and test exhibits that are displayed in the Comparison 
view. For more information about scores, see Understanding Bullet Correlation 
Scores (page 80).

Fields and Buttons

Field/Button Description

Max LEA 2D The highest LEA score, calculated using acquired 2D data, 
within all of the individual LEA scores for a bullet 
correlation, and the phase where it was produced.

Peak Phase 2D The highest LEA score within the phase that produced the 
Max Phase score, and the phase where it was produced.

Max Phase 2D The highest phase score within a bullet correlation, 
calculated using acquired 2D data, and the phase where 
it was produced.

Max LEA 3D The highest LEA score, calculated using acquired 3D data, 
within all of the individual LEA scores for a bullet 
correlation, and the phase where it was produced.
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How Do I...? 
View correlation scores (page 185)

Max Phase 3D The highest phase score within a bullet correlation, 
calculated using acquired 3D data, and the phase where 
it was produced. 

Closes the dialog box.

Opens the Help topic that describes the dialog box.

Field/Button Description
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Hits Reference

This section covers the following topics: 

Add/Modify Hit Dialog Box....................................................................... 381
Hits Window............................................................................................ 383
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Add/Modify Hit Dialog Box

The Add Hit dialog box opens when you click Hit on the Side-by-Side 
Viewer toolbar. However, if the two exhibits are already logged as a hit, the 
Modify Hit dialog box opens.

The Modify Hit dialog box opens when you double-click a hit in the Hits 
window (page 383).

Use the Add Hit dialog box to record a hit in MATCHPOINT+. Most of the 
information is automatically filled in. You can only enter comments. Use the 
Modify Hit dialog box to modify the comments of an existing hit. 

Fields and Buttons

Field/Button Description

Site Name The unique name that is assigned to the site to which the 
case belongs. This field is read-only.

Case Number The unique number that is assigned to the case. This field 
is read-only.

Exhibit Number The unique number that is assigned to the exhibit. This 
field is read-only.

Comments An area in which you can record additional comments.
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How Do I...? 
Add a hit (page 222)
Modify a hit (page 225)

Confirmed When selected, indicates the date that the hit was 
confirmed by a firearm examiner.

Note: Confirmed hits cannot be deleted.

Saves the hit in MATCHPOINT+.

Closes the dialog box without saving or modifying the 
hit.

Opens the Help topic that describes the dialog box.

Field/Button Description
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Hits Window

The Hits window displays a list of all hits that have been entered at your 
MATCHPOINT+ workstation. 

  

Note: Only users with Expert Acquisition Technician or Firearm 
Examiner permissions can open this window.

 

Columns

Column Description

Site Icon A colored site icon in the first column indicates that the 
hit is on a local site, and therefore can be modified. If no 
icon appears, the hit is on a remote site and is read-only.

First Exhibit The site name, case number, and exhibit number of the 
reference exhibit.

Second Exhibit The site name, case number, and exhibit number of the 
test exhibit.

Comments Additional comments that were entered during hit 
creation.
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Context Menu
The following menu items appear when you right-click a selected hit in the list. 

How Do I...? 
Add a hit (page 222)

View a hit (page 224)

Modify a hit (page 225)

Creation The date the hit was created in MATCHPOINT+.

Created By The user who created the hit.

Confirmation The date the hit was confirmed by a firearm examiner. 

Confirmed By The user who confirmed the hit. 

Modification The date the hit was last modified.

Modified By The user who modified the hit in MATCHPOINT+.

Menu Item Description

Compare Exhibits Opens the Side-by-Side Viewer.

Exhibit Information Opens the exhibit information window (First Exhibit or 
Second Exhibit.)

Modify Allows you to modify the comments or confirm a hit if it 
is not already confirmed.

Delete Deletes the selected hit. Confirmed hits cannot be 
deleted.

Print Open the Print dialog box. 

Column Description
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Reports Reference

This section covers the following topics: 

Reports Window ...................................................................................... 387
New Report Dialog Box ............................................................................ 390
Report Parameters Dialog Box .................................................................. 392
Report Format Dialog Box ........................................................................ 395
Report Data Source Dialog Box................................................................. 397
Report Fields Dialog Box .......................................................................... 399
Grouping Dialog Box................................................................................ 401
Display Order Dialog Box.......................................................................... 403
Sorting Dialog Box ................................................................................... 405
Charts Dialog Box .................................................................................... 407
Report Title and Options Dialog Box ......................................................... 409
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Reports Window

This window opens when you click Reports in the Navigation tree. Use this 
view to see a list of the reports that you have created. You can sort the list by 
clicking on any of the column headers. 

Columns

Column Description

Name The name of the report.

Type The name of the template that was used to create the 
report.
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Context Menu
The following menu items appear when you right-click a report in the list. 

Status The status of the report, which will be one of the 
following:

• Requested indicates that the report request has been 
submitted.

• Waiting indicates that the report request has been 
received and is queued to be processed.

• Processing indicates that MATCHPOINT+ is currently 
generating the report.

• Available indicates that the report is ready to be 
downloaded from the server.

• Downloading indicates that the report is currently 
being downloaded (also indicates the percent 
completed).

• Error indicates that an error has occurred.
• Done indicates that the report is ready to be viewed.

Creation The date on which the report was created.

Comments Additional comments about the report.

Menu Item Description

New Opens the New Report dialog box.

Open Opens the list of report formats that can be opened from 
your computer. A format must be generated before it can 
be selected. This menu item is available only if the report 
status is Done.

Copy Opens a list of report formats that can be copied. If a 
format has been generated it can be selected and copied 
to a folder on your computer or to an external drive.

Delete If the status of the selected report is Done, deletes all the 
report formats that are saved locally. If the status of the 
selected report is Waiting, cancels the report request and 
removes the entry from the Reports window. 

Column Description
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How Do I...? 
Display a list of reports (page 237)

View and print a report (page 238)
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New Report Dialog Box

This dialog box opens when you select File > New > Report or click New 
Report on the toolbar. Use this dialog box to select a standard or custom 
template to use to generate a report, or to create a new custom template. 

Fields and Buttons

Field/Button Description

Standard templates The standard MATCHPOINT+ report templates. These 
templates are available to all users.

Custom templates The report templates that you have created. These 
templates are available only to the user who created 
them.

Description The description of the selected template.

Comments Descriptive comments about the report. The field is 
mandatory, which makes it easier to recognize reports 
that are generated with the same template.
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How Do I...? 
Create a report (page 235)

Opens the Report Parameters dialog box.

Closes the New Report dialog box.

Starts the New Custom Report wizard, which guides 
you through the creation of a new custom report 
template. The new template is then used to generate the 
report.

Opens the selected custom template so that you can 
make modifications.

Deletes the selected custom report template.

Note: This button is disabled if a standard report is 
selected.

Opens the Help topic for the dialog box.

Field/Button Description
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Report Parameters Dialog Box

This dialog box opens when you click Generate on the New Report dialog box 
(page 390) or Finish on the Report Title and Options dialog box (page 409), 
which is the last dialog box in the New Custom Report wizard. Use this dialog 
box to specify the parameters for the report.
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Fields and Buttons

Field/Button Description

Select a start date Specifies which date is used as the start date. The 
options are:

• Select your own date
• Today
• Six months ago
• One year ago
• 01 January (of the current year)

If Select your own date is selected in the previous 
field, the second starting date field shows the date that 
you selected from the calendar.

The calendar is displayed when you click the down arrow 
in this field.

Select an end date Specifies which date is used as the ending date. The 
options are:

• Select your own date
• Today
• Six months ago
• One year ago
• 01 January (of the current year)

If Select your own date is selected in the previous 
field, the second ending date field shows the date that 
you selected from the calendar.

The calendar is displayed when you click the down arrow 
in this field.

Show Subtotals Only An option for certain reports that may generate a lot of 
data. Only the subtotals appear in the report; the 
individual items are eliminated. 

Hits Option For reports that are based on hits, you can choose to 
include confirmed, unconfirmed, or all hits. 

Available Sites The list of available sites that can be used to filter the 
data content of a report. 



394

IBIS MATCHPOINT+ 2.3 
User Guide

How Do I...? 
Select the report parameters (page 241)

Selects all the available sites for the report.

Clears all the sites that have been selected for the report.

Returns to the previous step. This button is disabled for 
report templates since this is the first dialog box. 

Opens the next dialog box in the wizard.

Closes the dialog box and cancels the report request.

Opens the Help topic for the dialog box.

Field/Button Description
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Report Format Dialog Box

This dialog box opens after you specify the report parameters. Use this dialog 
box to specify the formats that you want to create for the report.

Fields and Buttons

Formats Description

PDF Generates a version of the report in PDF format. This is 
the default selection.

HTML Generates a version of the report in HTML format.

Excel Generates a version of the report in Excel format.

RTF Generates a version of the report in RTF format.

Returns to the previous step.

Generates the selected formats of the report.

Closes the dialog box and cancels the report request.
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How Do I...? 
Select a report format (page 244)
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Report Data Source Dialog Box

This dialog box opens when you start the New Custom Report wizard by 
clicking New in the New Report dialog box (page 390). It is the first dialog box 
in the wizard. Use this dialog box to specify the type of report that you want to 
create.



398

IBIS MATCHPOINT+ 2.3 
User Guide

Fields and Buttons

How Do I...? 
Select the report data source (page 249)

Field/Button Description

Data Source The data that will appear in the report. You can choose 
from the following data sources:

• Confirmed Hits by Exhibit
• Cases
• Bullet Exhibits
• Cartridge Case Exhibits
• Firearm Exhibits
• Hits For Bullet Exhibits
• Hits For Cartridge Case Exhibits
• Correlation Requests
• Cartridge Case and Bullet Exhibits
• Hits for Cartridge Case and Bullet Exhibits
• Users

Description A description of the selected data source.

Disabled in this dialog box since this is the first dialog 
box in the wizard. 

Opens the Report Fields dialog box (page 399).

This button remains disabled until a data source is 
selected from the list.

Cancels the New Custom Report wizard.

Opens the Help topic for the dialog box.
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Report Fields Dialog Box

Use this dialog box to select the fields that you want to be included in the 
report.

Fields and Buttons

Field/Button Description

Available fields Lists the fields that are available for inclusion in the 
report. The particular fields that are available are 
determined by the selection that was made in the Report 
Data Source dialog box (page 397).

Selected fields Lists the fields that have been selected for inclusion in 
the report.

Moves the selected field from the Available fields list 
to the Selected fields list.

Moves all of the fields in the Available fields list to the 
Selected fields list.
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How Do I...? 
Select the report fields (page 250)

Moves all of the fields in the Selected fields list to the 
Available fields list.

Moves the selected field from the Selected fields list to 
the Available fields list.

Returns to the previous step.

Opens the next dialog box in the wizard.

This button remains disabled until at least one field is 
selected.

Cancels the New Custom Report wizard.

Opens the Help topic for the dialog box.

Field/Button Description
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Grouping Dialog Box

Use this dialog box to specify how you want to group the fields in the report.

Up to three grouping fields can be selected. The first field that is selected is at 
the top of the hierarchy. If you choose a second and third field, they are treated 
as subgroups within the main group.

Fields and Buttons

Field/Button Description

Available fields Lists the fields that can be used to group the data in the 
report.

Grouping fields Lists the fields that have been selected to group the data 
in the report.

Add total to each group When selected, the total number of records for each 
grouping is shown in the report.

Moves the selected field from the Available fields list 
to the Grouping fields list.
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How Do I...? 
Select the grouping fields (page 251)

Moves the selected field from the Grouping fields list 
to the Available fields list.

Returns to the previous step.

Opens the next dialog box in the wizard.

Cancels the New Custom Report wizard.

Opens the Help topic for the dialog box.

Field/Button Description
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Display Order Dialog Box

Use this dialog box to specify the order in which the selected fields will be 
displayed in the report. 

Fields and Buttons

Field/Button Description

Order Displays the order in which fields will be displayed in the 
report.

Moves the selected field up one position in the list.

Moves the selected field down one position in the list.

Returns to the previous step.
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How Do I...? 
Select the display order (page 252)

Opens the next dialog box in the wizard.

Cancels the New Custom Report wizard.

Opens the Help topic for the dialog box.

Field/Button Description
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Sorting Dialog Box

Use this dialog box to specify how data will be sorted in the report. You can 
specify up to three sort fields.

Fields and Buttons

Field/Button Description

1 The field by which the data will be sorted. If more than 
one sort field is specified, MATCHPOINT+ first sorts by 
this field.

2 The second field by which MATCHPOINT+ sorts the 
report data. To specify a second sort field, a selection 
must be made in the first sort field.

3 The third field by which MATCHPOINT+ sorts the report 
data. To specify a third sort field, a selection must be 
made in the first and second sort fields.
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How Do I...? 
Specify the sort order (page 253)

Sorts the results in ascending order.

Sorts the results in descending order.

Returns to the previous step.

Opens the next dialog box in the wizard.

Cancels the New Custom Report wizard.

Opens the Help topic for the dialog box.

Field/Button Description
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Charts Dialog Box

Use this dialog box to specify whether or not to include a chart in the report 
and, if so, the type of chart.

Fields and Buttons

Field/Button Description

Add a chart to the report When selected, includes a chart in the report.

Bar Chart When selected, a vertical bar chart is included in the 
report. 

Pie Chart When selected, a pie chart is included in the report.

Based on Specifies which field is used to calculate the bars or 
segments in the chart.

Returns to the previous step.
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How Do I...? 
Add a chart (page 254)

Opens the next dialog box in the wizard.

If the Add a chart to the report check box is 
selected but no selection has been made in the Based 
on field, this button remains disabled.

Cancels the New Custom Report wizard.

Opens the Help topic for the dialog box.

Field/Button Description
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Report Title and Options Dialog Box

Use this dialog box to specify page layout elements, including the report title 
and headers. 

Fields and Buttons

Field/Button Description

Report Title The title that will be printed on all report pages. This field 
is mandatory.

Element to be used as date 
range

The element that is used as the basis of the date range. 
The available options depend on the report type that was 
selected in the Report Data Source dialog box 
(page 397). This field is mandatory.

You will be prompted to enter the specified date range 
when creating a new report. 

Show page numbers in 
header

When selected, page numbers are displayed in the report 
headers.
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How Do I...? 
Specify page layout options and save the template (page 255)

Show date in header When selected, the date on which the report is 
generated is displayed in the report headers.

Save template as 
(check box)

Indicates that you want to save the options you selected 
in the wizard as a template. When selected, the text box 
to name the template is enabled.

Save template as 
(text box)

The name for the template you want save. The name 
appears in the list of Custom Templates in the New 
Report dialog box (page 390). 

If you enter a name that is already in use, you will be 
prompted to enter a different name.

Description The description of the new custom template. This 
description displays when the template is selected in the 
New Report dialog box (page 390).

This field is available only when a custom template is 
created or modified.

Returns to the previous step.

Terminates the wizard and opens the Report Parameters 
dialog box (page 392) in which you specify the date 
range. Generates and displays the report using the 
supplied date range.

If you have not completed all mandatory fields, or if you 
selected the Save template as check box but did not 
enter a name, this button remains disabled.

Cancels the New Custom Report wizard.

Opens the Help topic for the dialog box.

Field/Button Description
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3D Elevation A measure of the differences in height along the z-axis. Increasing the 
3D elevation increases the difference between the peaks and valleys on 
a bullet’s surface, creating a more pronounced texture.

Acquisition Marker A line of reference that appears on cartridge case images. The marker 
provides a reference to the original acquisition position.

Acquisition Station The BULLETTRAX-3D Acquisition Station collects bullet information and 
images. The BRASSTRAX-3D Acquisition Station collects cartridge case 
information and images. Both Acquisition Stations copy the images to 
the Data Concentrator.

Analysis Station The MATCHPOINT+ Analysis Station provides Firearm Examiners with 
access to the images and correlation results stored on an IBIS TRAX-3D 
system over a Local Area Network (LAN). 

Anchor Line A visual indicator that separates LEAs from GEAs in a bullet mosaic.

Annotations Text annotations can be added to identify ejector and extractor marks on 
breech face ring light images. Annotations are added in BRASSTRAX-3D 
and cannot be modified in MATCHPOINT+.

Breech Face That part of the breechblock or breech bolt which is against the head of 
the cartridge case or shotshell during firing.

Breech Face Class
Characteristics

The class characteristics that describe the breech face marks. This 
information about the exhibit is added in BRASSTRAX-3D and cannot be 
modified in MATCHPOINT+. Characteristics can be used as search 
criteria or a display filter in the MultiViewer.

Brightness The lightness value of a pixel in an electronic image, from black (0) to 
white (255).

Bullet A non-spherical projectile that is expelled from a firearm, such as a rifle 
or handgun.

Bullet Profile A two-dimensional graph that represents the shape of a bullet’s surface 
and the height measurements of its features and markings. 
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Caliber 1. Firearms: The approximate diameter of the circle formed by the tops 
of the lands of a rifled barrel. 2. Ammunition: A numerical term, without 
the decimal places, included in a cartridge name to indicate the nominal 
bullet diameter.

Cartridge A single, complete round of ammunition.

Cartridge Case The envelope, or container, of a cartridge.

Case An entity in MATCHPOINT+ that represents a law enforcement case, 
which keeps track of relevant case information such as the event type, 
law agency name, and occurrence date. A case is represented by a folder 
in the Navigation tree. Associated bullet and firearm exhibits are stored 
in the case folder. 

Centerfire Any cartridge that has its primer central to the axis in the head of the 
case.

Class Characteristics Measurable features of a specimen which indicate a restricted group 
source. They result from design factors, and are therefore determined 
prior to manufacture.

Consecutive Matching
Striae (CMS)

A toolmark identification technique that determines how many stria 
groups in a reference LEA match stria groups in the test LEA, based on 
the number of consecutive matching stria that make up the group.

Contrast The difference between the darkest and lightest areas in an image. The 
greater the difference, the higher the contrast.

Correlation The process by which signatures extracted from different exhibit images 
are compared for similarities. Results returned by this process are 
rankings of how similar each signature is to the reference exhibit in 
question.

Correlation Request A correlation request instructs the IBIS TRAX-3D system to compare a 
reference exhibit against test exhibits that are stored in the IBIS TRAX-
3D database. After an exhibit is acquired in BRASSTRAX-3D or 
BULLETTRAX-3D, a correlation request is created automatically.

Correlation Score The end result of the correlation process, which rates how similar one 
region of interest of a given reference exhibit is to the matching region 
of interest of a given test exhibit.
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Correlation Server A server that contains compressed images, image signatures, and 
information about cases and exhibits. After an exhibit’s signature has 
been extracted, this signature is copied into the Correlation Server. 
When a correlation is performed, the database stored on the server is 
consulted, and the signatures of the acquired images are compared.

Data Concentrator The Data Concentrator is a database server that stores all the bullet and 
cartridge case information, and the images that have been acquired by 
the BULLETTRAX-3D and BRASSTRAX-3D Acquisition Stations. It also 
contains the correlation requests and scores used for analysis in 
MATCHPOINT+.

Delimiter In a cartridge case exhibit, the outline around the region of interest.

Depth from Focus (DFF) Depth from focus (DFF) is a method of measuring depth information so 
that 3D primer images can be acquired by BRASSTRAX-3D. This method 
involves taking a series of images of a breech face region of interest, 
with each image taken at a different focal distance. As a result, only a 
certain region will be in focus in any particular image within the series. 
BRASSTRAX-3D then constructs an all-in-focus image from the image 
series.

Display Guides A collective term used to describe the types of additional information 
about exhibits that can be displayed in the Viewers, for example, anchor 
lines and annotations.

Ejector The part of a firearm’s mechanism which ejects cartridges or cartridge 
cases from a firearm.

Exhibit An entity in MATCHPOINT+ that keeps track of information relating to a 
particular bullet, cartridge case, or firearm found at the scene of a crime 
and associated with a particular case. Exhibits are represented as 
subfolders within case folders. For bullet and cartridge case exhibits, 
acquired images are stored in the exhibit subfolder. 

Extractor The part of a firearm’s mechanism which holds the cartridge case in 
place so that the ejector can eject it from the firearm.

Firearm An assembly of a barrel and action from which a projectile(s) is 
propelled by products of combustion.

Firing Pin The part of the firing mechanism that strikes the primer of the cartridge 
to initiate ignition.
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Groove Engraved Area
(GEA)

Raised areas on a bullet’s surface that are created by the grooves of the 
rifling of the barrel through which the bullet was fired. 

Hairline Profiling Bullet surface profiling method whereby the pixels used to generate the 
profile depend on the position of the hairline in the Side-by-Side Viewer.

Headstamp The markings imprinted on the base of a cartridge case, typically 
containing information about the caliber and manufacturer.

Hit A match between a reference exhibit and a test exhibit that has been 
confirmed by a Firearm Examiner.

Index Numbers The labels on bullet mosaics that identify LEAs and GEAs. They are the 
ROI references in an exhibit.

Image Group The images associated with a particular cartridge case exhibit, arranged 
vertically in a group in the MultiViewer.

Impression Surface contour variations on an object caused by applying force that is 
approximately perpendicular to the plane being marked. See striae.

Land The raised portion between the grooves in a rifled bore.

Land Engraved Area
(LEA)

Depressions on a bullet’s surface created by the lands of the rifling 
through which the bullet was fired.

LEA Count The number of LEAs on a bullet exhibit.

LEA Score A score generated according to the degree of similarity between two 
correlated LEAs.

Max LEA Score The highest LEA score within all of the individual LEA scores for a bullet 
correlation.

Max Phase Score The highest phase score within a bullet correlation, based on acquired 
2D data.

Mosaic A single image of a bullet exhibit with LEAs and GEAs arranged 
vertically in a continuous image that wraps around when moved 
vertically. Anchor lines are used to indicate the boundaries between 
LEAs and GEAs.

MultiViewer A window that allows a Firearm Examiner to compare multiple bullet or 
cartridge case exhibits simultaneously. 
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Outer Region The area outside the delimiters for breech face ring light and firing pin 
cartridge case images. This area can be hidden in the viewers.

Peak 3D Score The highest LEA score, calculated using acquired 3D data, within all of 
the individual LEA scores for a bullet correlation.

Peak Phase Score The highest LEA score within the phase that produced the Max Phase 
score.

Phase A group of scores. One way a pair of bullets, the reference and a test, 
can align with each other. For example, two bullets with four LEAs each 
can be aligned in four different ways. Therefore, the correlation has four 
phases.

Phase Score The sum of all LEA scores within a phase.

Phase 3D Score The phase that produced the Peak 3D score. 

Pistol A handgun in which the chamber is part of the barrel. A term sometimes 
used for handgun.

Polygonal Rifling Lands and grooves having a rounded profile instead of the traditional 
rectangular profile.

Profile Line A vertical line in the Comparison view of the Bullet Side-by-Side Viewer 
that determines which pixels are used to generate a bullet profile. See 
also Hairline Profiling.

Primer 3D Composite A term used to describe the primer 3D rendering which uses information 
from both the primer 3D DFF and primer all-in-focus image types.

Reference Exhibit The exhibit that is used to generate a correlation request.

Region of Interest (ROI) The area or region from which BRASSTRAX-3D and BULLETTRAX-3D 
extract a signature for correlation. The information of interest includes 
the marks that are unique to a type of image; breech face, firing pin, or 
ejector mark in the case of cartridge cases, or LEAs and GEAs, in the 
case of bullet exhibits.

Remote Correlation
Request

A correlation request that checks the databases of selected remote sites.
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Rendering The manner in which a bullet image is depicted on screen. A bullet 
image can be rendered as 2D, 3D, or a mixture of 2D and 3D. The more 
that an image is rendered as 3D, the more pronounced are the surface 
details and texture. 

Rifle A firearm having rifling in the bore and designed to be fired from the 
shoulder.

Rimfire A flange-headed cartridge containing the priming mixture inside the rim 
cavity.

Side-by-Side Viewer A comparison window that allows a Firearm Examiner to compare two 
bullet or cartridge case exhibits side-by-side. The Side-by-Side Viewer is 
an electronic version of the comparison microscope.

Signature A mathematical representation of important information that is 
extracted from the digital image of a bullet or cartridge case.

Striae Parallel surface contour variations on the surface of an object caused by 
a combination of force and motion where the motion is approximately 
parallel to the plane being marked. Striae are accidental in nature and 
unique to a common origin, (a particular firearm or tool). See 
impression.

Test Exhibit The exhibits in the database against which the reference exhibit is 
compared.

Test Fire Bullet A bullet fired into a bullet recovery system in a laboratory for comparison 
or analysis.

Toolmark The mark produced when a tool is placed against an object and enough 
pressure is applied to the tool so that it leaves an impression on the 
object. 

Twist The direction and rate of turn of the rifling helix, e.g. left hand, right 
hand. 
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I n d e x

Numerics
2D correlation scores

bullets, 83
2D/3D rendering

adjusting in the Image Information window, 98
adjusting in the MultiViewer, 151

2D/3D rendering control, 306, 334
3D correlation scores

bullets, 84
3D elevation

adjusting, 197
adjusting in the Image Information window, 98

3D elevation control, 306
3D exhibits

3D elevation, 197
adjusting lighting, 193

3D images, 151

A
accounts

user, 29
acquisition technicians

privileges, 21
adding

graphs to new reports, 254
hits, 222
manual correlation requests, 110

adjusting
2D/3D rendering in Side-by-Side Viewer, 195
2D/3D rendering in the Image Information window, 98
3D elevation, 197
3D elevation in the Image Information window, 98
brightness in Side-by-Side Viewer, 187
brightness in the Image Information window, 97
contrast in Side-by-Side Viewer, 188
contrast in the Image Information window, 98
lighting in the Image Information window, 99
lighting of 3D exhibits, 193
magnification level, 186

adjusting lighting and rendering in MultiViewer, 151

aligning
bullet exhibits in best match position, 147
bullet exhibits in the best phase position, 173
cartridge case exhibits in best match position, 147
cartridge case exhibits in the best match position, 176

analyzing
2D bullet correlation scores, 83
3D bullet correlation scores, 84
bullet correlation scores, 117
bullet exhibits in the Side-by-Side Viewer, 158
bullet profiles, 201
cartridge case correlation scores, 77, 115
cartridge case exhibits in the Side-by-Side Viewer, 160
correlations, 85
images in MultiViewer, 129

annotations
viewing, 168
viewing, in the Image Information window, 101

automatic correlation requests
description, 69

automatic correlations
overview, 71

B
bar chart

adding to a new report, 254
best match position

bullet exhibits, 147
cartridge case exhibits, 147, 176

best phase position
bullet exhibits, 173

brightness
adjusting in Side-by-Side Viewer, 187
adjusting in the Image Information window, 97

brightness control, 306
bullet correlation scores, 80

analyzing, 117
description of types, 82
examining 2D scores, 83
examining 3D scores, 84
max LEA, 82
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max phase score, 82
peak phase score, 82
phase score, 82
sorting, 117

bullet exhibits
analyzing in the Side-by-Side Viewer, 158
best match position, 147
best phase position, 173
displaying anchor lines, 168
hiding in MultiViewer, 149
importing from remote sites, 136, 166
mosaics, 130
moving in MultiViewer, 150
moving in Side-by-Side Viewer, 177
stretching or shrinking, 199
viewing profiles, 201
wrap around, 177

bullet images
placing rulers, 183

Bullet MultiViewer
buttons and fields, 340
controls, 342
description, 339
mouse actions, 342
visual indicators, 341

bullet profiles
viewing, 201

Bullet Side-by-Side Viewer
controls, 361
description, 355
hit count field descriptions, 360
locks, 352, 360
toolbar buttons, 356
views, 356

C
calculating

consecutive matching striae, 205
calendars

using, 41
caliber families, 74
cartridge case correlation scores

analyzing, 115
examining, 77
sorting, 115

cartridge case exhibits

analyzing in the Side-by-Side Viewer, 160
best match position, 147, 176
displaying in MultiViewer, 132
displaying one or all image types in MultiViewer, 143
hiding in MultiViewer, 149
importing from remote sites, 136, 166
moving and rotating, 179
rotating in MultiViewer, 150

cartridge case images
exporting, 213
rotating, in the Image Information window, 100

Cartridge Case MultiViewer
buttons and fields, 332
description, 331, 337
mouse actions, 335
visual indicators, 334

Cartridge Case Side-by-Side Viewer
controls and fields, 350
description, 347
hit count field descriptions, 352
toolbar buttons, 348
views, 348

cartridge cases
viewing an ROI, 96

cases
printing, 94
searching, 46

changing
correlation request status, 124
hits, 225
magnification level in the Image Information window, 97
passwords, 27, 31

chart
adding to a new report, 254

class characteristics
in automatic correlations, 71

CMS
calculating, 205

comparing
bullet exhibits in the Side-by-Side Viewer, 158
cartridge case exhibits in the Side-by-Side Viewer, 160
LEAs for consecutive matching striae, 207

comparison view
saving a screenshot, 211

connectivity, 23
consecutive matching striae

calculating, 205
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contacting
documentation team, 63
technical support, 63

context menus, 44
contrast

adjusting in Side-by-Side Viewer, 188
adjusting in the Image Information window, 98

contrast control, 306
controls

2D/3D rendering, 306, 334
3D elevation, 306
brightness, 306
Bullet MultiViewer, 342
Bullet Side-by-Side Viewer, 361
Cartridge Case Side-by-Side Viewer, 350
contrast, 306
lighting, 306, 334
using, 171

copying
images in Side-by-Side Viewer exhibits

saving and copying, 211
correlation

with remote sites, 111
correlation analysis process, 85
correlation requests

caliber families, 74
changing status, 124
creating manually, 110
deleting, 125
description, 69, 109
event types, 72
viewing, 113
viewing details, 122, 126

correlation results
viewing, 113

correlation scores
bullets, 80
cartridge cases, 77
description, 70, 76
displaying scores in Side-by-Side Viewer, 185
viewing in Correlations window, 113

correlation status, 75
changing, 124

creating
a new report, 247
hits, 222
manual correlation requests, 110

cursor modes
MultiViewer, 40
Side-by-Side Viewer, 40

custom report templates
saving, 255

customizing reports, 247

D
date of occurrence, in automatic correlations, 71
date range

element for new reports, 255
selecting for new reports, 241

deleting
correlation requests, 125
reports, 246

description
automatic correlation request, 69
Bullet MultiViewer, 339
Bullet Side-by-Side Viewer, 355
Cartridge Case MultiViewer, 331, 337
Cartridge Case Side-by-Side Viewer, 347
correlation request, 109
correlation scores, 70
exhibit, 89
hit, 221
image group, 332
manual correlation request, 69
MATCHPOINT+, 19
mosaic, 130
MultiViewer, 129
reference exhibits, 69
test exhibits, 69

detailed information
viewing, 102

details
correlation requests, 122, 126

display guides
displaying, 168
information in MultiViewer, 134

display order of fields
selecting, 252

displaying
anchor lines, 168
bullet exhibits in best match position, 147
bullet exhibits in best phase position, 173
bullet profiles, 201
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cartridge case exhibits in best match position, 147, 176
consecutive matching striae scores, 207
correlation requests and results, 113
detailed information, 102
dynamic information, 134
exhibits in Side-by-Side Viewer, 163
hidden images, 149
information in the MultiViewer, 134
LEA and GEA images, 96
LEA and GEA information, 168
MultiViewer, 132
one or all cartridge case image types, 143
text annotations in the Image Information window, 101

documentation
MATCHPOINT+, 62
team, contacting, 63

dynamic information
displaying, 134

E
e-mail address for technical support, 63
event types

in correlations, 72
when processing automatic correlations, 71

exhibits
description, 89
displaying correlation scores, 185
displaying in Side-by-Side Viewer, 163
importing from remote sites, 136, 166
lighting in Side-by-Side Viewer, 193
overlapping, 181
printing, 94
searching, 46
zoom in and out, 186

exiting
MATCHPOINT+, 64

expert acquisition technicians
privileges, 21

exporting
cartridge case images, 213

F
fax number for technical support, 63
field descriptions

Bullet MultiViewer, 340
Bullet Side-by-Side Viewer, 360

Cartridge Case MultiViewer, 332
Cartridge Case Side-by-Side Viewer, 350, 352

fields
selecting for new reports, 250

filter
for selecting test exhibits to display, 92

firearm examiners
privileges, 21

function keys, 43

G
GEA information

displaying, 168
GEAs

viewing a single image, 96
generating

a new report, 247
a report from a template, 235

graph
adding to a new report, 254

grouping fields
selecting, 251

H
headers

for new reports, 255
Help

using, 60
hit count

Bullet Side-by-Side Viewer, 360
Cartridge Case Side-by-Side Viewer, 352

hits
adding, 222
description, 221
modifying, 225
viewing, 224

how automatic correlations are processed, 71

I
image

brightness, 97
contrast, 98

image groups, 332
image information

viewing, 102
image manipulation controls
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Bullet MultiViewer, 342
Bullet Side-by-Side Viewer, 361
using, 171

image peaks, 197
images

exporting, 213
import from remote sites, 136, 166
moving, in the Image Information window, 100
overlapping, 181
printing, 215
viewing, 96

importing
images from remote sites, 136, 166

interface
introduction to, 32

interpreting
2D bullet correlation scores, 83
3D bullet correlation scores, 84
cartridge case correlation scores, 77

L
LEA information

displaying, 168
LEAs

calculating consecutive matching striae, 207
scores, 82
stretching or shrinking, 199
viewing a single image, 96

lighting
adjusting in Side-by-Side Viewer, 193
adjusting in the Image Information window, 99
adjusting in the MultiViewer, 151

lighting control, 306, 334
list boxes

using, 41
locks

Bullet Side-by-Side Viewer, 352, 360
using, 171

logging on
user name and password, 29

M
magnification level

changing in Side-by-Side Viewer, 186
changing in the Image Information window, 97

magnifying

exhibits, 186
manual correlation requests

creating, 110
description, 69

matching striae
calculating, 205

MATCHPOINT+
connectivity, 23
description, 19
documentation, 62
exiting, 64
Help system, using, 60
interface, 32
system requirements, 63

MATCHPOINT+ users
roles, 21

Max LEA score, 82
Max Phase score, 82
modifying

correlation request status, 124
hits, 225
passwords, 31

mosaic
description, 130

mouse actions
Bullet MultiViewer, 342
Cartridge Case MultiViewer, 335

moving
bullet exhibits in Side-by-Side Viewer, 177
cartridge case images in Side-by-Side Viewer, 179
images in MultiViewer, 150
images in the Image Information window, 100

MultiViewer
adjusting 2D/3D rendering, 151
adjusting lighting of 3D images, 151
best match position, 147
description, 129
display guides, 134
displaying one or all cartridge case types, 143
information, 134
moving and rotating images, 150
opening, 132
saving settings, 153

N
New Custom Report wizard
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starting, 248
new reports

adding a graph, 254
date range element, 255
display order of fields, 252
header information, 255
options, 255
selecting fields, 250
selecting grouping fields, 251
selecting the date range, 241
sort order, 253

O
opening

MultiViewer, 132
Side-by-Side Viewer, 163

options, 255
specifying for new reports, 255

order
of fields in new reports, 252

overlapping
images in Side-by-Side Viewer, 181

overview
reports, 231

P
passwords

changing, 27, 31
expired, 27
logging on, 29

Peak Phase score, 82
phase

description, 82
score, 82

phase score, 82
phone numbers for technical support, 63
pie chart

adding to a new report, 254
placing

rulers on bullet images, 183
preferences

setting in the MultiViewer, 153
setting in the Side-by-Side Viewer, 217

previewing images before printing, 215
print preview

images, 215

printing
cases, 94
exhibits, 94
images in Side-by-Side Viewer, 215
previewing images, 215
reports, 239

privileges
for generating reports, 231
for MATCHPOINT+ users, 21

profiles
for bullets, 201

R
reference exhibit

description, 69
selecting for display in Side-by-Side Viewer, 164

remote site correlation, 111
rendering

adjusting, 98
adjusting in Side-by-Side Viewer, 195

rendering control, 306, 334
report templates

descriptions, 232
saving, 255

report wizard
starting, 248

reports, 255
adding graphs to, 254
assigning a title, 255
creating, 247
deleting, 246
generating from a template, 235
overview, 231
printing, 239
privileges, 231
selecting display order, 252
selecting fields, 250
selecting grouping fields, 251
selecting the date range, 241
sort order for fields, 253
viewing, 237, 238

requirements
system, 63

resetting values
in the Side-by-Side Viewer, 216

rotating
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cartridge case images, 179
cartridge case images in MultiViewer, 150
cartridge case images in the Image Information 

window, 100
rulers

placing on bullet images, 183

S
saving

custom report templates, 255
images, 211

saving settings
in the MultiViewer, 153
in the Side-by-Side Viewer, 217

scores
bullets, 80
cartridge cases, 77
description, 76

screenshot
of comparison view, 211

searching
for cases and exhibits, 46

selecting
display order for new reports, 252
grouping fields for new reports, 251
reference exhibit to display in Side-by-Side Viewer, 164
report fields, 250
sort order for new reports, 253
test exhibits manually for MultiViewer display, 132
test exhibits to display in Side-by-Side Viewer, 164

server
in automatic correlations, 71

setting dates for test fires used in correlations, 73
shortcut menus, 44
Side-by-Side Viewer

adjusting 2D/3D rendering of images, 195
adjusting 3D elevation of 3D images, 197
adjusting brightness of exhibits, 187
adjusting contrast of exhibits, 188
adjusting lighting, 193
best match position for cartridge cases, 176
best phase position for bullets, 173
calculating consecutive matching striae, 205
displaying anchor lines, 168
displaying bullet profiles, 201
displaying scores, 185

exporting cartridge case images, 213
moving and rotating cartridge case images, 179
moving bullet exhibits, 177
opening, 163
overlapping images, 181
printing from, 215
resetting values, 216
saving and copying images, 211
saving settings, 217
stretching or shrinking bullet exhibits, 199
viewing text annotations, 168
zoom in and zoom out, 186

sort order
selecting, 253

sorting
bullet correlation scores, 117
cartridge case correlation scores, 115

standard report templates, 232
starting

New Custom Report wizard, 248
status

changing, 124
of correlation requests, 75

stretching or shrinking
bullet exhibits, 199

striae
finding consecutive matches, 205

system requirements, 63

T
technical support, contacting, 63
templates

descriptions, 232
saving, 255
using to generate reports, 235

test exhibits
creating a selection filter, 92
description, 69
selecting for display in Side-by-Side Viewer, 164
selecting manually for MultiViewer display, 132

test fire dates uses in correlation, how they are set, 73
text annotations

viewing in the Side-by-Side Viewer, 168
viewing, in the Image Information window, 101

texture
adjusting, 195
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title
for new reports, 255

toolbar button descriptions
Bullet MultiViewer, 340
Bullet Side-by-Side Viewer, 356
Cartridge Case MultiViewer, 332
Cartridge Case Side-by-Side Viewer, 348

transparency mode
enabling, 181

U
understanding

2D bullet correlation scores, 83
3D bullet correlation scores, 84
cartridge case correlation scores, 77

user
accounts, 29
name, 29
privileges, 21

user privileges
for generating reports, 231

using
calendars, 41
Help, 60
image manipulation controls, 171
list boxes, 41
locks, 171

V
values

resetting in the Side-by-Side Viewer, 216
view descriptions

Bullet Side-by-Side Viewer, 356
Cartridge Case Side-by-Side Viewer, 348

viewing
anchor lines, 168
bullet profiles, 201
cartridge case images, 96
correlation request details, 122, 126
correlation requests, 113
correlation results, 113
correlation scores, 185
detailed information, 102
dynamic information, 134
hidden images, 149
hits, 224

LEA and GEA images, 96
one or all cartridge case image types, 143
reports, 237, 238
text annotations in Side-by-Side Viewer, 168
text annotations in the Image Information window, 101

visual indicators
Bullet MultiViewer, 341
Cartridge Case MultiViewer, 334

W
wrap around

bullet exhibits, 177

Z
zoom in and out

exhibits, 186
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